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I n t r o d u c t i o n
This training guide introduces you to QuickBooks—Intuit’s easy-to-use, powerful 
accounting systems for small businesses. The guide contains 15 lessons in addition to 
this chapter. 

Many of the lessons in this guide can be performed with any QuickBooks Edition. 
When a lesson or exercise requires QuickBooks Pro or QuickBooks Premier, that 
requirement is stated at the beginning of the lesson or exercise.

Important: Most of the step-by-step instructions and screen captures in this guide 
were created with QuickBooks Pro. Your screens may differ, and some 
instructions may vary slightly, if you are using QuickBooks Basic or 
Premier Edition instead of QuickBooks Pro.

Our Web site contains several resources to assist you in teaching QuickBooks and 
incorporating QuickBooks instruction into your existing curriculum.  

The resources section of our Web site contains exercises for each lesson of the 
“QuickBooks in the Classroom” guide (including a selection of both short answer and 
open-ended questions), also case studies for various industries and a range of 
accounting activities.  

Our Curriculum Support Library also provides Instructors with the opportunity to 
share additional educational resources that they have found helpful for teaching 
QuickBooks.

Visit us at www.intuiteducation.ca and select ‘Members Login’.*

* You should have received your Members Only password when you registered for the 
QuickBooks Education program.  If you did not receive a password, or if you have 
misplaced your password, contact your Education Liaison by calling 1-888-829-8689 
or e-mailing us at educanada@intuit.com.
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Course objectives

After completing this guide, students should be able to do the following:

■ Create a new QuickBooks company.

■ Modify the preset chart of accounts to suit your needs.

■ Add information to company lists, or edit information in company lists.

■ Open and use registers for any QuickBooks balance sheet accounts.

■ Reconcile a QuickBooks chequing account.

■ Track credit card transactions.

■ Invoice customers.

■ Create sales orders.

■ Generate customer statements.

■ Receive payments from customers and make bank deposits.

■ Write QuickBooks cheques and assign amounts to specific expense accounts.

■ Work with asset and liability accounts in QuickBooks.

■ Track fixed assets.

■ Enter bills into QuickBooks accounts payable.

■ Pay bills.

■ Create and customize QuickBooks reports and graphs.

■ Export QuickBooks reports to Microsoft Excel.

■ Set up inventory and build finished good with QuickBooks.

■ Track and pay sales tax.

■ Understand QuickBooks payroll features.

■ Create estimates and do progress invoicing.

■ Track time and pay nonemployees for time worked.

■ Customize QuickBooks sales forms.

■ Write letters in Microsoft Word using QuickBooks data.
3



I n t r o d u c t i o n
Hardware and software requirements

At the time this guide was printed, the hardware and requirements were the most up-
to-date. Because of updates and new releases of QuickBooks, these requirements can 
change. For the most up-to-date requiements, visit our Website at 
http://support.intuit.ca/quickbooks/ and search our FAQs for “requirements”.

For all QuickBooks products

To use the version of any QuickBooks product, you need the following equipment and 
software:

■ 200 MHz IBM compatible Pentium computer (350 MHz or higher recommended).

■ A minimum of 64 MB (megabytes) of RAM (random access memory); 95 MB is 
recommended.

■ Hard disk with the amount of free disk space shown in the table below.

■ 2x CD-ROM drive (double speed) or higher.

■ 8-bit or 16-bit sound card if you want to use the sound features.

■ 256-colour VGA monitor, SVGA monitor, or better is recommended (minimum 
resolution of 800x 600 using Small Fonts in your Windows Control Display 
settings).

■ Either Windows 98, Me, 2000, or XP.

■ Internet access (with a connection speed of 28.8 or higher) is required for Payroll 
and all online features/services.

■ QuickBooks for Windows installation CD-ROM.

■ Printer supported by Windows 98, Me, 2000, or XP.

For QuickBooks Pro, Premier, and Premier: Accountant Edition
■ Microsoft® Word 97, 2000, or 2002 if you plan to use the QuickBooks Letters 

feature. (More RAM enhances the use of this feature.)

■ Microsoft® Excel 97, 2000, or 2002 if you plan to use the features in QuickBooks 
Pro and Premier that integrate with Microsoft Excel. (More RAM enhances the use 
of these features.)

■ Either Microsoft® Outlook (version 97, 98, 2000, or 2002), Symantec ACT! version 
3.0.8, 4.0.2, OR Interact 2000 if you want to synchronize with contact 
management software.

Installation 
component

QuickBooks 
Basic

QuickBooks 
Pro

QuickBooks 
Premier and 
Premier: 
Accountant 
Edition

QuickBooks Financial 
Software

230 MB 250 MB 280 MB

Microsoft Internet 
Explorer 6.0 

70 MB 70 MB 70 MB
4



                                                                                                
Network requirements

QuickBooks network requirements are the same whether you are sharing a company 
file or printing to a network printer:

■ Windows 2000 Server, Windows XP Server, or NetWare Network File Server 3.12.

OR

■ Peer-to-peer network, using Windows 98, 2000, Me, or XP.

Important: Intuit recommends you have the latest Service Pack or update for your 
operating system or network software. If you are uncertain whether 
you have the latest Service Pack or update, contact Microsoft, Novell, 
or your network administrator.

About the exercise file

The qbcanlesson.qbb file can be downloaded from the resource section of the Intuit 
Canada Education website (see instructions below). You’ll use a copy of this file to 
complete the lessons in this guide.

Using the exercise file in each lesson

For each lesson in this guide, except for lessons 1 and 2, you’ll restore a new copy of 
the exercise file qbcanlesson.qbb, and use that file to complete the lesson. The 
qbcanlesson.qbb file you copy into the QBtrain directory on your hard disk is a 
QuickBooks backup copy. This means that at the start of each lesson, you’ll be 
restoring a new qbcanlesson file. Instructions on how to restore the file are given at 
the start of each lesson.

Installing the exercise file

To install the exercise file on your hard disk:

1 From the Windows Start menu, choose Run.

2 Type Explorer, then click OK.

3 From Windows Explorer, select a folder under which you want to store your 
training files (e.g. c:/Program Files/Intuit).

4 From the File menu, choose New, then choose Folder.

Additional for Timer N/A 9 MB 9 MB

Installation 
component

QuickBooks 
Basic

QuickBooks 
Pro

QuickBooks 
Premier and 
Premier: 
Accountant 
Edition
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I n t r o d u c t i o n
5 Type QBtrain, then press ENTER.

6 Download the qbcanlesson.qbb and payroll.qbb files from the resource section of 
the Intuit Canada Education website at: http//www.intuiteducator.ca. into the 
QBtrain folder you created in the previous step.

Your exercise file is now installed in the QBtrain folder on your hard disk.

Exercise transaction dates

The exercise file for use with this guide was created in QuickBooks Pro with the date 
set to 12/15/2007. When you open the exercise file in QuickBooks, QuickBooks 
automatically sets the sample data file date to 12/15/2007. When you close the 
exercise file, use your own QuickBooks company file, or exit QuickBooks, your date 
will return to the current date.

Student prerequisites

No knowledge of finances or accounting is needed to use QuickBooks. Students should 
however, have a basic knowledge of the computer operating system and know how to 
move files around, create folders or directories, copy files to and from disks, and run 
applications.
6
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L E S S O N  1
Lesson objectives
■ To gain an overview of the course and the topics to be covered

■ To know how QuickBooks works and how you can get around in QuickBooks

■ To learn common business terms used by QuickBooks

■ To see how to exit QuickBooks

Handout materials
■ Handout 1:  Course Syllabus

■ Handout 2:  Record your daily transactions on QuickBooks forms

■ Handout 3:  Information stored in the Customer list

■ Handout 4:  Register for an accounts receivable account

■ Handout 5:  The QuickBooks chart of accounts

■ Handout 6:  About assets, liabilities, and equity

■ Handout 7:  Sample balance sheet

■ Handout 8:  Sample profit & loss statement
9



G e t t i n g  s t a r t e d
Course introduction

This course is an introduction to QuickBooks. Its main objective is to introduce you 
to the basic features in QuickBooks and give you an opportunity for hands-on 
practice. You’ll learn about the types of information you need to track in your 
business, and you’ll see how to enter that information and track it in QuickBooks. By 
the time you complete the course, you’ll have a good idea of all that QuickBooks 
offers, you’ll be familiar with the most common tasks, and you’ll know where to find 
information about more advanced features.

Introducing QuickBooks

Although most small business owners are worried about revenue, running a business 
involves a lot of other tasks. Depending on the type of business, you need to invoice 
customers, record payments from customers, pay your own bills to outside vendors, 
manage inventory, and—in your “spare time”—analyze your financial data to see 
where you need to focus your next efforts. QuickBooks is a tool you can use to 
automate the tasks you’re already performing as a business owner.

When you’re working in QuickBooks, you’ll spend most of your time using a form, a 
list, or a register. Since these are so basic to QuickBooks, we’re going to spend a few 
minutes introducing them.

Using forms

You record most of your daily business transactions on a QuickBooks form, which 
looks just like a paper form. Here’s an example of the form you use when you want to 
record a bill from and write a cheque to one of your vendors.
10



                                                                                                
L E S S O N  1
The form is intuitive—you already know how to fill out a form. But after you provide 
the information on a QuickBooks form, QuickBooks does the accounting for you in 
the background. For example, when you record a bill, then write a cheque (using the 
Pay Bills window) to pay for the business expense, QuickBooks enters transactions in 
your accounts payable register to show the expense you incurred and the payment you 
made. (Accounts payable is the money owed by your business to vendors.) It also 
records the cheque in your chequing account, keeping your records up to date, and 
providing a running balance of what you owe at any time.

Using lists

The list is another basic QuickBooks feature. You fill out most QuickBooks forms by 
selecting entries from a list.

QuickBooks has lists where you can store information about customers, vendors, 
employees, items or services you sell, and so on. Lists save you time and help you enter 
information consistently and correctly.

When you’re filling out an invoice form and you select a customer name from the 
Customer:Job list, QuickBooks not only fills in the name but also fills in the address, 
the payment terms, and the customer’s sales tax.

Here’s an example of the Customer:Job list.

QuickBooks lets you complete a variety of activities from lists, using the menu buttons 
located at the bottom of each list. For example, to fill out an invoice for a customer, 
first select the customer from the Customer:Job list, then choose Create Invoices from 
the Activities menu button.

Using registers

In addition to forms and lists, you’ll also work with registers in QuickBooks. Just as 
you use your paper chequebook register to see a record of all the transactions in your 
chequing account—cheques you’ve written, other withdrawals you’ve made from 
your account, and deposits—a QuickBooks register contains a record of all the activity 
in one account. Almost every QuickBooks account has its own register.
11



G e t t i n g  s t a r t e d
Here’s an example of the register for an accounts receivable account.

The register shows information about invoices written to customers—the date of the 
invoice, the date it’s due, the name of the customer, and the amount. It also shows 
payments you’ve received against your invoices. Below the right column of the 
register, you can see a running balance of all your accounts receivable, so you always 
know how much you’re owed.

Getting around in QuickBooks

QuickBooks maximizes your work space and gives you quick access to the features and 
reports that you use most. In this section, you’ll learn how to do the following:

■ Find information to help you get started using QuickBooks

■ Manage your open windows

■ Compare windows side by side

■ Customize navigation features

Finding information to help you get started

If you’re new to QuickBooks, the Getting Started window displays when you open a 
company file. This window guides you through the steps you need to complete after 
you’ve set up your company file. To display the Getting Started window, choose 
Getting Started from the Help menu.
12
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If you’re upgrading from a previous version, QuickBooks displays the New Features 
window. This window contains information about new features and explains how to 
find what you need to start working with the latest version. To display the New 
Features window, choose New Features from the Help menu.

Navigating in the working area

There are several ways to find what you need in the QuickBooks working area.

Making navigators your starting point

QuickBooks navigators provide a graphical representation of the workflow for a 
particular area of the product. For example, the Customers Navigator window has 
icons for important activities that are common to working with customers and 
making sales (such as, creating invoices, receiving payments, and making deposits). It 
looks like the following.

Navigators are 
an easy way to 
work in one area 
of QuickBooks.

Each Navigator 
shows the tasks 
for one area of 
your business.

As you use 
QuickBooks, the 
Open Window 
list keeps a list of 
the areas you’ve 
worked in.

Get your 
questions 
answered with 
1-2-3 Help. 

The Follow-Me Help window displays help related to what you are doing in QuickBooks.

The 
customizable 
Icon bar gives 
you one-click 
access to the 
features you 
use most often.

The Customer 
Navigator, 
shown here, 
contains 
customer-
specific tasks 
like creating an 
invoice. 
13



G e t t i n g  s t a r t e d
The navigators let you access features, reports, and solutions for the major areas of 
QuickBooks.

■ Flow charts guide you in performing tasks in the correct order.

■ Related Activities and Memorized Reports let you analyze your data and take 
action.

■ Customer Solutions help you find features and services that you can use to 
manage your business.

To display a navigator, select its name from the Navigator list.
14
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Managing your open windows

To give you more room to work on the task at hand, QuickBooks displays one window 
at a time. When you open a window, it appears in front of other windows that you 
previously opened.

The Open Window list keeps track of the windows that are open. Use the Open 
Window list to switch between windows while you work. To switch to another open 
window, just click the title of the window that you want to display.

To show or hide the Open Window list:
■ From the View menu, choose Open Window List.

If the list is currently displayed, a checkmark appears to the left of the menu item.

For comparison purposes, you may want to display more than one window at a time. 
You can easily switch between viewing one window at a time and viewing multiple 
windows. When you choose Multiple Windows from the View menu, QuickBooks tiles 
the windows in the main area. You can then move and resize the windows as needed.

To view multiple windows:
■ From the View menu, choose Multiple Windows.

Using the Menu bar

You can find all of the QuickBooks commands on the menu bar.

Many commands available on the menu bar can be added to the Icon Bar.

Using the Icon Bar

Another feature that makes it easy to get around in QuickBooks is the Icon Bar. It 
comes preset with shortcuts to several windows, such as Create Invoices and Enter 
Bills. By including the features and reports you use most, you can manage your 
business more quickly than ever.
15



G e t t i n g  s t a r t e d
In addition to deciding which features to add to the Icon Bar, you can add or remove 
icons, change the order in which the icons display, insert spaces between icons, and 
edit icons by changing the icon text, graphic, or tooltip.

For instructions on how to customize the Icon Bar, search the onscreen Help for  
Icon Bar, then choose “Customizing the Icon Bar” from the list of topics that displays.

QuickBooks is preset to display the Icon Bar, but you can display the Shortcut list 
instead of, or in addition to, the Icon Bar. 

All the accounting you need to know

QuickBooks doesn’t require users to learn or understand accounting jargon. However, 
it does use some common business terms.

Your chart of accounts

When you keep books for a company, you want to track where your income comes 
from, where you put it, what your expenses are for, and what you use to pay them. 
You track this flow of money through a list of accounts called the chart of accounts.

Like other lists in QuickBooks, the chart of accounts is opened through the Lists menu. 
The chart of accounts for the Rock Castle Construction Company looks like this:

The list displays balance sheet accounts first, followed by income accounts and 
expense accounts.
16
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About assets, liabilities, and equity

Assets

Assets include both what you have and what other people owe you. The money people 
owe you is called your accounts receivable, or A/R for short. QuickBooks uses an 
accounts receivable account to track the money owed you.

The rest of your company’s assets may include chequing accounts, savings accounts, 
petty cash, fixed assets (such as equipment or trucks), inventory, and undeposited 
funds (money you’ve received from customers but haven’t yet deposited in the bank).

When setting up your company file in QuickBooks, please note that even though 
chequing, savings, and petty cash are all company assets, you’ll set them up as “bank” 
type accounts in QuickBooks.

Liabilities

Liabilities are what your company owes to other people. The money you owe for 
unpaid bills is your accounts payable, or A/P for short. QuickBooks uses an accounts 
payable account to track the money you owe different people for bills.

A liability can be a formal loan, an unpaid bill, or sales and payroll taxes you owe to 
the government.

When setting up your company file in QuickBooks, please note that even though 
unpaid bills are liabilities, you’ll set them up as accounts payable type accounts in 
QuickBooks.

Equity

Equity is the difference between what you have (your assets) and what you owe (your 
liabilities):

Equity = Assets – Liabilities

If you sold all your assets today, and you paid off your liabilities using the money 
received from the sale of your assets, the leftover money would be your equity.

Your equity reflects the health of your business, since it is the amount of money left 
after you satisfy all your debts. Equity comes from three sources:

■ Money invested in the company by its owners

■ Net profit from operating the business during the current accounting period

■ Retained earnings, or net profits from earlier periods that haven’t been distributed 
to the owners
17



G e t t i n g  s t a r t e d
Of course, you as the owner can also take money out of the business. Such 
withdrawals, called owner’s draws, reduce the business equity.

If you have a sole proprietorship (where the existence of the business depends solely 
on your efforts), you can check the value of your owner’s equity by creating a 
QuickBooks balance sheet.

Cash versus accrual bookkeeping

When you begin your business, you should decide which bookkeeping method to use. 
The bookkeeping method determines how you report income and expenses on your 
tax forms. Check with your tax advisor or the Canada Revenue Agency (CRA) before 
choosing a bookkeeping method for tax purposes.

Cash basis

Many small businesses record income when they receive the money and expenses 
when they pay the bills. This method is known as bookkeeping on a cash basis. If 
you’ve been recording deposits of your customers’ payments but haven’t been 
including the money customers owe you as part of your income, you’ve been using 
cash basis. Similarly, if you’ve been tracking expenses at the time you pay them, rather 
than at the time you first receive the bills, you’ve been using cash basis.

Accrual basis

In accrual-basis bookkeeping, you record income at the time of the sale, not at the 
time you receive the payment. Similarly, you enter expenses when you receive the bill, 
not when you pay it.

Most accountants feel that the accrual method gives you a truer picture of your 
business finances.

How your bookkeeping method affects QuickBooks

Whether you use the cash or accrual method, you enter transactions the same way in 
QuickBooks.

QuickBooks is set up to do your reports on an accrual basis. For example, it shows 
income on a profit and loss statement for invoices as soon as you record them, even 
if you haven’t yet received payment. It shows expenses as soon as you record bills, 
even if they’re unpaid.

You can see any report (except transaction reports) on a cash basis by changing the 
reporting preference. (From the Edit menu, choose Preferences. In the Preferences 
window, click Reports & Graphs in the left scroll box, then click the Company 
Preferences tab.)
18



                                                                                                
L E S S O N  1
Important: When you create reports in QuickBooks, you can switch between cash 
and accrual reports at any time, regardless of which bookkeeping 
method you have chosen for tax purposes.

Measuring business profitability

Two of the most important reports for measuring the profitability of your business are 
the balance sheet and the profit and loss statement (also called an income statement). 
These are the reports most often requested by accountants and financial officers. (For 
example, banks request both documents when you apply for a loan.)

The balance sheet

A balance sheet is a financial snapshot of your company on one date. It shows:

■ What you have (assets)

■ What people owe you (accounts receivable)

■ What your business owes to other people (liabilities and accounts payable)

■ The net worth of your business (equity)

To see an example of a balance sheet:
1 From the Reports menu, choose Company & Financial.

2 From the submenu, choose Balance Sheet Standard.

The profit and loss statement

A profit and loss statement, also called an income statement, shows your income, 
expenses, and net profit or loss (equal to income minus expenses). The QuickBooks 
profit and loss statement summarizes the revenue and expenses of your business by 
category (first income, then expenses).

To see a profit and loss report:
1 From the Reports menu, choose Report Finder.

2 From the Select a type of report drop-down list, choose Company & Financial.

3 In the Select a report list, click Profit & Loss Standard.

4 Click Display.

5 Scroll the report window to see all parts of the report.

The statement of cash flows

Another report that your accountant may be interested in is the statement of cash 
flows report. A statement of cash flows shows your receipts and payments during a 
specific accounting period.
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To see a sample statement of cash flows report:
1 From the Reports menu, choose Report Finder.

2 From the Select a type of report drop-down list, choose Company & Financial.

3 In the Select a report list, click Statement of Cash Flows.

4 Click Display.

Exiting QuickBooks

Unlike most other Windows programs, QuickBooks doesn’t require you to save your 
data before exiting. It does an automatic save while you’re working with QuickBooks.

To exit QuickBooks:
■ From the File menu, choose Exit.

If no other applications are open, QuickBooks returns you to the Windows desktop.

To prevent or minimize data loss, you should make regular backup copies of your 
QuickBooks company data. In the event of a data loss you can restore your data from 
the backup copy. To make a backup copy, from the File menu, choose Back Up.

For more information about the recommended backup routine, see Chapter 8, 
“Protecting your data,” in the QuickBooks User’s Guide.

Moving between company files

If you work with several companies, you’ll be working with multiple QuickBooks 
company files. You can change from one company file to another at any time, but you 
can have only one file open at a time.

QuickBooks provides an easy way to find and open a company file that you’ve worked 
with before.

To open a previously opened file:
1 From the File menu, choose Open Previous Company.

2 From the submenu, choose the company file you want to open.

You can increase the number of company files that QuickBooks will display in the 
submenu.

To increase the number of company files displayed:
1 From the File menu, choose Open Previous Company.

2 Choose “Set number of previous companies.”

3 Enter the number of company files you want QuickBooks to display (up to 20).

4 Click OK.
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Student test and review
1 List the three main ways you enter data in QuickBooks.

2 List three ways to access features in QuickBooks.

3 What bookkeeping method does QuickBooks use to create most reports?
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Lesson objectives
■ To discuss some of the decisions you need to make before using QuickBooks, such 

as your QuickBooks start date and the number of QuickBooks companies you 
should create

■ To create a new QuickBooks company using the EasyStep Interview

■ To set QuickBooks preferences in the Interview

■ To record the opening balance for a chequing account

■ To practice using the QuickBooks Help tools

Handout materials
■ Handout 9:  Setting up QuickBooks

■ Handout 10:  How to choose a start date
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Creating a QuickBooks company

A QuickBooks company contains all the financial records for a single business. Before 
you can use QuickBooks, you need to tell QuickBooks about your business so that it 
can set up your company file.

How many companies should you set up?

If you operate a business enterprise, the CRA expects you to clearly show all sources of 
income and to document any business expenses you claim as deductions. For tax 
purposes, therefore, it’s usually best to set up a separate QuickBooks company for each 
business enterprise you report on your tax forms.

About the EasyStep Interview

The EasyStep Interview walks you through the process of setting up your entire 
business on QuickBooks. The Interview is broken down into sections. You must 
complete the required General section first. If you are not sure how to answer a 
question, you can always go back and change your answer later. A few questions ask 
you to make a decision that’s not easily reversed. When this is the case, you’ll see this 
symbol.

The EasyStep Interview has five sections:

General—Lets you enter company information, choose a chart of accounts 
appropriate for your business, decide on QuickBooks preferences, and specify a 
business start date.

Income & Expenses—Lets you review the income and expense accounts on your 
business’s chart of accounts, and lets you enter new accounts.

Income Details—Lets you specify whether your business income is from services 
and/or products you sell. Based on the information provided, QuickBooks determines 
which parts of the income and accounts receivable features you will be using.

Opening Balances—Lets you enter information about the customers who owe you 
money as of your start date, vendors to whom you owe money as of your start date, 
and balances in your balance sheet accounts as of your start date.

What’s Next—This section describes some common tasks in QuickBooks that you 
may want to complete after you’ve gone through the other sections of the Interview.

Each major section of the Interview is divided into topics that are displayed as tabs at 
the top of the EasyStep Interview window. After you complete a topic or section, 
QuickBooks displays a checkmark on that tab.
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Navigating through the Interview
■ Click Next to display the next window in the Interview.

■ Click Prev to display the previous window in the Interview.

■ When a window has a More button (in the lower right corner), click it to see more 
detailed information about the question being asked in the Interview. After you 
read the detailed information, you can click OK to return to the Interview.

■ Click Leave to leave the Interview and return to QuickBooks. You can return to the 
Interview later by opening your company file, then choosing EasyStep Interview 
from the File menu. QuickBooks remembers the information you have already 
entered.

Starting the EasyStep Interview

To begin adding a new company:
1 Start QuickBooks.

2 Select “Create a new company” or choose New Company from the File menu.

QuickBooks displays the EasyStep Interview window.
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Entering company info

When you use the EasyStep Interview to create a new QuickBooks company, 
QuickBooks asks you questions about the type of business you own. It uses your 
answers to get you started quickly, by setting up the appropriate accounts and lists.

In this lesson, you’ll create a new QuickBooks company for a business named Lockhart 
Design. Margaret Lockhart is the sole proprietor of this interior design firm. Most of 
her income comes from consulting services, but she also sells products such as fabrics 
and room accessories to clients.

To create a new QuickBooks company file:
1 At the first Welcome window for the Interview, click Next to begin.

2 Keep clicking Next, reading the information presented on the Welcome windows, 
until you have completed the Welcome section.

When you finish the section, QuickBooks places a checkmark on the Welcome 
tab.

3 Click Next until you come to the “Your company name” screen on the Company 
Info tab.

4 In the Company Name field, type Lockhart Design and press TAB.

When you press TAB, QuickBooks automatically enters the same name you typed 
into the Legal Name field. QuickBooks uses the company name on all reports.

5 Click Next.

6 Type the following information in the Your company address window.

1239 Bayshore Road
Kelowna, BC V6E 1E1

QuickBooks prints this company address on cheques, invoices, and other forms.

7 Click Next.

8 In the Other company information window, enter the following information:

■ Make sure January is selected for the first month of the income tax year and 
first month of the fiscal year. QuickBooks uses the fiscal year you choose to 
create year-to-date reports.

■ From the Income Tax form used drop-down list, select Corporate Income Tax 
(T2).

■ Set the default province to British Columbia

■ Set the Business number to: 123456789

Your screen should match the following.
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9 Click Next to go on.

Using a preset chart of accounts

The chart of accounts lists balance sheet accounts, income accounts, and expense 
accounts. When you create a new QuickBooks company, you can select a company 
type that most closely matches your type of business, and QuickBooks sets up a chart 
of accounts for you. It also sets up other lists that are appropriate for your type of 
company, such as payment methods, customer and vendor types, and payment terms.

The type of business you select here affects the chart of accounts that QuickBooks sets 
up for you. Even if you own a type of company that isn’t specifically listed, you should 
select the one that’s closest so you can get a head start on creating your own chart of 
accounts. Once QuickBooks creates a chart of accounts for you, you can modify it 
however you want.

To create a chart of accounts:
1 In the Select your type of business screen, select Retail: General from the Industry 

list, then click Next.

Although Lockhart Design receives most of its income from consulting, not from 
retail sales, the Retail company type will give us most of the accounts we need. 
We’ll need to modify the chart of accounts later to include an income account for 
Consulting Income.

2 Click Next two more times to get to the Save As window.

3 Make sure that QuickBooks is set to save the file in the QBtrain folder in the Quick-
Books installation folder.
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4 In the Filename for New Company window, click Save to accept the default 
filename of “Lockhart Design.”

QuickBooks creates the company file, then displays a list of the income and 
expense accounts available in the preset chart of accounts for retail businesses.

Scroll through the accounts to get an idea of what is included.

5 Confirm that Yes is selected to show that you want to use these accounts, then 
click Next.

6 In the Accessing your company window, leave the number of employees who will 
access the QuickBooks files at 0 and click Next.

Right now, the owner is the only person who needs access to the company file.

7 Click Next until you move from the Company Info section to the Preferences 
section.

If a No Password warning appears, click No to go on. You can set up a password 
later, if you want one.
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Setting up QuickBooks preferences

The Preferences section of the EasyStep Interview is where you indicate whether you 
want to use certain features of the QuickBooks program. From the Interview you can 
choose to use:

■ Inventory

Can be activiated or inactivated depending on whether your company maintains 
inventory.

■ Units of Measure 

For example, 12 cans of pop bought in a case can be sold as individual cans. Quick-
Books will make the conversion.

■ Multicurrency

Turn on if you invoice, receive payments, or pay bills in a currency other than the 
Canadian Dollar

■ GST/HST and Provincial Sales tax (PST/QST)

QuickBooks handles reporting information for you.

■ The invoice format you want to use

■ Payroll (whether turned on)

■ Estimates (QuickBooks Pro and Premier only)

■ Progress invoicing (QuickBooks Pro and Premier only)

■ Sales orders (QuickBooks Pro and Premier only)

■ Time tracking (QuickBooks Pro and Premier only)

■ Classes

■ How you want to enter bills: by entering cheques directly or by entering bills first, 
then payments

■ Reminders (whether to turn on)

Turning on inventory, unit of measure and multi-currency

Click Next from the Preferences section to display the Inventory section diagram.

1 Since Margaret Lockhart does have inventory, select Yes for the question, “Does 
your company maintain inventory?”.

2 Click Next to move to Enabling Inventory Section.

3 Select Yes for the question, “Do you want to turn on the inventory feature?”.

4 Click Next to move to Enable Units of Measure section.

5 Since Margaret Lockhart will resell inventory items in different units of measure, 
select Yes to the question, “Do you want to enable units of measure?”.

6 Click Next to move to Enable Multicurrency section.
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7 Since Margaret Lockhart does plan on purchasing inventory from the U.S., select 
Yes for the question, “Do you want to enable multicurrency?”, then click Next.

8 Ensure “Canada Dollar” is the selected Home Currency.

9 Click Next to move to the Sales Tax setup screen.

Entering sales tax information

This part of the Preferences section asks which taxes you want QuickBooks to keep 
track of. You should turn the sales tax preference off only if you never charge sales tax. 
Margaret Lockhart typically charges sales tax, so we’ll turn on sales tax in her company 
file.

To set up QuickBooks to track sales tax:
1 At the GST/HST and Provincial Sales Tax window, click Yes for the question, “Do 

you want to set up QuickBooks to handle any of the following?” Then click Next.

2 Select “Yes” for “Are you registered for the Goods and Services Tax or Harmonized 
Sales Tax?”

3 Click Next.

QuickBooks automatically creates a current liability account, called GST Payable, 
that keeps track of the sales tax you collect in your business.

4 Fill out the GST/HST Registration Information window as shown below.

5 Click Next.

6 Choose “Yes” for Provincial Sales Tax.

7 Click Next.

8 Choose “Yes” for PST Registration and click Next.

9 Fill out the PST Registration window as shown below.
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10 Click Next

11 Choose “Yes” to PST Tracking and click Next.

12 Your Tax Codes screen should look like this:

13 Click Next

14 Choose “No” to assign a default tax code to your Customers.

If you have regular customers who have special tax status (for example, who are 
exempt from paying the GST or PST), you may want to assign them a customer tax 
code that will override all other sales tax codes on forms. However, the Customer 
Tax Codes option in the EasyStep interview will assign a default tax code to all new 
customers you create -- not just the ones with special tax status. For this reason, 
you should only select Yes here on the advice of your accountant.

15 Click Next to go on.
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Choosing an invoice format

QuickBooks offers four different formats for invoices: Product, Professional, Service, 
and Custom. The type you choose affects the look of your invoices.

■ The Product invoice is for businesses that sell parts or products and need fields 
relevant for shipping (for example, a retail store).

■ The Professional invoice is for businesses that sell services and need a lot of room 
for descriptions of their services (for example, a public relations consultant).

■ The Service invoice is for businesses that primarily provide services, but that also 
sell some goods (for example, an interior design firm).

■ The Custom invoice is for businesses that want to create their own invoice 
format.

You can also customize any of these formats to suit your needs. You’ll see how to do 
that in Lesson 15 of this guide. For Lockhart Design, which primarily sells consulting 
services, but also sells the occasional product, we’ll choose the Service invoice format.

To select the invoice format for Lockhart Design:
■ In the Invoice Format window leave Service selected, then click Next.

Tracking sales orders

If you use a QuickBooks Premier Edition product, QuickBooks asks if you want to track 
sales orders. If you do, click Yes, then click Next. 

Choosing remaining preferences

The rest of the Preferences section is a series of “yes or no” questions. Simply click Yes 
or No, then click Next to move forward in the Interview. For Lockhart Design, 
complete the preferences by giving the following responses:

For this item... Do this...

Employees Enter 5 Employees on Payroll and click 
Next.

Payroll Service Click No and click Next.

Estimates (QuickBooks Pro and Premier only) Click Yes and click Next.

Progress invoicing (QuickBooks Pro and  
Premier only)

Click Yes and click Next.

Time tracking (QuickBooks Pro and  
Premier only)

Click Yes and click Next.

Classes Click Yes and click Next.

How to deal with bills and payments Select “Enter the bills first, then enter 
the payments later” and click Next.
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This completes the Preferences portion of the EasyStep Interview. All that remains of 
the General section is to specify a start date.

Choosing a start date

Before you start entering your company’s financial data, you need to choose a 
QuickBooks start date. This is the starting point you want to use for all your 
QuickBooks accounts. The start date is the date for which you give QuickBooks a 
financial snapshot of your company assets and liabilities.

Once you decide on a start date, you enter all your company’s transactions since that 
date. That’s why you should choose a start date that’s not too far back in the past for 
you to handle. Many business owners like to use the last day of a financial period as 
their start date, such as the end of last fiscal year, last quarter, or last month. You need 
to enter all historical transactions from the day after your start date up through today. 
For example, if you decide on a start date of March 31, you’d enter your historical 
transactions from April 1 up through today.

Continue clicking Next as you move through the Start Date section of the Interview 
until you get to the Select a start date window.

To set the company start date:
1 Select “I want to start entering detailed transactions as of” selection.

2 Enter 12/31/2003 as Lockhart Design’s start date.

3 Click Next.

The General Section is now complete. Click Next to proceed to the Income and 
Expenses section.

How often would you like to see your  
Reminders list

Select “At start up” and click Next.

For this item... Do this...
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Setting up income and expense accounts

Because you chose an industry from the list earlier in the Interview, QuickBooks has 
already created income and expense accounts for your company. The Income & 
Expenses section of the EasyStep Interview lets you view the preset income and 
expense accounts and add new income or expense accounts during the Interview.

To complete Income and Expense Accounts sections:
1 Press Next until the Adding an income account screen is displayed.

2 In the Account Name field, enter Design Consulting and press Next.

3 In the Add another income account screen, select No.

4 Press Next until the Expense Accounts screen is displayed.

5 Select No instead of More Details and press Next.

6 In the “Here are your expense accounts” screen, select No to “Do you want to add 
an expense account now?”. Press Next.

7 Click Next until you get to the Income Details section.

Providing details about your income

The Income Details section of the EasyStep Interview is where you specify whether you 
track accounts receivable, set up QuickBooks items to track the services you provide or 
products you sell, and set up inventory items if you plan to track inventory in 
QuickBooks.

You should complete the Introduction tab of the Income Details section because that 
tells QuickBooks whether you need the accounts receivable feature and whether you 
need statement charges (for businesses that send regular monthly statements showing 
past due, current balance, and so on).

To complete the Income Details section:
1 In the Income Details section window, click Next until the Receipt of payment 

screen is displayed.

2 For the question, “Do you receive full payment at the time (or before) you provide 
a service or sell a product?” make sure “Sometimes” is selected, then click Next.

3 For “Statement charges,” select No, then click Next until the Service Item screen is 
displayed.

4 In the Items section, click No on the three screens that ask if you want to set up 
Service Items, Non-Inventory Parts, or Other Charges.

You’ll see how to set up a new service item in Lesson 6, “Entering sales and 
invoices.”

5 Click Next until the Income Details: Inventory screen is displayed.

6 Read about Income Details:Inventory, then Click Next.

7 Click “No” to Adding an Inventory Item to complete the Inventory tab.
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Entering opening balances

The Opening Balances section of the EasyStep Interview is where you enter the 
amounts currently owed you by customers as of your start date, the amounts you 
currently owe vendors as of your start date, and the balances in your balance sheet 
accounts as of your start date. We recommend that you provide the opening balances 
from within the Interview; that makes it easier when you’re ready to use QuickBooks 
for your daily business transactions.

The balance sheet accounts in the QuickBooks chart of accounts start with an opening 
balance of zero. Before you begin working in QuickBooks, you need to enter an 
opening balance for each balance sheet account as of your start date.

The opening balance is important because QuickBooks can’t give you an accurate 
balance sheet (what your company owns and what it owes) without it. An accurate 
balance sheet gives you a true picture of your company’s finances. Also, if you start 
with an accurate balance as of a specific date, you can reconcile your QuickBooks bank 
accounts with your bank statements, and your QuickBooks chequing accounts will 
show the actual amount of money you have in the bank.

The easiest way to determine an account’s opening balance is to work from an accurate 
balance sheet. If you have a balance sheet as of your start date, you can take the 
opening balance from there.

Let’s assume Margaret Lockhart wants to enter an opening balance for her chequing 
account. The opening balance for a QuickBooks bank account is the dollar amount 
you have in the bank on your start date. You can determine this amount in two ways: 
you can use the ending balance on the last bank statement on or immediately prior to 
your start date, or you can use your bank account balance from a balance sheet 
prepared by your accountant. Margaret has a recent bank statement for this account, 
so she’ll use that method.
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To enter the chequing account opening balance:
1 Read the Opening Balances: Introduction and Information to have on hand 

screens, then click the Accounts tab. (Skip the Customers and Vendors tabs.)

2 Click Next until the Credit card accounts screen is displayed.

3 Click No when QuickBooks asks if you want to set up credit card accounts, lines 
of credit, and loans and notes payable.

4 For “Would you like to set up a bank account?”, make sure Yes is selected, then 
click Next.

5 Type Chequing as the name of the account, then click Next.

If QuickBooks asks if you want to use computer cheques with this account, click 
No for now.

6 For Statement Ending Date, enter the same date you used for Lockhart Design’s 
start date (12/31/2003).

7 In the Statement Ending Balance field, type 8359.00, then click Next.

If QuickBooks asks if you want to use computer cheques with this account, click 
No again.

8 When QuickBooks asks if you want to add another bank account, make sure No is 
selected. Then click Next.

9 To the question “Do you intend to print cheques or deposits slips from Quick-
Books?”, select No .

The rest of the Opening Balances and Payroll sections lets you add asset and equity 
accounts, and payroll information. In the interest of time, these sections are to be 
skipped in the interview.
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Finishing the Interview

The final section in the EasyStep Interview is What’s Next. This is not an essential item 
for initial setup, so we will not cover it in this lesson.

■ To leave the EasyStep Interview and save your changes, click Leave.

After you have completed the EasyStep Interview, Intuit recommends that you not 
use the Interview to make changes to your company file. Instead, use the infor-
mation in the help options described in the next section of this chapter to help 
you make changes and adjustments to your company file.

Completing the company setup process

When you are setting up your own company in QuickBooks, you may want to use the 
Getting Started window to help you finish setting up your own company file. The 
information provided there will guide you through the rest of the setup process and 
help you get started using QuickBooks. To display the Getting Started window, choose 
Getting Started from the Help menu.

If you have upgraded from an earlier version of QuickBooks, choose New Features 
from the Help menu. For more information, choose Help & Support from the Help 
menu.

Getting help while using QuickBooks

QuickBooks provides extensive help that you can access in several ways. When you 
have questions, QuickBooks provides:

■ Follow-Me Help. This type of help "follows" you as you work in QuickBooks and 
displays information that is related to what you are doing.

■ Step-by-step instructions. These are available via the How Do I menu, a search 
engine that finds answers to questions you enter, and an index.
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Follow-Me Help

Follow-Me Help "follows" you as you work in QuickBooks and displays topics that are 
related to what you are doing. For example, if you have an Invoice form open, you will 
see help on how to create an invoice with "How Do I?" links listed underneath. 

Follow-Me Help: 
This window 
tracks your moves 
and displays help 
about what you 
are doing.

Find: Use this 
window to get all 
your questions 
answered.

Help main menu Search the Help How Do I? menus: List help 
topics related to each window.

Index: opens the 
Index in the Find  
(1-2-3 Help) window

Back/Next: moves 
backwards or forward 
through help topics that 
have already been 
displayed in this window.

Topic information:

The  (plus) icon means 
that there is help content 
hidden. When you click 
the plus icon, the help 
topic expands so you can 
read it.

Search: opens the search 
engine in the Find (1-2-3 
Help) window. 

Print: prints the help topic. 
Make sure the help you 
want printed is expanded  
(i.e., click  to expand 
the text before you print 
it).

Pin: stops the help from 
following your activities.

 This tool is useful when 
you need to open several 
windows, but want the 
help to remain on one 
topic.
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The Follow-Me Help sidebar window is located, by default, at the bottom of the sidebar 
area on the left-hand side of the QuickBooks work space. You can move this help 
window  anywhere you like by dragging it to the position you want. When you drag 
it back to the sidebar window area, the window automatically docks in the sidebar. 
You can also close the Follow-Me Help window altogether. 

To close and open the Follow-Me Help window:
■ To close the Follow-Me Help window, click the x in the upper right-hand corner 

of the window.

■ To open the Follow-Me Help window, go to the View menu and select Follow-Me 
Help.

■ To reset the sidebar area to the default layout, go to the View menu and select 
Reset Sidebar Windows.

How Do I? menus

Throughout QuickBooks, you’ll find windows with a How Do I? drop-down menu in 
the upper-right corner. These menus provide quick access to information and 
instructions for the window you’re working in. The help topic is usually displayed in 
the Follow-Me Help window. 

Using the Help or F1 key

You can get explanations about most windows by pressing the F1 key or the Help key 
on your keyboard. The help topic is displayed in the Follow-Me Help area. 

Some windows also have a Help button. When you click a Help button, the help is 
usually displayed in a separate help window and not the Follow-Me Help window.

Finding answers to questions

In most windows, next to the How Do I? drop-down menu, there is an Ask field where 
you can type a question to search the in-product help system. 

You can also use the 1-2-3 Help to search both the help system and the KnowledgeBase 
on the QuickBooks Web site.  The KnowledgeBase is a grouping of Frequently Asked 
Questions (FAQs) that come from other customers.
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The 1-2-3 Help is located in the Find window. The Find window, by default, appears 
above the Follow-Me Help sidebar window. You can move this window anywhere you 
like by dragging it to the position you want. When you drag it back to the sidebar 
window area, the window automatically docks in the sidebar. You can also close the 
Find window altogether. 

To close and open the Find window:
■ To close the Find window, click the x in the upper right-hand corner of the 

window.

■ To open the Find window, go to the View menu and select Follow-Me Help.

To reset the sidebar area to the default layout, go to the View menu and select Reset 
Sidebar Windows.

Using the index

To find help on a particular subject, choose Help Index from the Help menu or click 
the book icon on the Follow-Me Help window. The Index appears in the Find window. 
Type the word that best describes what you need information on. If you can’t find 
what you want from the Index, try using the 1-2-3 Help.

 Click Search, type your question in the box, then 
click Ask. The search engine searches all the in-product 
help topics and displays the results underneath the box. 

 Click Look Online,  type your question in the 
box, then click Search. The search engine searches all the 
FAQs on our Web site and displays the results  in the 
QuickBooks workspace in a separate window.

 As a last resort, if you still haven’t found the 
answer you’re looking for, click Contact Us to display a list 
of contact numbers for Intuit Canada. Note that service 
charges may apply.

3

2

1
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Student test and review
1 The __________________ section of the EasyStep Interview is where you indicate 

whether you want to use certain QuickBooks features.

2 Search the onscreen Help index for information on how to turn on the inventory 
feature in QuickBooks.
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Lesson objectives
■ To edit the company chart of accounts

■ To add a new customer to the Customer:Job list

■ To add a new vendor to the Vendor list

■ To learn about custom fields, and to practice adding custom fields

■ To see how to manage lists in QuickBooks

Handout materials
■ Handout 11:  QuickBooks balance sheet accounts

To start this lesson

Before you perform the following steps, make sure you have installed the exercise file 
(qbcanlesson.qbb) on your hard disk. 

The steps that follow will restore the exercise file to its original state so that the data 
in the file matches what you see on the screen as you proceed through each lesson.

To restore the exercise file (qbcanlesson.qbb):
1 From the File menu in QuickBooks, choose Restore.

QuickBooks displays the Restore Company Backup window.

2 In the “Get Company Backup From” section of the window, click Browse and 
select your c:\QBtrain directory.

3 Select the qbcanlesson.qbb file, then click Open.

4 In the “Restore Company Backup To” section of the window, click Browse and 
select your c:\QBtrain directory.

5 In the File name field of the Restore To window, type lesson 3, then click Save.

6 Click Restore.
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Using QuickBooks lists

QuickBooks lists organize a wide variety of information, including data on customers, 
vendors, inventory items, and more. Lists save you time by helping you enter 
information consistently and correctly. When you store information on a list, you 
enter it once and never need to retype it. Think about how much information you use 
more than once in your business:

■ Names, addresses, and other information about customers who purchase from you 
on a regular basis

■ Contact information for vendors from whom you purchase your supplies

■ Descriptions and prices for products or services you sell again and again

Simply enter repetitive information into a list once, then use it over and over on 
cheques, on invoice forms, and other daily transactions. You don’t have to enter all 
the information for your company lists before you begin working with QuickBooks. 
You can add information to lists as you go along.

Editing the chart of accounts

The chart of accounts is your most important list because it shows how much your 
business has, how much it owes, how much money you have coming in, and how 
much you’re spending. When you set up your own company in QuickBooks, the 
EasyStep Interview lets you choose a chart of accounts designed especially for your 
type of business. However, not every business has the same needs; you’ll want to make 
a few changes to the list.

To display the chart of accounts:
1 From the Lists menu, choose Chart of Accounts.

QuickBooks displays the chart of accounts for Rock Castle Construction.
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2 Scroll through the list. The chart of accounts displays balance sheet accounts first, 
followed by income and expense accounts.

Editing an account

If any of the accounts don’t suit your needs, you can edit or delete them. In the next 
exercise, you’ll edit Rock Castle Construction’s chequing account to provide the 
account number.

To edit an account:
1 In the chart of accounts, select Chequing.

2 Click the Account menu button (at the bottom of the window), then select Edit.

QuickBooks displays the Edit Account window.

3 In the Description field, type The Provincial Bank.

4 In the Bank Acct. No. field, type 555-333-2222.

Your window should look like this.

5 Click OK.

6 If QuickBooks asks if you use computer cheques with this account, click No.
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Adding subaccounts

The Dues and Subscriptions expense account has one subaccount called Union Dues. 
Rock Castle Construction wants to add a second subaccount for trade publications.

To add a subaccount:
1 In the chart of accounts, click the Account menu button, then choose New.

QuickBooks displays the New Account window.

2 In the Type field, select Expense from the drop-down list.

3 In the Name field, type Trade Pubs.

4 Select the “Subaccount of” checkbox, then select Dues and Subscriptions in the 
drop-down list.

5 In the Description field, type Trade Publications.

The screen should look as follows:

6 Click OK.

QuickBooks displays the new subaccount in the chart of accounts list.

7 Close the chart of accounts.
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Working with the Customer:Job list

The Customer:Job list stores names, addresses, and other information about your 
customers. It also holds information about the jobs or projects you may want to track 
for each customer.

Adding new customers

In this exercise, you’ll add a new customer to the Customer:Job list.

To add a new customer:
1 From the Customers menu, choose Customer:Job List. QuickBooks displays the 

Customer:Job list.

The Customer:Job list lets you add, edit, and get reports on your customers. Each 
customer in the list can have multiple jobs (you may call them projects or 
accounts). Notice that this Customer:Job list already has quite a few entries.

2 Click the Customer:Job menu button (at the bottom of the list window), and select 
New.

QuickBooks displays the New Customer window.

The New Customer window is where you enter all the information about a new 
customer, including billing and shipping addresses, contacts, credit limit, and 
payment terms. QuickBooks uses the information you enter to complete invoices, 
bills, and receipts. When you’re setting up your company file, you use this window 
to record customers’ opening balances.
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3 In the Company Name field in the Address Info tab, type Godwin Manufacturing, then 
press TAB.

Notice that QuickBooks fills in the Customer Name field and the first line of the 
Bill To field with the information you typed in the Company field.

QuickBooks displays the name listed in the Customer Name field in the 
Customer:Job list. By default, QuickBooks sorts the list alphabetically. 

Tip: If you are entering individual names, you may want to use last name, first 
name in the Customer Name field so that your Customer:Job list displays 
the names with the last name first.

4 In the Bill To field, click to the end of the company name and press ENTER. Type 
376 Pine Street, then press ENTER.

Notice that you press TAB to move between fields, but you press ENTER to move 
from one line to the next within a field.

5 On the next line of the Bill To field, type Vancouver, BC T6H 0R7

6 Click Copy to have QuickBooks copy the billing address to the Ship To field.

7 Continue filling out the customer information by providing the following  
information:

■ Contact: John Godwin

■ Phone: 325-555-9841

■ Fax: 325-555-0012

■ Alt Contact: Tracy Heldt

Note: If you use plan to e-mail invoices or statements to customers using the Send 
Forms feature, use this window to enter your customers’ e-mail addresses.
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Providing additional customer information

You’ve just completed the Address Info tab for a new customer. The Additional Info 
tab is where you can provide other important information, such as customer type (if 
you want to categorize your customers in some way), payment terms, and sales tax 
information.

To add additional information to a customer record:
1 Click the Additional Info tab.

QuickBooks displays the Additional Info tab of the New Customer window.

2 In the Type field, type Industrial.

The Type field lets you track customers in any way that is meaningful for your 
business. For example, if you run ads on television, radio, and in print, and you 
want to know which advertising method brings you the most customers, you can 
assign customers a “type” (TV, Radio, or Print) and run reports that tell you which 
referral source is most effective. Rock Castle Construction uses the Type field to 
categorize customers by the type of service provided.

3 Press TAB.

4 In the Terms field, type Net 30.

5 In the Customer Tax Code field, leave the checkbox empty. The New customer 
screen should look as follows:
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Providing customer payment information

The Payment Info tab is where you enter customer account numbers and credit limits. 
QuickBooks remembers each customer’s credit limit and warns you when a customer 
is about to exceed it. You can also record information about each customer’s preferred 
payment method. For customers who pay by credit card, you can enter credit card 
numbers and expiration dates.

To add payment and credit information to a customer record:
1 Click on the Payment Info tab.

2 In the Credit Limit field, type 2000.

3 In the Preferred Payment Method drop-down list, choose Cheque.

When you finish, your window should look like this.

4 Click OK to add the customer and close the New Customer window.

QuickBooks displays the Customer:Job list with Godwin Manufacturing added.

5 Close the Customer:Job list.
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Working with the Employee list

The Employee list stores information about your employees such as name, address, 
and social insurance number. It also stores information QuickBooks needs to calculate 
your employee pay cheques (if you are using QuickBooks for payroll). You’ll learn how 
to enter employee payroll information later in this course. For now, enter only the 
basic employee information.

QuickBooks uses the information you enter in the Employee list to track sales and fill 
in information on cheques and other forms.

Adding new employees

Suppose that Rock Castle Construction has hired a new employee and you want to add 
her information to the Employee list.

1 From the Employees menu, choose Employee List.

QuickBooks displays the Employee list.

The Employee list is where you add a new employee, edit information for an 
existing employee, or delete an employee name (as long as you have not used the 
employee name in any transactions).

2 Click the Employee menu button and choose New.

QuickBooks displays the New Employee window.

The Address Info tab is where you enter basic information about the employee, 
such as name, Social Insurance Number, and date of birth.
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3 In the First Name field, type Marlene.

4 In the Last Name field, type Duncalf.

Notice that QuickBooks fills in the Print As field with the information you entered 
in the name fields. You can enter a different name if you want.

5 In the Address field, type 195 Spruce Avenue, #202.

6 For the City, Province, and Postal Code fields, type Vancouver, BC T2P 5L3.

7 In the Phone field, type 415-555-1111.

8 In the SIN field type 111-111-118.

9 In the Date of Birth field, type 7/18/82.

10 In the Hired field, type 11/25/2003.

11 Click OK.

12 When QuickBooks asks if you want to set up payroll information, click Leave As Is.

You learn how to set up payroll in Lesson 12.

13 QuickBooks updates and displays the Employee list with the new employee’s 
name added.

14 Close the Employee list.
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Working with the Vendor list

The Vendor list is where you record information about the companies or people from 
whom you buy goods or services. QuickBooks uses the data in the Vendor list to fill in 
purchase orders, receipts, bills, and cheques as you receive and pay for goods and 
services.

Adding new vendors

In this exercise, you’ll add a new vendor to the Vendor list. Suppose Rock Castle 
Construction is working with a new subcontractor, and it needs to add information 
about the new vendor to its QuickBooks Vendor list.

1 From the Vendors menu, choose Vendor List.

QuickBooks displays the Vendor list.

2 Click the Vendor menu button, then choose New.

QuickBooks displays the New Vendor window.

The New Vendor window is where you enter all of the information regarding a 
new vendor, such as name, phone, contact, address, and opening balance. Just as 
when you add a new customer, you start by providing basic information on the 
Address Info tab.

3 In the Vendor Name field, type Hughes Electric.

This is the name QuickBooks displays for this vendor in the Vendor list. If the 
vendor is an individual, you may want to enter the last name first, then the first 
name.

4 In the Company Name field, type Hughes Electric.

5 Click in the Address field at the end of the first line. Notice that QuickBooks 
displays the company name on the first line of the Address field. Press ENTER.

6 On the second line of the Address field, type P.O. Box 2316.

7 Press ENTER to move to the next line.

8 Type Nanaimo, BC V6C 2R3

9 In the Contact field, type David Hughes.
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10 In the Phone field, type 510-555-6666.

11 In the FAX field, type 510-555-6667.

When you finish, your window should look like this.

Providing additional vendor information

The Additional Info tab in the New Vendor window is where you can enter a vendor 
type (if you want to categorize your vendors), payment terms, your credit limit, the 
vendor’s business number, whether this vendor is eligible for a T4A form, and your 
opening balance. You’ll add this information now for Hughes Electric.

To add information to a vendor record:
1 Click the Additional Info tab.

QuickBooks displays the Additional Info tab of the New Vendor window.
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2 In the Account No. field, type 123-445.

3 In the Type field, type Subcontractors.

Notice that when you type “sub,” QuickBooks fills in the rest.

4 In the Terms field, choose 2% 10 Net 30 from the drop-down list.

5 In the Credit Limit field, type 2000 and press TAB.

Your New Vendor window should resemble the figure below.

6 Click OK.

QuickBooks adds the vendor and displays the updated Vendor list.

Notice that Hughes Electric has been added to the list.

7 Close the Vendor list.
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Adding custom fields

QuickBooks lets you add custom fields to your Customer:Job, Vendor, Employee, and 
Item lists. Custom fields give you a way to track additional information specific to 
your business. For example, you can add a field for pager numbers to your Vendor and 
Employee lists, a field for customers’ birthdays to your Customer:Job list, and fields for 
units of measurement, colour, and size to your Item list.

When you add the custom fields to your sales forms or purchase orders, the fields are 
prefilled with the information for that specific customer, employee, vendor, or item 
(if you specified a value for the custom field when you added the customer, for 
example). You don’t have to add the custom fields to your forms, however; you can 
also use custom fields as a way to record information just for your use, such as a credit 
rating for each customer. QuickBooks remembers the information you entered in the 
custom fields when you import and export data and when you memorize transactions.

For each customer, vendor, and employee, you can add up to seven custom fields, 
including fields that overlap. For example, if you add a custom birthday field for 
customers, vendors, and employees, QuickBooks counts it as one field used for each. 
You can add up to five custom fields for each item your company sells.

After you add custom fields, you can use them on invoices, credit memos, sales 
receipts, estimates (QuickBooks Pro and Premier only), and purchase orders.

Adding custom fields for customers, vendors, and employees

You can enter information in the custom fields only through the New or Edit windows 
(for example, the New Customer or Edit Customer windows). You can display 
information from the custom fields on forms as well as add custom fields to reports.

First, look at the custom fields that Rock Castle Construction has already added to its 
Customer:Job, Vendor, and Employee lists. Then, you’ll add two new custom fields.

To add custom fields:
1 From the Customers menu, choose Customer:Job List.

QuickBooks displays the Customer:Job list.

2 In the Customer:Job list, select Cook, Brian.

3 Click the Customer:Job menu button, then choose Edit.

QuickBooks displays the Edit Customer window.
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4 Click the Additional Info tab.

QuickBooks displays the Additional Info tab in the Edit Customer window.

5 Click Define Fields.

QuickBooks displays the Define Fields window.
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Notice that Rock Castle Construction has already set up custom fields in the 
Customer:Job list for contract number, birthday, spouse’s name, ID and 
percentage. In the Vendor list, they have set up a custom field for discount 
available. In the Employees list, they have set up custom fields for birthday, the 
date of last raise, the spouse’s name, id and password.

Now, you’ll add a custom field for pager numbers to the Customer:Job and Vendor 
lists. You’ll also add a custom field to the Employees list that tracks the date of 
each employee’s last review.

6 In the first blank Label field, type Pager Number.

7 Click the Customers:Jobs checkbox to select it.

8 Click the Vendor checkbox to select it.

9 In the next blank Label field, type Date of last review.

10 Click the Employees checkbox to select it.

Your Define Fields window should now look like this.
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11 Click OK.

12 If you see an informational message about using the custom fields in transactions 
by turning them on in your custom templates, click OK.

QuickBooks has added the Pager Number field to the Edit Customer window.

13 In the Pager Number field, type 415-555-9876.

If you customize your sales forms to display the Pager Number field, this number 
displays whenever you create a form for this customer. It also displays on reports 
modified to display the Pager Number column.

14 Click OK to close the Edit Customer window.

15 Close the Customer:Job list.

Adding custom fields for items

Now suppose that Rock Castle Construction wants to add another custom field to its 
Item list. The company purchases several types of locking doorknobs. The Item list 
already has custom fields for colour and Material, but now Rock Castle wants to add 
an additional field to track Style.

To add custom fields for items:
1 From the Lists menu, choose Item List.

QuickBooks displays the Item list, as shown below.

2 In the Item list, select Lk Doorknobs (a sub item of Hardware).
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3 Click the Item menu button, then choose Edit.

QuickBooks displays the Edit Item window.

4 Click Custom Fields.

QuickBooks displays the custom fields already defined for this item.

5 Click Define Fields.

QuickBooks displays the Define Custom Fields for Items window.

6 Under Use, click the first blank checkbox to select it. Then type Style in the Label 
field.

7 Click OK to close the window.

8 If you see an informational message about using the custom fields in transactions 
by turning them on in your custom templates, click OK.

9 In the Custom Fields for Lk Doorknobs window, type Round in the Style field.

10 Click OK to close the Custom Fields for Lk Doorknobs window, then click OK to 
close the Edit Item window.

11 Close the Item list.
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Managing lists

Lists are easy to manage in QuickBooks. You can sort lists, combine (merge) list items, 
rename list items, delete list items, make list items inactive, and print lists.

Sorting lists

You can sort many QuickBooks lists manually or alphabetically. To sort a list 
manually, simply use the mouse to drag a list item to its new location. Lists that you 
can sort this way are the Chart of Accounts, Customer:Job, Class, Customer Type, 
Vendor Type, Job Type, and Memorized Transaction lists.

If you have changed the order of a list by dragging items, then decide you’d rather 
have an alphabetically sorted list, QuickBooks has a Re-sort List command. In the 
chart of accounts, the Re-sort List command sorts alphabetically within account type; 
in the Item list, the Re-sort List command sorts alphabetically within item type.

Sorting lists manually

In this exercise, you’ll sort a list manually, then re-sort it to put it back in alphabetical 
order.

To sort a list manually:
1 From the Lists menu, choose Chart of Accounts.

QuickBooks displays the chart of accounts for Rock Castle Construction.

2 Click the small diamond to the left of the Owner’s Draw subaccount of Owner’s 
Equity.

The mouse pointer becomes a four-directional arrow.
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3 Click and hold the mouse button, and drag the pointer upward until you see a 
dotted line directly below Owner’s Equity.

4 Release the mouse button to drop the account in the new position.

The Owner’s Draw account is now directly under the Owner’s Equity account.

Now you can use the Re-sort List command to return the list to alphabetical order.

5 To re-sort the list alphabetically, click the Account menu button, and select  
Re-sort List.

QuickBooks asks you to confirm that you want to return the list to its original 
order.

6 Click OK.

QuickBooks re-sorts the chart of accounts alphabetically by account type.

7 Close the chart of accounts.

Sorting lists in ascending or descending order

Depending on the type of business you have, you may want to order your list entries 
in a certain way. For example, perhaps you’d like to see people who owe you money 
at the top of your Customer:Job list. In this exercise, you’ll learn how to sort the 
Customer:Job list in descending order by customer balance.

To sort a list in descending order:
1 From the Lists menu, choose Customer:Job List.

2 Click the Balance column heading.

Notice that an arrow pointing up appears on the heading and the list is sorted in 
ascending order by customer balance.
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3 Click the column heading again.

Notice that the arrow now points down and the list is sorted in descending order 
with the customers with the highest balances at the top of the list.

4 To return to the order you started with, click the large diamond to the left of the 
Name column heading.

5 Close the Customer:Job list.
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Merging list items

In most lists, you can combine two list items into one. For example, you may find that 
you’ve been using two customers (because of different spellings) when you really need 
only one on your Customer:Job list. You can merge list items in the Chart of Accounts, 
Item, Customer:Job, Vendor, Employee, and Other Names lists.

Important: After you merge list items, you cannot separate them. When working 
in your own company file, we recommend that you back up your data 
before merging list items.

In this exercise, suppose you want to merge Hughes Electric (the vendor you added 
earlier in the lesson) with C.U. Electric. To merge them, you edit the incorrect name 
to match the spelling of the correct name.

To merge items on a list:
1 From the Vendors menu, choose Vendor List. QuickBooks displays the Vendor list.

2 Select Hughes Electric.

3 Click the Vendor menu button, then choose Edit.

QuickBooks displays the Edit Vendor window.
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4 In the Vendor Name field, type C.U. Electric. (This is the vendor name you want to  
merge with.)

5 Click OK.

QuickBooks asks if you would like to merge the names.

6 Click Yes.

7 When QuickBooks asks if you are sure, click Yes again.

QuickBooks merges the two names, and you now have only C.U. Electric in the 
Vendor list.

8 Close the Vendor list.

Note: If you use assembly items in QuickBooks Premier Edition products, you cannot 
merge them with other assembly items or with any other type of item.

Renaming list items

You can rename any list item. When you make the change, QuickBooks automatically 
modifies all existing transactions containing the item.

Tip: If you don’t want to change existing transactions, add a new name or item 
instead.

To rename a list item in the chart of accounts:
1 From the Lists menu, choose Chart of Accounts to display the chart of accounts 

for Rock Castle Construction.

2 In the chart of accounts, select chequing.
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3 Click the Account menu button, and choose Edit.

QuickBooks displays the Edit Account window.

4 In the Name field, type Master Chequing Account.

5 Click OK.

If QuickBooks asks if you want to use computer cheques with this account, click 
No.

QuickBooks changes the account name in the chart of accounts.

6 Close the chart of accounts.
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Deleting items and making list items inactive

You can delete list items only if you have not used them in any transactions. If you 
try to delete a list item that is used in a transaction, QuickBooks displays a warning 
that the item can’t be deleted. If you don’t want to use a list item but you can’t delete 
it, you can make it inactive.

To make a list item inactive:
1 From the Customers menu, choose Customer:Job List.

QuickBooks displays the Customer:Job list.

2 Select Natiello, Ernesto in the list. (Select his name, not the job.)

3 Click the Customer:Job menu button, and choose Make Inactive.

4 QuickBooks displays a warning message to confirm if you want to make it inactive. 
Click Yes.

Notice that Ernesto Natiello (and the job for his kitchen) no longer appears on the 
Customer:Job list. (The customer:job item is only removed from the list—transac-
tions associated with this customer:job will still show in reports.)

5 To see inactive list items, select the Show All checkbox in the list window.

QuickBooks displays all the list items again, but the Xs signify that this customer 
is still inactive. (You make the customer active again by choosing Make Active 
from the Customer:Job menu button.)

6 Leave the Customer:Job list open, you’ll print it in the next exercise.
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Printing a list

You can print a QuickBooks list for reference, or you may print a list to a file to use in 
your word processor or spreadsheet.

To print a list of customers:
1 Click the Customer:Job menu button, then choose Print List.

QuickBooks displays a message telling you that you can also print list information 
from the Reports menu.

2 Click OK to bypass the List Reports message.

QuickBooks displays the Print Lists window, which displays the name of your 
printer and printer port. You can select to print to a printer or to a file.

3 Click Print.

Note: This is a fairly long list, so if you don’t want to print it now, click Cancel.

4 Close the Customer:Job list.
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Student test and review
1 Match the information on the left with the appropriate QuickBooks list on the 

right.

2 Add the following customer using the data below:

Customer Name: Alla Rozenvasser

Opening Balance: $234.00

Company Name: Rozenvasser Advertising

Contact: Alla Rozenvasser

Bill to: 300 Main Street, Suite #3, Penticton, BC V6R 2B1

Phone: 415-555-6767

Fax: 415-555-9090

Alt. Contact: Shannon Stubo

Type: Commercial

Credit Limit: $2500

Terms: Net 15

3 Add a new vendor using the data below:

Vendor: Martin Drywall

Contact: Sean D. Martin

Address: P.O. Box 76, Calgary, AB T2C 5G6

Phone: 555-5432

Fax: 555-6565

Account: 082-4343

Type: Subcontractors

Terms: Net 30

Credit Limit: 1,000.00

1. A subcontractor A. Customer:Job list

2. Someone who purchases the goods 
or services you sell

B. Chart of accounts

3. A new hire C. Vendor list

4. Chequing account D. Employee list
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Lesson objectives
■ To learn how to work with the registers for QuickBooks bank accounts

■ To demonstrate how to open a register

■ To learn the features common to all registers

■ To learn when and how to make entries directly in the register

■ To demonstrate how to reconcile a QuickBooks bank account

Handout materials
■ Handout 12:  Registers associated with QuickBooks windows

■ Handout 13:  Using the keyboard to move around a register

To start this lesson

Before you perform the following steps, make sure you have installed the exercise file 
(qbcanlesson.qbb) on your hard disk. 

The steps that follow will restore the exercise file to its original state so that the data 
in the file matches what you see on the screen as you proceed through each lesson.

To restore the exercise file (qbcanlesson.qbb):
1 From the File menu in QuickBooks, choose Restore.

QuickBooks displays the Restore Company Backup window.

2 In the “Get Company Backup From” section of the window, click Browse and 
select your c:\QBtrain directory.

3 Select the qbcanlesson.qbb file, then click Open.

4 In the “Restore Company Backup To” section of the window, click Browse and 
select your c:\QBtrain directory.

5 In the File name field of the Restore To window, type lesson 4, then click Save.

6 Click Restore.
72



                                                                                                
L E S S O N  4
Writing a QuickBooks cheque

You can enter cheques directly into QuickBooks by using the QuickBooks Write 
Cheques window. When you enter a cheque in the Write Cheques window, you can 
see the address information and easily allocate the cheque between multiple accounts.

Suppose that coming back from a customer call, you purchased a new phone for Rock 
Castle Construction from a phone company store. Now you should record the cheque 
you wrote for the telephone in QuickBooks.

To write a cheque:
1 From the Banking menu, choose Write Cheques.

QuickBooks displays the Write Cheques window.

The Bank Account field shows the account from which you are writing this 
cheque. QuickBooks displays the current date in the Date field. (The sample data 
is set to display December 15, 2007 as the current date.) You can change either of 
these values if you want, but they are fine for our example.

2 Select the “To be printed” checkbox.

If QuickBooks reminds you to order computer cheques, click Close.

3 In the Pay to the Order of field, type Cal Telephone.

If QuickBooks notifies you that you have bills open for this vendor, click OK. You 
are receiving this reminder because you should never use the Write Cheques 
window to pay a bill you entered earlier in QuickBooks. If you enter a bill (as you 
will in a later chapter), always pay it with the Pay Bills window, not the Write 
Cheques window.
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4 Press TAB to move to the Amount field.

Tip: QuickBooks has an AutoRecall feature that fills in the amount from the last 
transaction with a payee. This is convenient when you have recurring payments 
of the same amount. You can turn on AutoRecall by choosing Preferences 
from the Edit menu. Click General, then select the checkbox for “Automati-
cally recall last transaction for this name” on the My Preferences tab.

5 Type 156.91 (the amount the telephone cost), then press TAB.

Notice that QuickBooks spells out the amount of the cheque for you on the line 
below the payee.

6 Click in the Account column on the Expenses tab, then choose Utilities:Telephone 
from the drop-down list.

Your screen should resemble the following figure.

The Expenses tab is where you assign the amount of the cheque to one of the 
expense accounts on your company’s chart of accounts. In this case, Rock Castle 
Construction assigns the cheque to its Utilities account and the Telephone subac-
count. You use the Items tab only when purchasing items you plan to stock in 
inventory. Note the taxes amount is deducted from the expense amount and 
displayed separately.

7 Click Save & Close.
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8 From the Banking menu, choose Use Register.

Rock Castle Construction has more than one type of bank account, so QuickBooks 
displays the Use Register window and asks you to specify the account you want.

9 Click OK to accept Chequing as the account whose register you want to see.

QuickBooks opens the Chequing register.

Notice that the cheque you just wrote is listed in the register as a cheque that needs 
to be printed.

10 Close the Chequing account register.

Using bank account registers

When you work in QuickBooks, you often use forms, such as a cheque or an invoice, 
to enter information. But behind the scenes, QuickBooks records your entries in the 
appropriate account register. Each balance sheet account listed on the chart of 
accounts has a register associated with it (except the Retained Earnings account).

Opening a register

When you have a QuickBooks form displayed on your screen, you can view its account 
register by choosing Use Register from the Banking menu, or by double-clicking the 
account name in the chart of accounts.

To open a register (when no form is open):
1 From the Lists menu, choose Chart of Accounts.

QuickBooks displays the Chart of Accounts window.
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2 In the chart of accounts, double-click the Savings account.

QuickBooks opens the register for Rock Castle Construction’s Savings account

Common features of QuickBooks registers

All QuickBooks registers work the same way, regardless of the accounts with which 
they are associated. Here are some common features of all QuickBooks registers:

■ The register shows every transaction that affects an account’s balance and lists 
them in chronological order (though you can change the order by choosing a 
different option from the Sort by drop-down list). For example, in a chequing 
account, the register shows cheques you’ve written (either with QuickBooks or by 
hand), deposits to the account, and withdrawals from the account.

■ The columns in the register give specific information about the transaction. The 
first column is the date. The second column shows a reference number (a cheque 
number or a vendor’s P.O. number) and a type (to tell you whether the transaction 
represents a cheque or a bill payment, for example). The next column lists the 
payee, the account to which you’ve assigned the transaction, and any descriptive 
memo you choose to type. The final columns for a bank account show the trans-
action amount (either in the Payment or Deposit column) and whether the trans-
action has cleared the bank (indicated by a checkmark in the column).

■ On every transaction line, QuickBooks shows the account’s running balance. The 
bottom of the register window shows the account’s ending balance—the balance 
takes into account all the transactions entered in the register, including cheques 
you haven’t yet printed.

To complete the exercise:
1 Close the Savings register window.

2 Close the chart of accounts.
76



                                                                                                
L E S S O N  4
Entering a handwritten cheque

Sometimes you need to write a cheque on the spot for items you did not plan to 
purchase. QuickBooks lets you write the cheque, then enter it later in the chequing 
account register or on the cheque form.

Suppose that while picking up supplies one day, you stop at Bayshore Office Supply 
and find a new office chair on sale for $99.95. The sale ends today, so you write a 
cheque on the spot. You’ll have to enter it in QuickBooks later.

To enter a handwritten cheque in the chequing account register:
1 From the Banking menu, choose Use Register.

QuickBooks displays the Use Register window.

2 Click OK to accept Chequing.

QuickBooks displays the register for the Chequing account.

3 Click in the Number field in the blank transaction at the bottom of the register, 
then double-click to highlight the number that QuickBooks prefills.

4 Type 1204, then press TAB.

5 In the Payee field, type Bayshore Office Supply, then press TAB.

QuickBooks displays a message telling you that Bayshore Office Supply is not on 
the Name list.

6 Click QuickAdd.

QuickBooks displays the Select Name Type window.

Bayshore Office Supply is a vendor, so you can accept the displayed choice.

7 Click OK. QuickBooks adds the new vendor to the Vendor list.

8 In the Payment field, type 99.95, then press TAB.

9 In the Account field, type Of, then press TAB. QuickBooks fills in Office Supplies.
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10 In the Memo field, type Office Chair.

The Chequing account register on your screen should resemble the following 
figure.

11 Click Record.

12 Close the Chequing account register.
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Transferring money between accounts

You can easily record that you have transferred money between the accounts at your 
financial institution using the QuickBooks Transfer Funds Between Accounts window. 
Rock Castle Construction wants to record that is has transferred $5,000.00 from 
chequing to savings.

To transfer money:
1 From the Banking menu, choose Transfer Funds.

QuickBooks displays the Transfer Funds Between Accounts window.

Notice that QuickBooks displays the current balance for the Chequing account.

2 In the Transfer Funds To field, choose Savings from the drop-down list.

3 In the Transfer Amount field, type 5000.00, then press the Tab key.

Your screen should resemble the following figure.

4 Click Save & Close.

QuickBooks decreases the balance in the chequing account by $5,000 and increases 
the balance in the savings account by $5,000.
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Reconciling chequing accounts

Reconciling is the process of making sure that your chequing account record matches 
the bank’s record.

An overview of reconciliation

When you keep your records with QuickBooks, you don’t have to worry about 
addition or subtraction errors like you do when you’re using a paper cheque register. 
Even so, it is important to get in the habit of reconciling your QuickBooks bank 
accounts on a monthly basis. This helps you avoid overdraft charges for bad cheques, 
gives you a chance to spot possible bank errors, and helps you keep more accurate 
financial records.

Your bank sends you a statement for each of your accounts each month. The 
statement shows all the activity in your account since the previous statement:

■ The opening balance for your bank account (amount in your account as of the 
previous statement)

■ The ending balance for your bank account (amount in your account as of the 
closing date for the statement)

■ The amount of interest, if any, you’ve received for this statement period

■ Any service charges assessed by the bank for this statement period

■ Cheques that have cleared the bank

■ Deposits you’ve made to the account

■ Any other transactions that affect the balance of your account (for example,  
automatic payments or deposits or automatic teller machine (ATM) withdrawals 
or deposits)

When you receive a statement from your bank or from a credit card company, you 
need to reconcile the statement with your QuickBooks records. You can reconcile any 
QuickBooks bank account, including accounts for savings and money market funds. 
The goal of reconciling is to make sure that your QuickBooks records and the bank’s 
statement agree about your account balance.

Marking cleared transactions

To begin reconciling an account, you need to tell QuickBooks which account you 
want to reconcile. Then you can provide information from the top part of your bank 
statement.

To reconcile your account:
1 From the Banking menu, choose Reconcile.

QuickBooks displays the Begin Reconciliation window.
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2 In the Account field, make sure Chequing is selected.

3 In the Ending Balance field, type 106,803.13.

4 In the Service Charge field, type 14.00.

5 In the Service Charge Account field, select Bank Service Charges from the drop-
down list.

Your screen should resemble the following.

6 Click Continue.

QuickBooks displays the Reconcile - Chequing window.
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7 In the Cheques, Payments and Service Charges section, select cheque # 265 from 
Reyes Properties for $1,200.00, and cheque #266 from Larson Flooring for 
$2,700.00.

QuickBooks places a checkmark to the left of both items.

8 In the Deposits and Other Credits section, select the Cheq# 9 deposit 
dated12/10/07 for $109.25.

Your screen should resemble the following figure.

Tip: The Go To button allows you to select a transaction that needs a correction, 
jump to the actual transaction in the register to make an adjustment, then 
return to the reconciliation window.

9 Click Reconcile Now.

Wait a few moments while QuickBooks examines and reconciles the account.

10 If QuickBooks prompts you to consider using Online Banking, click OK to 
continue.

QuickBooks displays the Select Reconciliation Report window.
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11 In the Select Reconciliation Report window, select “Detail”, then click Display. 
Click OK at the message that QuickBooks displays.

QuickBooks displays the reconciliation detail report. It’s a good idea to print each 
reconciliation report, but for the purposes of this lesson viewing the report is suffi-
cient. 
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Because QuickBooks Basic and QuickBooks Pro only store information for the 
latest reconciliation, you may want to print the report to a file if you think you 
will want to print the reconciliation report again. QuickBooks overwrites the 
previous reconciliation report with data from the latest reconciliation.

If you’re using QuickBooks Premier, you can print the reconciliation reports for all 
previous reconciliations.

In addition, if you’re using QuickBooks Premier, you have two additional report 
options: the reconcile discrepancy report and the reconciliation summary report. 
The reconcile discrepancy report lists the transactions that have changed since 
you last reconciled an account. This report is useful when the beginning balance 
that QuickBooks shows is different than the ending balance from the bank 
statement for the previous period. The reconciliation summary report provides a 
quick look at the overall totals for deposits/credits and cheques/payments for a 
reconciliation period.

12 Close the report window.

Now you know that the balance in your QuickBooks cheque register is accurate as of 
the latest bank statement. The next time you look at the cheque register, you’ll see a 
checkmark in the Cleared column next to each reconciled transaction.

Viewing cleared cheques in the register

Open the Chequing account register to see the cleared cheques.

To viewed cleared cheques in the register:
1 From the Banking menu, choose Use Register.

QuickBooks displays the Use Register window.

2 Click OK to accept Chequing.

3 Scroll through the register to view the cleared items (cheques numbered 265 and 
266).

Your register should resemble the figure below.
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Notice that QuickBooks displays a checkmark next to all cleared items.

4 Close the Chequing account register.
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Student test and review
1 Use the chequing account register to enter a handwritten cheque for $76.95. Use 

the next available cheque number and make the cheque payable to Express 
Delivery Service, for delivery of a new sign. Assign the cheque to the Freight & 
Delivery expense account.

2 Write a QuickBooks cheque to Bayshore Water for $143.87 to pay this month’s 
water bill. Assign the cheque to the Utilities:Water expense account.
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Lesson objectives
■ To introduce the other account types available in QuickBooks

■ To learn how to track credit card transactions in QuickBooks

■ To reconcile a credit card account

■ To see how to make a credit card payment

■ To discuss the different types of asset and liability accounts you can create and see 
how to track assets and liabilities in QuickBooks

■ To introduce the subject of equity and QuickBooks equity accounts

Handout materials
■ Handout 14:  Determining the value of a fixed asset

■ Handout 15:  Tracking asset cost and depreciation

■ Handout 16:  Understanding QuickBooks equity accounts

To start this lesson

Before you perform the following steps, make sure you have installed the exercise file 
(qbcanlesson.qbb) on your hard disk. 

The steps that follow will restore the exercise file to its original state so that the data 
in the file matches what you see on the screen as you proceed through each lesson.

To restore the exercise file (qbcanlesson.qbb):
1 From the File menu in QuickBooks, choose Restore.

QuickBooks displays the Restore Company Backup window.

2 In the “Get Company Backup From” section of the window, click Browse and 
select your c:\QBtrain directory.

3 Select the qbcanlesson.qbb file, then click Open.

4 In the “Restore Company Backup To” section of the window, click Browse and 
select your c:\QBtrain directory.

5 In the File name field of the Restore To window, type lesson 5, then click Save.

6 Click Restore.
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Using other account types in QuickBooks

In this lesson, you’ll learn about these types of QuickBooks accounts:

■ Credit card accounts—Used to track transactions you pay for with a credit card.

■ Asset accounts—Used to track both current assets (those assets you’re likely to 
convert to cash or use up within one year, such as inventory on hand) and fixed 
assets (such as long-term notes receivable and depreciable assets your business 
owns that aren’t liquid, such as equipment, furniture, or a building).

■ Liability accounts—Used to track both current liabilities (those liabilities 
scheduled to be paid within one year, such as sales tax, payroll taxes, and short-
term loans) and long-term liabilities (such as loans or mortgages scheduled to be 
paid over terms longer than one year).

■ Equity accounts—Used to track owner’s equity, including capital investment, 
draws, and retained earnings.

Tracking credit card transactions

In your business, you sometimes pay for expenses with a credit card rather than a 
cheque. For travel expenses especially, a credit card is invaluable because it gives a 
detailed listing of each charge. You can track your credit card transactions in 
QuickBooks just as easily as you track expenses you pay for by cheque.

You should set up a QuickBooks credit card account for each credit card you use in 
your business. Like any QuickBooks account, a credit card account has its own register. 
The register lists all the charges and credits you've recorded, as well as payments you've 
made.

The way you open and scroll through a credit card register is the same way you open 
and scroll through any QuickBooks account register.
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Entering credit card charges

QuickBooks lets you choose when you enter your credit card charges. You can enter 
credit card charges when you charge an item or when you receive the bill. Your choice 
depends on whether you like to enter information into QuickBooks incrementally or 
all at once. The advantage to entering charges when you charge an item is that you 
can keep close track of how much you owe. In addition, if the charge is for a particular 
job, you can keep track of how much you’re spending on that job.

Suppose you have a $30 gasoline charge you want to enter into QuickBooks. The form 
you use is the Enter Credit Card Charges form.

To enter a credit card charge:
1 From the Banking menu, choose Enter Credit Card Charges.

QuickBooks displays the Enter Credit Card Charges window. 

This is the window where you enter your charges. Notice that the form at the top 
of the window looks just like a familiar credit card charge slip.

2 In the Credit Card field, select CalOil Card from the drop-down list (if it’s not 
already selected).

3 In the Purchased From field, select Bayshore CalOil Service from the drop-down 
list.

The next field is called Ref No. Most credit card receipts have some sort of  
transaction number near the top, which exists for identification and tracking 
purposes. Entering this number from a credit card receipt gives you additional 
information for the credit card charge, but you don't have to use it. You don’t need 
to enter one for this example.

4 Click in the Amount field, then double-click to select the entire amount.
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5 Type 30.00, then press Tab.

6 Click the Expenses tab (if it’s not already selected).

7 In the detail area, click in the Account column and assign the charge to the  
Automobile:Fuel expense account, as shown in the figure below. (Automobile is 
the account; Fuel is the subaccount.) Leave the tax column empty for now.

8 Click Save & Close to record the transaction and close the window.

After you record this credit card charge, QuickBooks adds a $30 transaction to the 
credit card account register (increasing the liability by $30). It also adds $30 to the 
Automobile:Fuel expense account. (You will see the increase when you create reports 
on their expense accounts.)

Reconciling a credit card statement

Just as we reconciled a bank account in the previous lesson, you should compare your 
credit card receipts with your statement and reconcile your credit card statement. 
Reconciling a credit card account is almost identical to reconciling a bank account.

To reconcile a credit card statement:
1 From the Company menu, choose Chart of Accounts.

QuickBooks displays the chart of accounts.

2 Click CalOil Card in the list once to select it.
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3 Click the Activities menu button, then choose Reconcile Credit Card.

QuickBooks displays the Begin Reconciliation window.

In the Opening Balance field, QuickBooks displays the balance of all cleared  
transactions in the credit card register. To reconcile a credit card statement, all you 
have to do is enter the ending balance and check off each transaction listed on 
your statement.

4 In the Statement Date field, enter 12/15/2007.

5 In the Ending Balance field, type 101.02.

Note: When the opening balance is different from the previous month’s ending 
balance, check for cleared transactions that are now showing as uncleared.

6 Press Continue.

QuickBooks displays the Reconcile Credit Card window.

The Reconcile Credit Card window shows all the transactions for the credit card 
account that have not yet cleared. You’ll use this window to check off the trans-
actions listed on your statement.
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Marking cleared transactions

To mark the transactions as cleared:
1 In the Charges and Cash Advances section of the window, select all three charges.

2 In the Payments and Credits section of the window, select the 12/02/07 payment 
for $135.80.

QuickBooks places a checkmark in the column to the left of each transaction you 
select. Your Reconcile Credit Card window should resemble the following figure.

3 Click Reconcile Now.

QuickBooks displays the Make Payment window.

When you’ve finished reconciling a credit card account, QuickBooks gives you a 
chance to pay part or all of the balance due on your credit card.

4 For this exercise, you want to write a cheque for payment now, so leave that 
option selected and click OK.

QuickBooks displays the Select Reconciliation Report window.
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5 In the Select Reconciliation Report window, select Detail, then click Display. (If 
you wanted to keep a copy of the reconciliation report, you would click Print, but 
you don’t need to print the report for this lesson.)

6 Click OK at the message that QuickBooks displays.

7 Review the report, then close it.

Paying a credit card bill

To write a cheque for the bill now:
1 In the Write Cheques window, make sure Chequing is shown as the bank account.

Notice that QuickBooks has already filled in the amount of the payment for you, 
and has assigned the expense to the CalOil Card account. (If you change your 
mind and decide you only want to make a partial payment, you can change the 
amount here.)
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2 Click in the Pay to the Order of field and select CalOil Company as the name of 
the credit card company from the drop-down list.

3 When QuickBooks asks if you want to autorecall the previous transaction for 
CalOil Company, click No.

4 Click in the “To be printed” checkbox to put a checkmark in it.

If QuickBooks reminds you that you can order cheques from Intuit, click Close. 
Your window should resemble this one.

5 Click Save & Close to record the transaction.

QuickBooks subtracts $101.02 from your chequing account and also subtracts that 
amount from what you owe to the credit card company.

Working with asset accounts

QuickBooks has two account types for tracking the value of your short- and long-term 
assets:

■ An Other Current Asset account tracks assets that are likely to be converted to  
cash or used up within one year. If you buy and sell inventory, the value of all  
your inventory on hand is usually shown in an Other Current Asset account  
called something like “Inventory Asset.” Other current assets might include 
treasury bills, certificates of deposit, prepaid expenses (amounts already paid for 
services your business has yet to receive), prepaid deposits (which will be returned 
to you at a later date), reimbursable expenses, and notes receivable (if due within 
one year).
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■ A Fixed Asset account tracks assets your business owns that are not likely to  
be converted into cash within a year. A fixed asset is usually something  
necessary for the operation of your business, like a truck, cash register, computer, 
or photocopier.

Setting up an Other Current Asset account

Suppose you need an Other Current Asset account to track a prepaid expense for rent. 
(The landlord requires a six-month advance payment.)

1 In the chart of accounts, click the Account menu button, then choose New.

QuickBooks displays the New Account window.

2 For the Type, choose Other Current Asset from the drop-down list.

3 In the Name field, type Prepaid Rent.

4 In the Opening Balance field, type 6000.

5 Click OK.

QuickBooks displays the new account in the chart of accounts.

As each month goes by and you use part of that prepaid expense, you can enter each 
month’s rent as a decrease in the value of the current asset and assign it to the rent 
expense account. You would enter those transactions directly in the register for the 
Prepaid rent asset account.
96



                                                                                                
L E S S O N  5
Setting up accounts for fixed assets

Fixed Asset Tracking allows you to keep track of asset information, easily add new 
fixed assets to QuickBooks, track disposed fixed assets, and produce fixed asset reports. 
The Fixed Asset Item list provides a way for your clients to easily enter and track 
information such as asset names, serial numbers, acquisition dates and disposal dates.

Setting up asset accounts to track depreciation

There is more than one way to keep track of depreciation; this is just one suggested method. 
If you have students who are keeping track of asset depreciation in other ways, assure them 
that they can continue using their own method.

Fixed assets are equipment or property your business owns that are not for sale. Since 
they last a long time, you don’t completely charge their cost to the year in which you 
buy them. Instead, you spread their cost over several years. But because fixed assets 
wear out or become obsolete, their value declines constantly from the day you 
purchase them. The amount of this decline in value is called depreciation.

To determine the estimated value of a fixed asset at any point in time, you need to 
subtract its accumulated depreciation (total amount of depreciation since the asset’s 
purchase) from its original cost.

Usually, you’ll want your balance sheet to show the original cost of an asset (plus any 
subsequent improvements) on one line, with the accumulated depreciation subtracted 
from the original cost on a second line, and the current value (net) on a third line. The 
method you’ll learn in this lesson lets you see each asset’s cost and its accumulated 
depreciation separately on your balance sheet. You set up a separate fixed asset 
account for each asset, and two subaccounts under each fixed asset account: one for 
cost and one for accumulated depreciation.

In the next exercise, you’ll set up an asset account to track depreciation on a new 
trailer purchased by Rock Castle Construction.

To set up asset accounts to track depreciation:
1 In the chart of accounts window, click the Account menu button, then choose 

New.

QuickBooks displays the New Account window.

2 In the Type field, choose Fixed Asset from the drop-down list.

3 In the Name field, type Trailer.

4 Leave the opening balance blank, and click OK.

QuickBooks displays the new fixed asset account in the chart of accounts.
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Now you need to add two subaccounts—one for the asset’s cost, and the other for 
depreciation.

To add subaccounts:
1 In the chart of accounts window, click the Account menu button, then choose 

New.

2 In the Type field, choose Fixed Asset from the drop-down list.

3 In the Name field, type Cost.

4 Select the “Subaccount of” checkbox, then select Trailer as the parent account.

5 Leave the opening balance blank.

Tip: The opening balance is the original cost of the asset, if you purchased the 
asset before your QuickBooks start date. If you’re buying the asset now, as the 
owner of Rock Castle Construction is, you leave the opening balance for the 
Cost account blank. When you enter information about the loan Rock Castle 
Construction takes out to pay for the truck (later in this lesson), you’ll update 
the Cost account with the truck’s original cost.

Your screen should resemble the following figure.

6 Click OK.

7 Repeat the previous steps to add a second subaccount to the Trailer fixed asset 
account. Call the subaccount “Accumulated Depreciation,” and leave the opening 
balance blank.
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The New Account window should look like this.

When you complete these steps, your chart of accounts should look like this.

Note: The amount you enter as the opening balance depends on whether you 
acquired the asset after or before your QuickBooks start date. If you 
acquired the asset after your QuickBooks start date, you don’t enter an 
opening balance. If you acquired the asset before your QuickBooks start date, 
you enter the accumulated depreciation of the asset as of the start date—
entered as a negative number.
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Adding fixed asset information

For most fixed asset accounts found in your Chart of Accounts, you should create a 
corresponding fixed asset item that describes the fixed asset.

To add a new fixed asset item:
1 From the Lists menu, choose Fixed Asset Item List.

QuickBooks displays the Fixed Asset Items List screen: 

2 To add a fixed asset item, click the Item menu button, then choose New.

The QuickBooks New Item screen is displayed:

Notice the Type field is set to Fixed Asset and cannot be changed.

3 In the Asset Name/Number field, type Trailer and press TAB.

4 In the Purchase Information area, ensure the “Item is new” option is selected.

5 In the Purchase Description field, type 12 cubic meter double axle trailer and press 
TAB.

6 In the Purchase Date field, type 12/15/2007.

7 In the Purchase Cost field, type 30000.
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8 In the Asset Account field, select the Trailer fixed asset from the drop-down list.

9 In the Inventory Information area, type SN12345 in the Serial Number field.

The New Item screen should look as follows:

10 Click OK to create the fixed asset item.

The updated Fixed Asset Item List is displayed with the added item:
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11 To add another fixed asset item follow the steps below:

- Click the Item menu button, then choose New

- In the Asset Name/Number field, type Pickup Truck and press Tab.

- Select the “Item is used” checkbox.

- In the Purchase Description field, type 2000 1-Ton Pickup and press Tab.

- In the Purchase Date field, type 12/31/2007.

- In the Purchase Cost field, type 18602.91.

- In the Asset Account field, select the Trucks fixed asset from the drop-down 
list.

- In the Serial Number field, type SN2000.

- Click OK to create the fixed asset item.

12 To add a third fixed asset item follow the steps below:

- Click the Item menu button, then choose New

- In the Asset Name/Number field, type Utility Truck and press Tab.

- Select the “Item is used” checkbox.

- In the Purchase Description field, type 1999 1/2 Ton 4WD and press Tab.

- In the Purchase Date field, type 12/31/2007.

- In the Purchase Cost field, type 12250.

- In the Asset Account field, select the Trucks fixed asset from the drop-down 
list.

- In the Serial Number field, type SN1999.

- Click OK to create the fixed asset item.

The updated Fixed Asset Item List is displayed with the added item:
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Reporting fixed asset item information

Suppose you’re viewing the Fixed Asset Item list, and you want to see a summary 
report of all the fixed asset items.

To generate a fixed asset item summary report:
1 From the Fixed Asset Item List, click the Reports menu button, then select Fixed 

Asset Listing.

The following report is displayed:

The Fixed Asset Listing report provides a one line summary of all fixed asset items.

2 Close the report and you return to the Fixed Asset Item List screen.

Working with liability accounts

QuickBooks has two account types for tracking the value of your short- and long-term 
liabilities:

■ An Other Current Liability account tracks liabilities that your company expects to 
pay within a year. Other current liabilities might include short-term loans or a line 
of credit.

■ A Long-term Liability account tracks debts that your business is not likely to pay 
off within a year. The most common long-term liabilities are loans that you expect 
to pay off in more than one year.

Tracking a loan with a long-term liability account

You’ve already added an asset account to track the value of the new trailer. Because 
the trailer loan is not going to be paid off in a year or less, you need to add a long-term 
liability account.

To add a long-term liability account:
1 In the chart of accounts, click the Account menu button, then choose New.

2 In the New Account window, select Long Term Liability in the Type drop-down 
list.

3 In the Name field, type Trailer Loan.
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4 Leave the Opening Balance field blank.

Your screen should resemble the figure below.

5 Click OK.

QuickBooks displays the new liability account in the chart of accounts.

Because this is a new loan, you are either receiving money to deposit in your bank 
account or receiving a new asset. In this example, you received an asset (the new 
trailer), so you need to show an increase in the asset’s Cost account.

To record an increase in the asset’s Cost account:
1 In the chart of accounts, double-click the Trailer:Cost subaccount.

QuickBooks displays the Trailer:Cost register.
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2 In the Increase field, type 30,000.

3 In the Account field, select the Trailer Loan liability account from the drop-down 
list.

Make sure that you select the Trailer Loan long-term liability account, not the 
Trailer fixed asset account.

Your screen should resemble the following.

4 Click Record.

5 Close the register window.

6 Close the chart of accounts.

When you complete these steps, QuickBooks increases the value of your Cost asset 
account to 30,000. (This effectively sets the opening balance.) It also enters a liability 
of 30,000 in the liability account you use to track the loan. (Again, this sets the 
opening balance.)

Recording a payment on a loan

When it's time to make a payment on a loan, use the Write Cheques window to record 
a cheque to your lender. You’ll want to assign part of the payment to a loan interest 
expense and the remainder to loan principal.

To record a payment on a loan:
1 From the Banking menu, choose Write Cheques.

QuickBooks displays the Write Cheques window.
105



U s i n g  o t h e r  a c c o u n t s  i n  Q u i c k B o o k s
2 In the “Pay to the Order of” field, type Great, then press Tab.

QuickBooks fills in the field with Great Canadian Bank. If QuickBooks asks 
whether you want to use the last transaction for this vendor, click No.

3 For the dollar amount of the cheque, type 500.00.

4 Click the Expenses tab, then click in the Account column and choose the Interest 
Expense:Finance Charge expense account from the drop-down list.

5 In the Net Amt column highlight the amount that QuickBooks prefilled, then type 
225.00.

6 On the next line, assign the remainder of the expense (275.00) to the Trailer Loan 
long-term liability account.

7 Click Save & Close to record the payment.

When you record the transaction, QuickBooks automatically updates the accounts 
affected by this transaction:

■ In your chequing account, QuickBooks subtracts the amount of the cheque from 
your balance.

■ In the expense account that tracks interest, QuickBooks enters the interest amount 
as an increase to your company's interest expense.

■ In the Trailer Loan liability account, QuickBooks subtracts the principal amount 
from the current value of the liability (reducing the amount of your debt).
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Depreciating and selling fixed assets

Entering depreciation transactions

When it's time to enter depreciation for an asset, you can use the register for the asset's 
accumulated depreciation account.

To enter a transaction for depreciation:
1 In the chart of accounts, select the Trailer: Accumulated Depreciation subaccount.

2 Click the Activities menu button, then choose Use Register.

QuickBooks displays the register for the Trailer:Accumulated Depreciation asset 
account.

3 In the Decrease column, type 1300 and press Tab. This is the depreciation amount.

4 In the Account field, select Depreciation Expense from the drop-down list.

Your register should resemble the following figure.

5 Click Record.

6 Close the register window.

7 Close the Chart of Accounts window.

When you record the transaction, QuickBooks does the following:

■ Subtracts the depreciation amount from the current value of the asset in the asset's 
fixed asset account.

■ Enters the depreciation amount as an increase to your company's depreciation 
expense in the expense account that tracks depreciation.
107



U s i n g  o t h e r  a c c o u n t s  i n  Q u i c k B o o k s
Disposing of fixed assets

When managing your own fixed assets, you can record the disposal of fixed assets 
using sales receipts/invoices when you receive money or the promise of money from 
the purchaser of the asset or using general journal entries when you don't receive 
money for the asset.

In the following exerice, we will record the disposal of a fixed asset created in a 
previous exercise by updating the fixed asset item sales information, generating a sales 
receipt recording payment at the time of the sale, then flagging the fixed asset item as 
as inactive.

To update the sales information for a fixed asset item:
1 From the Fixed Asset Item List, select the Trailer fixed asset, click the Item button, 

then select Edit to display the Edit Item screen.

2 In the Sales Information section, select the Item is sold checkbox.

QuickBooks automatically fills in the Purchase Description field from the Sales 
Description field.

3 In the Sales Date field, type 12/15/2007.

4 In the Sales Price field, type 28000.

This Edit Item screen should look like the following:

5 Press OK to save the changes and return back to the Fixed Asset Item List screen.
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To record the sale of a fixed asset:
Now that the fixed asset sales information has been updated, it’s time to generate 
the sales receipt.

1 From the Fixed Asset Item List, press the Activities button, then select Enter Sales 
Receipts.

This displays an empty Sales Receipts screen (note that the next lesson will go into 
more detail about creating sales receipts and invoices):

2 In the Customer:Job field, click the drop-down list arrow.

QuickBooks shows you a list of Rock Castle Construction’s existing customers and 
jobs.

3 Choose Smith, Lee for the customer and job. Because this name has already been 
entered on the Customer:Job list, QuickBooks knows the billing name, the 
address, and the payment terms and updates the sales receipt form.

4 Click in the Item field.

5 Click the down arrow to display the list of items. Select Trailer, then press Tab.
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QuickBooks automatically fills in the Amount field with the selling price of the 
Trailer fixed asset item. The Sales Receipt screen should look as follows:

6 Record the sale by clicking Save and Close. You are returned to the Fixed Asset 
Item List.

To flag a fixed asset item as inactive:
Now that the fixed asset has been sold, it should be marked as inactive.

1 From the Fixed Asset Item List, select the Trailer fixed asset, click the Item button, 
then select Edit to display the Edit Item screen.

2 Select the Item is inactive checkbox to the right of the Sales Information section.

3 Press OK to return to Fixed Asset Item List.

Note that the Trailer fixed asset is no longer displayed in the list.

4 To see the inactive Fixed Asset Items, click the Show All checkbox.

QuickBooks re-displays the Fixed Asset Item List and includes the inactive items:

5 Close the Fixed Asset Item list.
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Understanding equity accounts

Equity is the difference between what you have (your assets) and what you owe (your 
liabilities). If you sold all your assets today and paid off your liabilities using the 
money received from the sale of your assets, the money you’d have left would be your 
equity.

A balance sheet shows your company assets, liabilities, and equity on a particular date. 
Because equity is the difference between total assets and total liabilities, it’s also true 
that total assets equal the sum of total liabilities and equity.

As you enter the opening balances of your assets and liabilities, QuickBooks calculates 
the amount of equity and records it in an equity account called Opening Bal Equity 
(Bal stands for Balance).

In addition to the Opening Bal Equity account, QuickBooks sets up another type of 
equity account for you called Retained Earnings. This account tracks your company's 
net income from previous fiscal years. QuickBooks automatically transfers your profit 
(or loss) to Retained Earnings at the end of each fiscal year.

If your company is a sole proprietorship (an unincorporated company with only one 
owner), you don’t have to add any more equity accounts to your chart of accounts. All 
the equity belongs to the company’s sole owner.

You can get as involved in tracking equity as you want. Some people like to track 
owner investments, owner’s draws, and retained earnings prior to their QuickBooks 
start date by putting them in separate equity accounts. If your business is a 
partnership, you’ll probably want to set up separate equity accounts for each partner.

To learn more about equity and to learn how to set up equity accounts for your 
business, search the onscreen Help index for equity.
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Student test and review

Assume that the owner of Rock Castle Construction has taken out a loan and 
purchased a computer system for $15,000. He wants to track the accumulated 
depreciation and cost of the system in two separate fixed asset accounts.

1 Create a fixed asset account called Computer System and two subaccounts—one 
for Cost and one for Accumulated Depreciation.

2 Create a long-term liability account to track the loan.

Enter the amount of the loan as an increase in the asset’s Cost account. Assign the 
transaction to the loan liability account.
112



• • • • • • • • • •

LESSON 6 Entering sales and 
invoices
2

Lesson objectives, 114

Handout materials, 114

To start this lesson, 114

Using sales forms in QuickBooks, 115
When to use different types of sales forms, 115

For payment in the future, 115
For payment at the time of sale, 116

Choosing a format for sales forms, 117

Filling in a sales form, 117
Filling in the customer information, 117

Filling in the line item area, 118

Completing the sales form, 119

Memorizing a sale, 121

Entering a new service item, 122

Using multiple price levels, 124
Creating new price levels, 124

Associating price levels with customers, 126

Using price levels on sales forms, 127

Assigning price levels to individual line items, 128

Using statements to bill customers, 129
Understanding statement limitations, 129

Generating customer statements, 130

Student test and review, 133
113



E n t e r i n g  s a l e s  a n d  i n v o i c e s
Lesson objectives
■ To learn about the different formats available for sales forms

■ To practice creating a new invoice

■ To learn the purpose and use of the QuickBooks Item list

■ To see how QuickBooks records the information you enter on sales forms

■ To memorize an invoice transaction for reuse

■ To add a new item to the Item list

■ To add a new price level to the Price Level list

■ To associate a price level with a customer

■ To generate customer statements

■ To create sales orders

Handout materials
■ Handout 17:  Create Invoices window

■ Handout 18:  Enter Sales Receipts window

■ Handout 19:  Choosing a format for sales formss

■ Handout 20:  Types of QuickBooks items

To start this lesson

Before you perform the following steps, make sure you have installed the exercise file 
(qbcanlesson.qbb) on your hard disk. 

The steps that follow will restore the exercise file to its original state so that the data 
in the file matches what you see on the screen as you proceed through each lesson.

To restore the exercise file (qbcanlesson.qbb):
1 From the File menu in QuickBooks, choose Restore.

QuickBooks displays the Restore Company Backup window.

2 In the “Get Company Backup From” section of the window, click Browse and 
select your c:\QBtrain directory.

3 Select the qbcanlesson.qbb file, then click Open.

4 In the “Restore Company Backup To” section of the window, click Browse and 
select your c:\QBtrain directory.

5 In the File name field of the Restore To window, type lesson 6, then click Save.

6 Click Restore.
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Using sales forms in QuickBooks

Any time you make a sale in your business, you record it in QuickBooks on a sales 
form. A sales form can be an invoice (when you expect payment to come later), a sales 
receipt (when you expect payment at the time you make the sale), or a credit memo.

When to use different types of sales forms

The type of sales form you use depends on whether you expect payment in the future 
or at the time of the sale.

For payment in the future

If you expect to receive payment at some future date, you enter an invoice. The 
invoice lists the customer’s name and address, along with an itemized list of how 
much that customer owes.

To display a completed invoice form in QuickBooks:
1 From the Customers menu, choose Create Invoices.

QuickBooks displays the Create Invoices window.

2 Click Previous to display the previously created invoice.
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If you own a business that sells products, like Rock Castle Construction, your 
invoice lists the products purchased by the customer, the amount charged for each 
item, and any sales tax you need to apply. Notice that Rock Castle Construction’s 
invoice charges for both products and services (such as labour).

A business that sells mainly services, such as a consulting firm, might use a 
different type of sales form than the one shown previously. QuickBooks lets you 
choose from three different preset formats for your sales forms, or you can create 
your own customized forms.

3 Close the Create Invoices window.

For payment at the time of sale

If you receive payment at the time you make a sale—either by cash, cheque, or credit 
card—you fill out a sales receipt instead of an invoice. Like the invoice, the 
QuickBooks sales receipt includes information about the items or services purchased, 
but it also includes information about how payment was made.

To display a completed sales receipt in QuickBooks:
1 From the Customers menu, choose Enter Sales Receipts.

QuickBooks displays the Enter Sales Receipts window.

2 Click the Previous button to view the previously entered sale.

The sales receipt is similar to the invoice—both forms display customer infor-
mation and describe the items and services purchased. However, because payment 
is made at the time of sale, the sales receipt has deposit information at the bottom 
of the window.

3 Close the Enter Sales Receipts window.
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Choosing a format for sales forms

QuickBooks has four different formats for invoices: Service, Professional, Product, and 
Custom.

■ Use the Service format if you primarily sell services but occasionally sell goods.

■ Use the Professional format if you sell services and need a lot of room for  
descriptions of your services.

■ Use the Product format if you sell parts or products and need fields relevant to 
shipping.

■ Use the Custom format if you want to tailor a form to your type of business.

Each format has an onscreen version and a printed version. This lets you record all the 
sales detail you need, but print only what you want customers to see. For example, if 
you use the Professional format, the onscreen version shows the number of hours 
you’re billing the client as well as your hourly rate; the printed version shows only the 
Description and the Amount fields. You’ll learn how to customize forms in Lesson 15, 
“Customizing forms and writing QuickBooks Letters.”

Filling in a sales form

Suppose Rock Castle Construction wants to bill a customer for a portion of a kitchen 
remodeling job. Because they expect payment to be made in the future (rather than 
cash on the spot), they need to create an invoice.

Filling in the customer information

Filling in an invoice is just like filling in a paper form; you enter the customer 
information first, followed by a description of the charges.

To enter customer information on an invoice:
1 From the Customers menu, choose Create Invoices.

Notice that the new invoice already has the current date (12/15/2007 in the 
sample file) entered in the Date field, and the next invoice number assigned in the 
Invoice # field.

2 In the Customer:Job field, click the drop-down list arrow.

QuickBooks shows you a list of Rock Castle Construction’s existing customers and 
jobs.
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3 Choose Jacobsen, Doug:Kitchen for the customer and job. If QuickBooks reminds 
you that you have recorded billable time or costs for this customer, click OK.

Because this name has already been entered on the Customer:Job list, QuickBooks 
knows the billing name, the address, and the payment terms. It provides this 
information for you on the top half of the form.

Filling in the line item area

On the bottom half of the invoice, you list each service or product you’re selling on 
its own line, along with the amount the customer owes for that item. Because 
information about individual items is on separate lines, the lines are called line items.

In QuickBooks, you enter line items using the Item list, so you don’t have to type and 
retype lines for services or products you sell frequently. For example, an architect 
would have one item for design and another for construction supervision.

But items are not just products you sell or services you provide to clients. Line items 
can be anything you might want to put in the detail area of an invoice, like a discount, 
a subtotal line, a markup, or a sales tax calculation.

Rock Castle Construction has already entered the items for which it bills customers on 
its Item list.

To complete the line item area of an invoice:
1 In the Item field, type the letters rem (for Removal).

QuickFill is an alternative to choosing from a list. Whenever you’re in a field 
where you’ll use a list item, you can start typing the first letter or two of the list 
item you want, and QuickBooks fills in the field with the item that matches the 
letters you’re typing.

2 Press TAB.

When you press Tab to accept a QuickFill entry, QuickBooks fills in other 
information about the item, like its description and rate. In this case, QuickBooks 
displays “Removal labour” in the Description column and a rate of $35 per hour. 
All you have to do is enter the number of hours.
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3 Type 40 in the Quantity column.

4 Press Tab to have QuickBooks update the invoice total.

Completing the sales form

If you want to check the form before you print it, you can use the print preview feature 
in the Create Invoices window.

To complete and record the invoice:
1 On the Create Invoices window toolbar, click the Print drop-down arrow, then 

choose Preview. 

If QuickBooks reminds you that you can print shipping labels, click OK. 

2 Click No when QuickBooks reminds you to save your invoice. 

QuickBooks displays the invoice page as it will look when printed.
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3 Click Zoom In and use the scroll bars to see the invoice items at greater magnifi-
cation.

4 Click Close.

5 In the Create Invoices window, record the sale by clicking Save & Close.

QuickBooks records the invoice in your accounts receivable register. If this were a sales 
receipt, QuickBooks would record the sale in your Undeposited Funds account until 
you deposit the money at the bank, or record a deposit in the bank account you 
specified in the Enter Sales Receipts window.

The accounts receivable register keeps track of how much money your customers owe 
you.

To see the Accounts Receivable register:
1 From the Company menu, choose Chart of Accounts.

QuickBooks displays the chart of accounts.

2 In the chart of accounts, double-click the Accounts Receivable account.

QuickBooks displays the accounts receivable register.

3 Select the sale we just recorded in the register (for Doug Jacobsen).

4 Double-click the entry.

When you double-click an entry in a register, QuickBooks displays the original 
form (in this case, the invoice).

5 Keep the invoice window open, you’ll use it in the next exercise.
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Memorizing a sale

Many of the sales you make in your business are ones you repeat again and again. For 
example, you may have a standing monthly order from a customer, or you may 
perform essentially the same services for more than one client. QuickBooks lets you 
memorize sales forms so that you don’t have to retype the information.

To memorize the invoice:
1 Make sure you have the invoice you want to memorize displayed on your screen.

2 From the Edit menu, choose Memorize Invoice.

Note that if the transaction is already in the memorized transaction list, Quick-
Books displays a message asking you if you would like to replace it or add a new 
one. Select Add.

QuickBooks displays the Memorize Transaction window.

3 In the name field, type a description that helps you recognize the memorized 
invoice.

Enter “Kitchen - Removal Labour”. Notice that you can also have QuickBooks 
remind you when to use the memorized transaction (for an invoice you always 
send at the end of the month, for example).

4 Click OK.

5 From the Window menu, choose Close All.

When you memorize an invoice, QuickBooks adds it to the Memorized Transaction 
list.

To recall a memorized sale:
1 From the Lists menu, choose Memorized Transaction List.

QuickBooks displays the Memorized Transaction List window.
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2 Double-click the transaction you just added.

QuickBooks displays the Create Invoices window, with the information you 
memorized displayed on the form. It gives you a new invoice number and displays 
the current date. You can modify the information as you want, or just save the 
invoice as is.

3 Click Save & Close to record the invoice.

4 Close the Memorized Transaction list.

Entering a new service item

When you begin using your own QuickBooks company file, you’ll need to create your 
own line items to include on your invoices. In the next exercise, you’ll see how to add 
information to the Item list.

Rock Castle Construction already has a service item called Repairs that it uses when it 
wants to charge for general repair work. Suppose Rock Castle wants to add a subitem 
for plumbing repairs to the Item list. (The company charges a higher rate for plumbing 
repairs, so it wants a separate item for it on its Item list.)

To create a new service item:
1 From the Customers menu, choose Item List.

QuickBooks displays the Item list for Rock Castle Construction.

2 Click the Item menu button, then choose New.

QuickBooks displays the New Item window.

If you’re using a QuickBooks Premier product, you’ll also see Assembly Item listed 
as an item type.
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3 In the Type field, select Service from the drop-down list.

4 In the Item Name/Number field, type Plumbing.

5 Click the “Subitem of” checkbox to select it.

6 In the drop-down list below the “Subitem of” field, select Repairs.

7 In the Description field, type Plumbing repairs and maintenance and press TAB.

8 In the Rate field, type 55.

9 In the Sales Tax Code drop-down list, leave the selection at <S> (Standard, 
meaning that you charge both GST and PST on this service).

Now you need to assign this line item to one of Rock Castle Construction’s income 
accounts.

10 In the Account field, select Construction:Labour from the drop-down list.

Your screen should look like the following figure.

11 Click OK to add the new item to Rock Castle Construction’s Item list.
123



E n t e r i n g  s a l e s  a n d  i n v o i c e s
12 Close the Item list.

Now that the new item is on the Item list, Rock Castle Construction can invoice for 
plumbing repairs separate from its general repair work. It can also create sales reports 
that show sales for general repairs separate from sales for plumbing repairs.

Using multiple price levels

In the last exercise, you set up a new service item for Rock Castle construction and 
assigned a price to that item. Sometimes businesses want to vary an item’s price based 
on who they are selling to. For example, Rock Castle Construction charges different 
prices depending on whether it is selling to a residential or a commercial customer.

You can associate price levels with specific customers so that each time you create an 
invoice (or other sales form) for that customer, QuickBooks uses the appropriate price 
level when calculating rates and amounts on the form. Price levels make it easy to use 
different rates on sales forms without having to calculate percentage amounts 
manually. Price levels affect amounts for service, inventory, and non-inventory part 
items only.

In this section, you’ll create a new price level, associate it with one of Rock Castle’s 
customers, then create an invoice for that customer.

Note: The ability to create multiple price levels is not available in QuickBooks 
Basic. You must be using QuickBooks Pro or Premier to complete the rest 
of this lesson.

Creating new price levels

Rock Castle Construction charges its residential customers the base sales price it set up 
on its Item list. The company charges its commercial customers 10 percent less than 
the base sales price. In this exercise, you’ll create a new price level for Rock Castle 
Construction to use to reduce the sales amount for its commercial customers. 
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For each price level you create, you assign a name and percentage increase or decrease 
to the item’s base sales price. You can create up to 20 price levels to use on invoices, 
sales receipts, and credit memos. 

To create a new price level:
1 From the Lists menu, choose Price Level List.

2 From the Price Level menu button, choose New.

This displays the New Price Level screen:

3 In the Price Level Name field type Commercial.

4 QuickBooks Pro only allows the Price Level Type field to be fixed percentage.

5 From the Price Level drop-down list, make sure “decrease” is selected.

6 In the Item Priced By field type 10 (e.g. 10% decrease).

Always enter the percentage as a positive number.

7 Click OK.

Your screen should now resemble the following.

8 Close the Price Level list.
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Associating price levels with customers

When you assign price levels to customers, QuickBooks calculates rates and amounts 
on sales forms based on the price level associated with that customer.

To associate a price level with a customer:
1 From the Customers menu, choose Customer:Job List.

2 From the Customer:Job list, choose Lew Plumbing - C.

3 From the Customer:Job menu button, choose Edit, then click the Additional Info 
tab.

4 From the Price Level drop-down list, choose Commercial.

Your screen should look like this.

5 Click OK to close the Edit Customer window and save your changes.

6 Close the Customer:Job list.
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Using price levels on sales forms

In this section, you’ll create an invoice for the customer with whom you just 
associated the Commercial price level to see how the price level affects amounts on 
the form.

To use a price level associated with a customer:
1 From the Customers menu, choose Create Invoices.

2 From the Customer:Job drop-down list, choose Lew Plumbing - C.

Notice that QuickBooks displays the name of the price level associated with this 
Customer:Job in parentheses above the Customer:Job drop-down list. (This infor-
mation will not be printed on the form.)

3 Click in the Item column and choose Framing from the drop-down list. 

4 In the Quantity field, type 8.

5 Click below Framing in the Item field and choose Wood Door:Exterior from the 
drop-down list.

6 In the Quantity field, type 2, then press Tab.

Your screen should look like this.
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7 Keep the invoice open and choose Item List from the Lists menu.

8 In the Item list, go to Framing. Note that the price for framing is $55.00, but the 
rate on the invoice is $49.50—10 percent less than the base sales price.  
QuickBooks has automatically reduced the rate on the invoice by 10 percent.

Note: You can set up QuickBooks to round rates up to the next whole dollar. 
From the Edit menu, choose Preferences. Choose Sales & Customers from 
the scroll list, then click the Company Preferences tab. Click the “Round all 
sales prices up to the next whole dollar” checkbox and click OK.

9 Scroll to the Wood Door:Exterior item and note that the base sales price is $120 —
10 percent greater than the rate listed on the invoice using the Commercial price 
level.

10 Close the Item list.

11 Record the invoice by clicking Save & Close.

Assigning price levels to individual line items

In addition to associating price levels with customers, you can also use price levels on 
an individual basis on sales forms. The following are some examples of when you 
might want to do this.

■ You’ve associated a price level with a customer, but want to charge the base sales 
price for an item on a sale to that customer.

■ You want to use a price level for one or more items, but you don’t want to assign 
a price level to the customer for whom you’re recording the sale.

To apply a price to a single line item: 
■ Click in the Rate column and select the price level you want to use from the  

drop-down list that displays.

When you move out of that field on the form, QuickBooks recalculates the 
amount and balance due.
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Using statements to bill customers

Another option for billing customers is to send statements. Statements are ideal if you 
want to accumulate charges before requesting payment, or if you assess a regular 
monthly charge. Billing statements list the charges a customer has accumulated over a 
period of time.

You enter statement charges one by one, as you perform services for the customer. 
Later, you print a billing statement that shows the previous balance, details of all new 
charges, payments received, and the new balance. Billing statements are appropriate 
if you want to send monthly statements that show the detail of new charges as well as 
the previous balance and payments received.

If you bill the same charge to a group of customers on a regular basis, you can set up 
QuickBooks to enter the charges automatically when it's time to send out your 
statements. Any business that bills a recurring charge on statements can use this 
feature. For more information, search the onscreen Help index for memorized 
transactions, for statement charges.

Reminder statements summarize a customer's account with your company by listing 
recent invoices, credit memos, and payments received. You use reminder statements 
when you bill through invoices but want to remind your customers about delinquent 
payments.

Reminder statements are different than other “forms” in QuickBooks such as invoices, 
sales receipts, or cheques. Because QuickBooks already has all the information you 
need to create reminder statements, you don't have to fill them out. Instead, you 
review the information that will appear on each statement, decide whether to add 
finance charges, and print them.

Understanding statement limitations

In QuickBooks, statements have the following limitations:

■ You can't record sales tax, percentage discounts, payment items, or group items as 
a separate charge on a billing statement. To bill for any of these, you must use an 
invoice.

■ You cannot group related charges together and subtotal them (you can group and 
subtotal charges on an invoice).

■ A charge on a billing statement can represent only one item (in contrast, an 
invoice can represent many items). This means you must enter a separate 
statement charge for each service or product you sell.

■ You cannot add custom fields (for lists or items) to the statement form.
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Customer statements are available in all QuickBooks editions, however,  
QuickBooks Pro and Premier editions have additional functionality. For example, in 
QuickBooks Pro and Premier editions, you can include invoice detail on statements 
and include all open transactions as of a certain date.

Note: To complete the following exercises, you must be using QuickBooks Pro 
or Premier.

Generating customer statements

Rock Castle uses invoices to bill its customers, but it sends reminder statements to 
customers with overdue invoices. In this exercise, you generate statements to send to 
customers with outstanding balances.

Rock Castle wants to send reminder statements to all customers who have balances 
more than 30 days past due.

To generate reminder statements:
1 From the Customers menu, choose Create Statements.

QuickBooks displays the Create Statements window.

2 In the Enter Statement Date and Type section of the window, select the “All open 
transactions as of Statement Date” option.

3 Click to select the “Include only transactions over” checkbox.

4 Leave the number of days past due field entry at 30.

5 In the Select Customers section, leave “All Customers” selected. 
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6 In the Select Additional Options section, click to select the “Show invoice item 
details on statements” checkbox, and click to deselect the “Print due date on trans-
actions” checkbox.

Your screen should look like the following graphic.

7 Click Assess Finance Charges.

QuickBooks displays the Assess Finance Charges window.

8 If QuickBooks reminds you that the customer has unapplied payments, click OK 
to continue.

9 Click Unmark All.

10 In the Assess column, click to put a checkmark in the row for the 155 Wilks job 
for Pretell Real Estate (finance charges were assessed against Pretell Real Estate on 
12/15/07).

Your screen should look like the following graphic.
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11 Click Assess Charges.

12 Answer Yes if QuickBooks displays the message telling you that finance charges 
have already been assessed today.

QuickBooks creates a finance charge invoice for Pretell Real Estate in the amount 
of $48.98. This amount does not display on the current statement, but you can 
send the finance charge invoice with the reminder statement.

13 Click Preview.

QuickBooks displays reminder statements for the fifteen customers whose 
balances are 30 days or more past due—including the details from the original 
invoices.

14 Click Close.

At this point you could generate and send the reminder statements to your 
customers.

15 Close the Create Statements window.
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Student test and review
1 From which list (or lists) does QuickBooks get the information for A, B, and C in 

the graphic below?

2 List the item types used in the line item area of the invoice above.

3 Create an invoice for Rock Castle Construction that uses the new 
Repairs:Plumbing line item. Create the invoice for a new customer by adding 
information to the Customer list “on the fly.”

4 Filling out a sales receipt is similar to filling out an invoice form. Create a sales 
receipt for a customer of Rock Castle Construction. After you create the sales 
receipt, open the Undeposited Funds account register to see the transaction 
QuickBooks created automatically.
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Lesson objectives
■ To learn how to record customer payments in QuickBooks

■ To learn how to handle customer discounts, partial payments, overpayments, or 
down payments

■ To see how to record a deposit in QuickBooks, and learn how QuickBooks treats 
the deposit behind the scenes

■ To learn how to enter cash back from a deposit in QuickBooks

Handout materials
■ Handout 21:  Receive Payments window

■ Handout 22:  Make Deposits window

To start this lesson

Before you perform the following steps, make sure you have installed the exercise file 
(qbcanlesson.qbb) on your hard disk. 

The steps that follow will restore the exercise file to its original state so that the data 
in the file matches what you see on the screen as you proceed through each lesson.

To restore the exercise file (qbcanlesson.qbb):
1 From the File menu in QuickBooks, choose Restore.

QuickBooks displays the Restore Company Backup window.

2 In the “Get Company Backup From” section of the window, click Browse and 
select your c:\QBtrain directory.

3 Select the qbcanlesson.qbb file, then click Open.

4 In the “Restore Company Backup To” section of the window, click Browse and 
select your c:\QBtrain directory.

5 In the File name field of the Restore To window, type lesson 7, then click Save.

6 Click Restore.
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Recording customer payments

If you’re receiving payment at the time of a sale, and you fill out a sales receipt, 
QuickBooks records a customer payment. When you invoice a customer, and you 
receive payment later, you enter the payment in the QuickBooks Receive Payments 
window.

The Receive Payments window lets you match up payments you receive with invoices 
you’ve written. You’ll be working with the Receive Payments window in this lesson.

Recording a payment in full for a single job

The simplest case is when a customer has one outstanding invoice for one job and 
sends you a payment for the full amount. Suppose that Rock Castle Construction 
receives a cheque for $475.57 from Mike Violette for his workshop. Here’s how you’d 
enter the payment.

To record a payment in full:
1 From the Customers menu, choose Receive Payments.

QuickBooks displays the Receive Payments window.

The first step is to enter the name of the customer from whom you’ve received a 
payment.

2 In the Received From field, select Violette, Mike:Workshop from the drop-down 
list.

QuickBooks displays the outstanding invoice for Mike Violette in the Applied To 
section of the window.

3 Press TAB twice to move to the Amount field.
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4 In the Amount field, type 475.57 and press TAB.

QuickBooks changes the Total Payment to 475.57, and applies the payment to the 
one outstanding invoice.

5 In the Ref./Cheque No. field, type 6745, then press TAB.

6 In the Pmt. Method field, select Cheque from the drop-down list.

7 Click “Group with other undeposited funds” if it is not selected already.

8 Click Save & New.

This records the payment and clears the window so you can enter another one.

Entering a partial payment

Rock Castle Construction has also received a cheque for $1,000 from Ecker Designs. 
Ecker Designs has two outstanding invoices and owes more than $6,000.

To enter a partial payment:
1 In the Received From field, select Ecker Designs:Office Repairs from the drop-down 

list.

In the middle of the window, QuickBooks shows you the invoices still outstanding 
for the job. In this case, there are two. Next, you need to enter the amount of the 
payment in the Amount field.

2 Press TAB twice to move to the Amount field, then type 1000. Then press TAB again.
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QuickBooks automatically applies the payment you’ve entered to Ecker Design’s 
oldest invoice.

However, we want to apply this payment to a different invoice, not the oldest.

3 Click Clear Selections.

4 In the Payment column, type 1000 as the amount you want to apply to the second 
invoice, then press TAB.

5 In the Pmt. Method field, select Cheque from the drop-down list.

6 Make sure that “Group with other undeposited funds” is selected.

7 Click Save & New to record the partial payment and clear the window.
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Applying one payment to multiple jobs

Rock Castle Construction is working on several jobs for a customer, Brian Cook. Brian 
has payments outstanding for four invoices. He wants to write one cheque to cover all 
outstanding payments.

In this exercise, you’ll apply this single payment to invoices for multiple jobs.

To apply one payment to multiple jobs:
1 In the Receive Payments window, select Cook, Brian from the Received From drop-

down list.

QuickBooks lists the open invoices for all of the jobs associated with Brian Cook.

Mr. Cook is paying us for all jobs except the last one, the Kitchen job.

2 Press TAB twice to move to the Amount field.

3 In the Amount field, type 8,626.23, then press TAB. 

Notice that QuickBooks applies the payment to the oldest outstanding invoices 
first.

4 In the Ref./Cheque No. field, type 575, then press TAB.

5 In the Pmt. Method drop-down list, select Cheque.
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Your window should look like this.

At the bottom of the Payment column, you can see that this customer also has a 
$4,500 credit available. This credit was issued for the first job in the job list (the 
2nd story addition) and we will apply it now.

6 Click the first job (the 2nd story addition) once to select it.

7 Click Set Credits.
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8 Confirm that the $4,500 credit is selected, then click Done.

The credit will now be applied to this job. Note that the Unused Credits line now 
reads 0.00 and the Unused Payment line reads 4,500.00. Now we will apply the 
remaining $4,500 of the customer’s payment to the remaining jobs.

9 In the Payment column for the first job, change 691.40 to 5191.40 and press TAB.

Notice that the Unused Payment and Unused Credit areas now both show 0.00. 
All of Mr. Cook’s outstanding invoices except the last are paid in full.

10 Make sure that “Group with other undeposited funds” is selected.

11 Click Save & New.

Entering overpayments

If a customer sends you an overpayment, you simply enter the amount in the Receive 
Payments window, and QuickBooks keeps track of the additional payment. When the 
customer has future invoices, you can apply the overpayment to those amounts.

Suppose that Rock Castle Construction has received a payment of $14,300.00 from 
Pretell Real Estate for the 75 Sunset Rd. job. The outstanding invoice for that job is 
$14,274.00.

To enter the payment:
1 In the Received From field of the Receive Payments window, select  

Pretell Real Estate:75 Sunset Rd. from the drop-down list.

QuickBooks displays an invoice dated 12/15/2007 for $14,274.00.

2 Press TAB twice and type 14300 in the Amount field. 

3 Press TAB again.
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QuickBooks shows an Unused Payment amount of $26.00. QuickBooks keeps 
track of the overpayment amount for you, and you can apply it to any future 
invoices for the customer. The next time you invoice Pretell Real Estate and receive 
a payment, the Receive Payments window will show $26.00 in unused credits. 

4 Select Cheque from the drop-down list in the Pmt. Method field.

5 Make sure “Group with other undeposited funds” is selected.

6 Click Save & New.

7 When QuickBooks displays a message telling you that the customer will have a 
credit if you proceed, click OK.

Handling down payments or prepayments

If a customer makes a payment before you’ve invoiced him for services (for example, 
he may be making a down payment or paying a retainer fee), you can still record the 
payment at the Receive Payments window. However, because you don’t have any 
invoices to which to apply the payment, QuickBooks records the payment as an 
unused payment (just like an overpayment).

QuickBooks holds the unapplied amount with the customer’s name. The next time 
you enter that customer in the Receive Payments window, QuickBooks displays the 
credit amount in the Unused Credits area. The customer’s balance also reflects the 
credit amount.

Suppose Sonya Bristol wants Rock Castle Construction to build a utility shed for her. 
She’s sent Rock Castle Construction a cheque for $1,000 as an initial payment, but the 
company hasn’t invoiced her yet.

To enter the down payment you’ve received:
1 In the Received From field, select Bristol, Sonya:Utility Shed from the  

drop-down list.

2 In the Pmt. Method field, select Cheque from the drop-down list.

3 Highlight the numbers in the Amount field and type 1000. Then press TAB.

QuickBooks displays the payment as an Unused Payment.

4 Click “Group with other undeposited funds” if it is not selected already.

5 Click Save & Close.

6 When QuickBooks displays a message telling you that the customer will have a 
credit if you proceed, click OK.
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Later, Rock Castle Construction is ready to prepare its invoices and needs to invoice 
Sonya for the labour the workers have already completed on the job.

To create an invoice for a customer who made a down payment:
1 From the Customers menu, choose Create Invoices.

QuickBooks displays the Create Invoices window.

2 In the Customer:Job field, select Bristol, Sonya:Utility Shed from the drop-down 
list.

3 If you have QuickBooks Pro or Premier, QuickBooks displays the Available  
Estimates window. You don’t want to create this invoice from the estimate listed, 
so click Cancel.

4 Click in the Item column, select Installation from the Item drop-down list, then 
press TAB.

5 In the Quantity column, type 40 and press TAB.

6 Click Save & Close to record the invoice and to close the Create Invoices window.

Now you can go to the Receive Payments window and see how QuickBooks applies the 
payment Sonya made earlier.
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To view a down payment:
1 From the Customers menu, choose Receive Payments.

2 In the Received From field, select Bristol, Sonya:Utility Shed from the drop-down 
list.

QuickBooks shows Unused Credits of $1,000.

3 Click in the Payment column, then Click Set Credits.

In the Discounts and Credits window, notice that QuickBooks has applied the full 
credit amount to the invoice, which is what you wanted. If there were other 
invoices to which you wanted to apply part of the credit amount, you would use 
this window to apply the credits to the appropriate invoices.

4 Click Done.

QuickBooks applies the existing credit to the new invoice. Select the Show 
discount and credit information option so you can see what has happened:

5 Click Save & Close to record the credit used.

The next time you receive a payment from Sonya, QuickBooks will show that she 
owes only $610.
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Making deposits

When you use the Enter Sales Receipt window (for a sales receipt where you receive 
payment on the spot), the Receive Payments window (for payments on invoices), or a 
payment item on an invoice, QuickBooks keeps track of the money you’ve received 
until you deposit it in the bank.

Selecting payments to deposit

At your office, you might hold payments in a locked cash drawer or a cash register 
until you can get to the bank; QuickBooks holds the amount in an asset account called 
Undeposited Funds. When you’re ready to take your payments to the bank, you can 
record the deposit in QuickBooks, print a deposit slip to bring with you, and enter cash 
back amounts.

To select payments to deposit:
1 From the Banking menu, choose Make Deposits.

QuickBooks displays the Payments to Deposit window, which lists the payments 
you have not yet deposited.

2 Ensure that the payment method type drop_down list is set to “All types”.

3 Click to select the payments you want to take to the bank.
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For this exercise, select the payments from Pretell Real Estate (6,248.73), Mike 
Violette (1,000.00), Pretell Real Estate (1,200.00), Anton Teshner (3,500.00), and 
Tuan Nguyen (2,200.00).

4 Click OK.

QuickBooks displays the Make Deposits window, which shows the payments you 
just selected.
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5 In the Deposit To field, make sure that Chequing is selected.

Note: If you have money to deposit that is not the result of a payment you 
received for a sale, you can enter it in the detail area of the window. For 
example, if you received a premium refund from your insurance vendor, 
you could enter it here.

QuickBooks updates the deposit total at the bottom of the window automatically. 
If you wanted to print a deposit slip to take to the bank, you would click Print. 
(The Printable Deposit Slips that you can order to work with QuickBooks work 
only with deposits of cash and cheques.)

6 Click Save & Close to record the deposit.

How QuickBooks handles the deposit

QuickBooks updates the Undeposited Funds account to show that you’ve made a 
deposit. It also adds the deposit to your chequing account register.

To view the Undeposited Funds account:
1 From the Lists menu, choose Chart of Accounts.

2 In the chart of accounts, double-click the Undeposited Funds account.

QuickBooks displays your deposits and reduces the balance in the account by the 
amount of the deposits.

3 Close the Undeposited Funds window.

Now you can look at the deposit transaction in the chequing account.
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4 In the chart of accounts, double-click the chequing account.

QuickBooks has entered the deposit as a transaction in the chequing account 
register and has updated the balance of your chequing account.

5 Close the chequing account register and the chart of accounts.

Getting cash back from a deposit

In the Make Deposits window, you can enter information about any cash you took out 
of the deposit when you are recording the deposit.

To record getting cash back from a deposit:
1 From the Banking menu, choose Make Deposits.

QuickBooks displays the Payments to Deposit window. Notice that the deposits 
you made in the last exercise are no longer listed.

2 In the Payments to Deposit window, select the payment from Doug Jacobsen.
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3 Click OK.

4 In the Make Deposits window, type Petty Cash in the “Cash back goes to” field and 
press TAB.

5 When QuickBooks displays a message telling you that Petty Cash is not on the 
account list, click Set up.

QuickBooks displays the New Account window with the name preset to  
Petty Cash.

6 Make sure Bank is selected in the Type drop-down list, then click OK to return to 
the Make Deposits window.
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7 If QuickBooks asks whether you want to use computer cheques with this account, 
click No to continue.

8 In the “Cash back amount” field, type 200 and press TAB.

QuickBooks displays the deposit subtotal amount ($2000.00) and the total less the 
cash back amount ($1800.00).

9 Click Save & Close.

QuickBooks records the Deposit Total amount in your chequing account and the 
cash back amount in your Petty Cash account. 

10 To see the effect on these accounts, choose Chart of Accounts from the Lists menu.

11 Close the chart of accounts.
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Student test and review
1 Create an invoice for Bryan Ruff’s utility shed job.

Add items to Rock Castle Construction’s Item list as needed.

2 After you invoice Bryan, record a payment from him in the Receive Payments 
window.

3 Record Rock Castle Construction’s deposit of the payment.
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Lesson objectives
■ To discuss the different ways you can handle bills in QuickBooks

■ To learn how to enter a bill in QuickBooks

■ To use the Pay Bills window to pay a bill in QuickBooks

■ To learn how to enter a discount on a bill from a vendor

Handout materials
■ Handout 23:  Handling expenses in QuickBooks

To start this lesson

Before you perform the following steps, make sure you have installed the exercise file 
(qbbcanlesson.qbb) on your hard disk.

The steps that follow will restore the exercise file to its original state so that the data 
in the file matches what you see on the screen as you proceed through each lesson.

To restore the exercise file (qbbcanlesson.qbb):
1 From the File menu in QuickBooks, choose Restore.

QuickBooks displays the Restore Company Backup window.

2 In the “Get Company Backup From” section of the window, click Browse and 
select your c:\QBtrain directory.

3 Select the qbbcanlesson.qbb file, then click Open.

4 In the “Restore Company Backup To” section of the window, click Browse and 
select your c:\QBtrain directory.

5 In the File name field of the Restore To window, type lesson 8, then click Save.

6 Click Restore.
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Handling bills in QuickBooks

When you have a business expense, you can handle it in one of the following ways: 

■ You can write a cheque manually and enter the information into a QuickBooks 
cheque register later. This doesn’t take advantage of features in QuickBooks, but 
sometimes it’s necessary. For example, if you purchase supplies at a retail store, 
they expect payment on the spot, and you may not know the amount in advance.

■ You can use QuickBooks to write and print a cheque. When you receive a bill for 
which you want to make immediate payment, you can write a QuickBooks cheque 
more quickly and accurately than you can by hand, and you receive an additional 
advantage: QuickBooks makes the entry in your chequing account register for you.

■ You can use the QuickBooks accounts payable feature to track the amounts you 
owe to vendors, track your cash flow needs, and handle bills you want to pay later.

■ You can pay by credit card and enter the credit card receipt into QuickBooks later.

Lesson 4, “Working with bank accounts,” shows you how to enter a handwritten 
cheque and a QuickBooks cheque. In Lesson 5, “Using other accounts in QuickBooks,” 
you learn about credit card accounts. This lesson shows you how to use QuickBooks 
for accounts payable.

Using QuickBooks for accounts payable

Some business owners, especially if they own smaller, home-based businesses, pay 
their bills when they receive them. Most business owners, however, find it more 
convenient to pay bills less often. (They also like keeping the cash in the company for 
as long as possible.) If you don’t plan on paying your bills right away, QuickBooks can 
help you keep track of what you owe and when you owe it.

The money you owe for unpaid bills is called accounts payable. QuickBooks uses the 
Accounts Payable account to track all the money you owe. Like any QuickBooks 
balance sheet account, the Accounts Payable account has a register where you can 
view all your bills at once.

To see the Accounts Payable register:
1 From the Lists menu, choose Chart of Accounts.

QuickBooks displays the chart of accounts.
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2 Double-click Accounts Payable in the list to open the register.

QuickBooks displays the Accounts Payable register.

The register keeps track of each bill you have entered, shows you the due date, and 
keeps a running balance of all the bills you owe. As a business owner, this helps 
you forecast your cash flow, and the QuickBooks reminder system helps you pay 
your bills on time.

3 Press ESC twice to close the open windows.

Using accounts payable to pay your bills involves two steps: entering the bill and 
paying the bill. You’ll practice both steps in this lesson.

Entering bills

When you receive a bill from a vendor, you should enter it into QuickBooks as soon 
as you can. This keeps your cash flow forecast reports up to date and doesn’t give you 
the chance to set aside a bill and forget about it.

Rock Castle Construction received a bill from the company that created its new 
brochures. The bill includes a charge for courier delivery. Rock Castle Construction 
doesn’t plan to pay the bill until close to its due date, but the company wants to keep 
an eye on the accounts payable total, so it enters the bill now.
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To enter a bill:
1 From the Vendors menu, choose Enter Bills.

QuickBooks displays the Enter Bills window.

The top half of the window is where you enter the bill. The bottom half is the 
detail area where you can assign the bill amount to different expense accounts, 
customers, or jobs.

Notice that the Bill Received checkbox has a checkmark. The only time the Bill 
Received checkbox should be cleared is if you’re using QuickBooks for inventory 
and you want to record items you’ve received that you haven’t actually been billed 
for yet.

2 In the Vendor field, type Willis Advertising, then press TAB.

3 In the Amount Due field, type 1500.

4 Click in the Bill Due field.

Notice that QuickBooks supplies a date for you in the Bill Due field. The date 
displayed is ten days from the date in the Date field. You can change the date if 
you want. If your Vendor list had payment terms entered for this vendor, Quick-
Books would have used those terms to calculate the bill’s due date.

5 Click in the Account column on the Expenses tab and type Printing.

QuickFill completes the entry for you, and displays Printing and Reproduction as 
the account. QuickBooks lets you assign transactions to more than one account, 
so you can keep close track of where your company spends its money. Rock Castle 
Construction wants to assign the majority of this bill to a printing and repro-
duction expense account, and the rest to a freight delivery expense account.
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6 Press TAB to accept Printing and Reproduction as the account.

7 In the Tax drop-down list, select Not Used and press TAB. (We are ignoring sales 
tax for this example.) Press TAB again.

8 Type 1450 to change the amount from 1,500 to 1,450.

9 Click in the Account column below Printing and Reproduction.

10 From the drop-down list, choose Freight & Delivery and press TAB.

11 In the Tax drop-down list, select Not Used and press TAB.

QuickBooks automatically assigns the remainder of the bill amount ($50.00) to 
Freight & Delivery.

Your screen should resemble the figure below.

12 Click Save & Close to record the bill.
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Paying bills

When you start QuickBooks or open a QuickBooks company file, a Reminders window 
appears that tells you if you have transactions to complete, such as bills to pay or 
money to deposit.

Tip: If you don’t see the Reminders window when you start QuickBooks, you 
can turn it on by choosing Preferences from the Edit menu. Click the 
Reminders icon in the left-hand menu, click the My Preferences tab, and select 
“Show Reminders List when opening a Company file.”

When QuickBooks tells you that you have bills due, you can display the Pay Bills 
window and select the bills you want to pay. 

To pay a bill:
1 From the Vendors menu, choose Pay Bills.

QuickBooks displays the Pay Bills window.

The Pay Bills window shows your unpaid bills as of any date you enter. You can 
pay by cheque, credit card, or with an online payment (if you are set up to make 
online payments).

For this exercise, you’ll pay a bill using a QuickBooks cheque (rather than a  
handwritten one).

2 In the Payment Method area, that the “To be printed” option is selected.

By selecting this option, you are telling QuickBooks that you will print this cheque 
later.
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3 Scroll down to the Willis Advertising bill and select it by clicking in the column to 
the left of the bill.

QuickBooks displays a checkmark next to the bill and changes the amount in the 
Ending Bank Balance to reflect a payment of $1,500.00. If you want to make a 
partial payment, you can enter the amount you want to pay in the Amt. To Pay 
column.

Your screen should resemble the figure below.

4 Click Pay & Close.

How QuickBooks records your bill payment

When you pay a bill through the Pay Bills window, QuickBooks makes an entry in the 
accounts payable register, showing a decrease of $1,500 in the total payables. It also 
creates a cheque from your chequing account to pay the bill.

To see the entry in the accounts payable register:
1 From the Company menu, choose Chart of Accounts.

QuickBooks displays the chart of accounts.

2 In the chart of accounts, double-click the Accounts Payable account.
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QuickBooks displays the accounts payable register.

The register now shows the bill payment to Willis Advertising.

3 Close the accounts payable register.

At the same time QuickBooks recorded the entry in your accounts payable register, it 
made an entry in your Chequing account.

To see the entry:
1 In the chart of accounts, double-click Chequing.

QuickBooks displays the chequing account register.
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Notice that the third to the last entry in the register is the cheque for the payment 
to Willis Advertising.

2 Select the Willis Advertising transaction.

QuickBooks highlights the Willis transaction with a thick border to show that it is 
selected.

3 On the toolbar, click Edit Transaction.

QuickBooks displays the Bill Payments (Cheque) window.

This cheque is called a “Bill Payment Cheque” and differs from the cheque form 
that you use to enter cheques directly into the chequing account. (That form 
shows expenses directly on the cheque voucher portion, while the bill payment 
form shows the bills paid by the cheque.)

4 Press Esc to close the Bill Payment Cheque window.

5 From the Window menu option, choose Close All to close all the open QuickBooks 
windows. If QuickBooks asks if you want to save the transaction, choose No.

Applying vendor discounts to bill payments

If you take advantage of discounts for early payment offered by some vendors, you can 
record the discounts directly in the Pay Bills window. You can set up QuickBooks to 
track the discount amounts.

In this section, you’ll apply a discount for early payment to one of Rock Castle 
Construction’s vendors.
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To apply a discount for early payment:
1 From the Vendors menu, choose Pay Bills.

QuickBooks displays the Pay Bills window.

2 In the “Due on or before” field, type 1/16/08 and press TAB.

QuickBooks displays all of Rock Castle Construction’s bills due on or before 
1/16/08.

3 From the Sort Bills By drop-down list, choose Discount Date, if necessary.

Your screen should look like this.

4 Click to put a checkmark next to the bill for Hamlin Metal with a due date of 
1/10/08.

QuickBooks displays the discount and credit information for Hamlin Metal.

5 Click Set Discount.
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6 QuickBooks displays the Discount and Credits window prefilled with information 
about Rock Castle’s terms with Hamlin Metal, and the amount of the discount 
based on those terms (in this case, two percent of $770.50, or $15.41).

7 From the Discount Account drop-down list, choose Construction:Discounts 
Received to track the discount amount.

8 Click Done.

The Pay Bills window is redisplayed with the Amount To Pay for Hamlin Metal 
reduced by the discount:
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9 Click Pay & Close.

Note: You can set up QuickBooks to always use discounts and credits from 
vendors. If you always track discounts from vendors in the same account, 
you can set up a default account. From the Edit menu, choose Preferences. 
Click Purchases & Vendors, then click the Company Preferences tab. Select 
the “Automatically use discounts and credits” checkbox and choose the 
account in which you want QuickBooks to track the discounts you receive 
from vendors.
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Student test and review
1 Write a cheque to a vendor, assigning the amount to more than one expense 

account.

2 Enter a bill in the Enter Bills window, then view the bill transaction in the 
accounts payable register.

3 Pay the bill using the Pay Bills window.
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Lesson objectives
■ To discuss some of the tools QuickBooks gives you for analyzing  

financial data: QuickReports, preset reports, and graphs

■ To create a QuickReport

■ To add a column to a report

■ To learn how to move a column in a report

■ To learn about the types of preset reports QuickBooks offers

■ To practice creating reports and viewing them onscreen

■ To customize a report by changing how it looks and the data it covers (filtering)

■ To learn how to process reports in batches

■ To learn how to export a report to Microsoft Excel

■ To practice filtering reports in Microsoft Excel

■ To learn about the types of graphs QuickBooks offers

■ To create and customize several graphs

Handout materials
■ Handout 24:  Creating a QuickReport from a list, register, or form

■ Handout 25:  Preset report types in QuickBooks

■ Handout 26:  Seeing more of an onscreen report

■ Handout 27:  QuickInsight graph types

To start this lesson
Before you perform the following steps, make sure you have installed the exercise file 
(qbcanlesson.qbb) on your hard disk. The steps that follow will restore the exercise file 
to its original state so that the data in the file matches what you see on the screen as 
you proceed through each lesson.

To restore the exercise file (qbcanlesson.qbb):
1 From the File menu in QuickBooks, choose Restore. QuickBooks displays the 

Restore Company Backup window.

2 In the “Get Company Backup From” section of the window, click Browse and 
select your c:\QBtrain directory.

3 Select the qbcanlesson.qbb file, then click Open.

4 In the “Restore Company Backup To” section of the window, click Browse and 
select your c:\QBtrain directory.

5 In the File name field of the Restore To window, type lesson 9, then click Save.

6 Click Restore.
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Reports and graphs help you understand your 
business

So far, you’ve been learning ways to track your data in QuickBooks. In this lesson, 
you’ll work with two of the most valuable tools in QuickBooks: reports and graphs. 
Reports and graphs give you insight into your finances; they’re two of the most 
important benefits of tracking your data in QuickBooks.

Often, people’s perceptions of their business profitability don’t match the facts. If you 
enter your data in QuickBooks, but don’t take the time to analyze the data, your 
business decisions are based on incomplete knowledge. Reports let you summarize 
your financial data so you make decisions based on analysis of the numbers.

Reports give you the bottom line—you can see exactly how profitable your business 
is. If it’s not doing as well as you’d hoped, you can create reports that show you which 
areas need improvement. QuickBooks has dozens of preset reports, but if you have 
specific reporting needs, you can customize any QuickBooks report to show exactly 
the data you want. And if you’re interested in getting quick information, you can use 
a QuickReport that lets you summarize information from your lists, forms, or registers 
with one click of a button.

Some people find it easier to see a visual picture of their financial data. If you’re 
interested in learning more about trends or patterns in your business data (for 
example, what proportion of your income comes from consulting services as 
compared to product sales), QuickBooks offers six types of QuickInsight graphs.

Creating QuickReports

One of the fastest ways to see a report on your QuickBooks data is to create a 
QuickReport. QuickReports are predesigned reports that give you information about 
the items you’re currently viewing onscreen. Whenever you have a list, a register, or a 
form displayed, you can click a button to have QuickBooks create a QuickReport.

When to use a QuickReport

Suppose you’re viewing the Vendor list, and you want to see a history of all 
transactions for a certain vendor. Select the vendor’s name, click the Report menu 
button, then select QuickReport. You’ll see a report listing information about each bill 
for that vendor.

Suppose that Rock Castle Construction wants to see what it owes to Patton Hardware.
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To see what you owe a vendor:
1 From the Lists menu, choose Vendor List.

QuickBooks displays the Vendor list.

2 Select Patton Hardware Supplies.

3 Click the Reports menu button, then select QuickReport:Patton Hardware 
Supplies.

A vendor QuickReport shows all transactions for this month to date for the 
selected vendor, Patton Hardware Supplies. The transactions shown can include 
purchase orders, item receipts, bills, bill payments, and credits received from the 
vendor.

Note:  If you want to see only unpaid bills and unapplied credits for the selected 
vendor, select Open Balance from the Reports menu button on the Vendor 
list.

Zooming in on a QuickReport

All QuickReports contain a summary of individual transactions. To help you better 
understand the information presented in reports, QuickBooks lets you trace report 
data to the individual transaction level using QuickZoom.

When you position the mouse pointer over a number in a report and you see the 
QuickZoom symbol (a magnifying glass with a Z in it), you can double-click the 
number to display the original transaction in QuickBooks.

Suppose you want more detail about the item receipt shown in the report. (You use an 
item receipt in QuickBooks when you want to record that you’ve received inventory 
items, but you haven’t yet received a bill.)
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To see more detail about an item:
1 Position the mouse pointer over the item receipt dated 12/05/07.

The arrow pointer turns into a magnifying glass with the letter Z (z for zoom).

2 Double-click the item receipt.

QuickBooks displays the Create Item Receipts window for the selected transaction.

3 Click Save & Close to close the window.

QuickBooks returns you to the QuickReport.

Customizing QuickReports

Each QuickReport window has a buttonbar at the top of the report for customizing 
report content and layout.

In this exercise, you’ll customize the QuickReport you just created to display 
transaction numbers in the report.
171



A n a l y z i n g  f i n a n c i a l  d a t a
To add a column to a report:
1 In the QuickReport window, click Modify Report.

QuickBooks displays the Modify Report window.

Use the Display tab of the Modify Report window to select the columns to include 
in the report and the date range of the report.

2 In the Columns list, select Trans #.

QuickBooks displays a checkmark next to Trans # to indicate that it’s selected.

3 Click OK to accept the changes.

QuickBooks displays the customized vendor QuickReport.

Notice that the item receipt from Patton Hardware Supplies is now listed as Trans-
action #179.

Next, you’ll move the Trans # column to a new position in the report.
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To move a report column:
1 Position your mouse pointer over the Trans # column that you added to the Quick-

Report.

The mouse pointer changes shape to look like a hand.

2 Hold down the left mouse button and drag the Trans # column to the right until 
you see an arrow between the Date Column and the Num column.

3 Release the mouse button.

QuickBooks places the Trans # column between the Date column and the Num 
column.

Next, you’ll use the QuickReport buttonbar to customize the report header.

To change information in the report heading:
1 In the QuickReport window, click Modify Report, then click the Header/Footer 

tab.

On the Header/Footer tab, you can change the company name, report title, 
subtitle, and date and time prepared. You can also specify whether to print the 
header on all pages or on just the first page. The Header/Footer tab is the same for 
all QuickBooks reports.

Use this window to change the report title from Vendor QuickReport to Vendor 
History Report.
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2 In the Report Title field, select the text for “Vendor QuickReport,” and type Vendor 
History Report to replace the title.

3 Click OK to close the Modify Report window.

QuickBooks changes the title of the report and displays the new report.

4 Close the QuickReport window and close the Vendor list.

Creating and customizing preset reports

In addition to QuickReports, QuickBooks has dozens of preset report formats. You can 
create profit and loss reports, balance sheet reports, accounts receivable reports, sales 
reports, accounts payable reports, inventory reports, and many other types of reports.

The Reports menu categorizes the preset reports into 12 major categories:

Company & Financial reports include the following:

■ Profit and loss reports give you a global view of your company’s income, expenses, 
and net profit or loss over a specific period of time.

■ Balance sheet reports show the financial position of your business by listing assets, 
liabilities, and equity.

■ Statement of cash flows reports show the net change in your cash during a period 
of time.

Customers & Receivables (accounts receivable) reports give you information about 
the receivables side of your business: which invoices are due (or overdue), how much 
each customer owes your company, and so on.

Sales reports give you information about what you have sold and to whom.

Jobs & Time reports (QuickBooks Pro only) give information about the status and 
profitability of the jobs/projects you track in QuickBooks.

Vendors & Payables (accounts payable) reports give you information about the 
payables side of your business, including which bills are due, your sales tax liability, 
and your current balance with each vendor.
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Purchases reports give you information about your purchases.

Inventory reports give you information about status (such as the quantities you have 
on hand or on order) and the value of your inventory.

Employees & Payroll reports summarize the information you need to pay your 
current payroll liabilities and fill out your tax forms. QuickBooks has these payroll 
reports: summary, employee earnings, liabilities, item detail, transaction detail, and 
transactions by payee.

Banking reports include cheque detail, deposit detail, and missing cheque reports.

Accountant & Taxes reports include income tax summary, income tax detail, general 
ledger, trial balance, journal, transaction journal, and audit trail reports.

Budget reports show how your income and expenses compare to the budgets you’ve 
set up.

List reports let you report on any information stored in a QuickBooks list.

Creating a balance sheet comparison report

The balance sheet comparison report compares the current year against the previous 
year in both dollar amount and percentage.

To create a balance sheet comparison report for Rock Castle 
Construction:
1 From the Reports menu, choose Company & Financial. Then choose Balance Sheet 

Prev Year Comparison.

The report on your screen should resemble the following figure.
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2 Scroll the report window to see more of the report.

Notice that the buttonbar at the top of the report is the same buttonbar you saw 
in the QuickReport window.

3 Keep the report displayed on your screen. You’ll use it in the next exercise.

Filtering reports

You can customize preset reports the same way you customize QuickReports. In this 
exercise you’ll customize the balance sheet comparison report and filter it to include 
only the transactions you specify.

Report filters let you set custom criteria for the transactions you want included in a 
report. When you filter a report, QuickBooks includes only those transactions that 
match the rules you create.

To filter a preset report:
1 With the balance sheet comparison report displayed, click Modify Report on the 

report buttonbar, then click the Filters tab.

QuickBooks displays the Filters tab of the Modify Report window.

Suppose you want to see only the asset accounts on the comparison balance sheet. 
You can filter the report by account.

2 In the Filter scroll box, make sure Account is selected.

Notice that QuickBooks provides a description of the selected filter below the list 
of filters. If you need more information about how applying a particular filter will 
affect the report, click Tell me more.

3 In the Account field, choose All assets from the drop-down list.

4 Click OK.

QuickBooks displays the customized balance sheet comparison report. If you scroll 
to the bottom of the report, you’ll see that QuickBooks removed the liability and 
other accounts from the report.
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5 Close the report window.

6 Click No if QuickBooks asks if you want to add this report to the Memorized 
Report list.

Creating and customizing a sales report

In this exercise, you’ll create a QuickBooks sales report, which you will then customize 
by changing the date range it covers.

To create a sales report:
1 From the Reports menu, choose Sales, then choose Sales By Customer Summary 

from the submenu.

QuickBooks displays the sales by customer summary report.

The Dates field in the report buttonbar shows that the report covers “This  
Month-to-date.” Customize the report so you can see all your sales.
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To customize dates in a report:
1 In the Dates field, select All from the drop-down list.

QuickBooks updates the report and displays the new data.

Using QuickZoom in a preset report

As with all QuickBooks reports, you can QuickZoom any item in the report to see more 
detail.

To QuickZoom on a report item:
1 Position the mouse pointer over the $11,105.00—the amount for Anton 

Teschner’s sun room.

The arrow pointer turns into a magnifying glass with a Z in it.

2 Double-click $11,105.00.

QuickBooks displays a QuickZoom report showing sales by customer detail.
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To QuickZoom further to display the original invoice for a 
transaction:
1 Position the mouse pointer over the first item on the report (invoice #40 dated 

10/05/2007 for Removal labour).

2 Double-click anywhere in the first line.

QuickBooks displays Invoice #40 for Anton Teschner’s sun room.

Notice that QuickBooks puts a paid stamp on invoices for which payment has 
been received in full.

3 From the Window menu, choose Close All.

4 Click No if QuickBooks asks if you want to memorize the report.

What you see when you QuickZoom in a report depends on the type of report 
displayed:

■ If the report shows summary figures (like the sales by customer summary report 
we just displayed) and you QuickZoom an amount, QuickBooks displays a  
transaction report that includes the transactions which contribute to that amount.

■ If the report shows transactions and you QuickZoom a transaction, QuickBooks 
displays the invoice, bill, or other form for the requested transaction.
179



A n a l y z i n g  f i n a n c i a l  d a t a
Saving report settings

After you have customized a report to provide the information you need, you can have 
QuickBooks memorize the settings so you can quickly produce the same report in the 
future. (QuickBooks memorizes a report’s settings, not the actual data.)

If you use one of the QuickBooks Premier products, you can export the settings for 
memorized reports as report templates. A report template lets you specify all of a 
report’s settings in advance—for example, report date, format, and filters. Report 
templates can be imported into other QuickBooks data files, then accessed from the 
Memorized Report list.

Creating memorized report groups

In addition to saving report settings, you can create memorized report groups that you 
can use to organize your memorized reports in a way that makes sense for your 
business and to allow you to quickly process a group of reports at once. 

QuickBooks comes preset with a number of memorized report groups each containing 
common reports for each area. You can add your own reports to these groups, modify 
the groups to meet your needs, and even create your own groups.

In this exercise, you’ll create a memorized group called “Year End” to which you will 
add some memorized reports. Later, you learn how you can batch process memorized 
reports.

To create a memorize report group:
1 Choose Memorized Reports from the Reports menu, then choose Memorized 

Report List.

QuickBooks opens the Memorized Report list.
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2 In the Memorized Report list, click the Memorized Report menu button, and 
choose New Group.

3 In the Name field of the New Memorized Report Group window, type Andrew’s 
Reports.

Your window should look like this.

4 Click OK.

QuickBooks adds the new group to the Memorized Report list.

Memorizing preset reports

Now, you’ll memorize a report and add it to the memorized report group you just 
created.

To memorize a report:
1 From the Reports menu, choose Accountant & Taxes, then choose 

Income Tax Summary.

2 On the report buttonbar, click Memorize.

QuickBooks displays the Memorize Report window.

3 Leave the name of the report as is.

4 Click the “Save in Memorized Report Group” checkbox to select it, and if necessary 
choose Andrew’s Reports from the drop-down list.

Your window should look like this.

5 Click OK to memorize the report and add it to the “Andrew’s Reports” memorized 
report group.

6 Close the income tax summary report.
181



A n a l y z i n g  f i n a n c i a l  d a t a
Adding reports to memorized report groups

Now, you’ll add a previously memorized report to the Andrew’s Reports group.

To add memorized reports to a memorized report group:
1 In the Memorized Report List window, select the report called  

“Inventory Valuation Detail-Andrew”.

2 Click the Memorized Report menu button, then choose Edit.

QuickBooks opens the Edit Memorized Report window.

3 Leave the report name as is.

4 Click the “Save in Memorized Report Group” checkbox to select it, and if necessary 
choose Andrew’s Reports from the drop-down list.

5 Click OK.

QuickBooks moves the “Inventory Valuation Detail-Andrew” report to the 
Andrew’s Reports memorized report group.

Once a report is memorized, you can easily display it from the QuickBooks Memorized 
Report list.

To display a memorized report:
1 In the Memorized Report list, select “Inventory Valuation Detail - Andrew.”

2 Click Display.

QuickBooks displays the report.

3 Leave the report open.
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Printing reports

Any time you have a report displayed in the report window, you can print it by 
clicking the Print button in the report buttonbar.

To print a report:
1 With the Inventory Valuation Detail - Andrew report displayed, click Print.

If QuickBooks prompts you to learn more about how to format reports, click OK.

QuickBooks displays the Print Reports window.

In the Print Reports window you can select the print orientation and tell  
QuickBooks where you would like the pages to break in multi-page reports.

2 Click Preview to see how the report will look when you print it.

QuickBooks displays a preview of your report onscreen.

3 Click Close to close the Print Preview window.

4 Close the Print Reports window (click Cancel), then close the report.

Processing reports in groups

Organizing your memorized reports in groups makes it fast and easy to process several 
reports at once. Now, you’ll process the reports you added to the Andrew’s Reports 
report group you created in the previous exercise.

To batch process reports:
1 In the Memorized Report list, select Andrew’s Reports.

2 Click Display.
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QuickBooks opens the Process Multiple Reports window. You can use this window 
to display or print the selected reports. You can also change the date range for 
reports in this window before you display or print them by clicking in the From or 
To columns.

3 Leave both reports selected and click Display. QuickBooks opens the two reports 
in the Andrew’s Reports group.

4 From the Window menu, choose Close All.

Exporting reports to Microsoft Excel

Occasionally, you may want to change a report’s appearance or contents in ways that 
aren’t available in QuickBooks, filter report data in ways that you can’t in QuickBooks, 
or run what-if scenarios on your QuickBooks data.

You can send QuickBooks Pro or Premier reports to Microsoft Excel. Since the changes 
you make in Excel don’t affect your QuickBooks data, you’re free to customize reports 
as needed, and even change data to run what-if scenarios.

Note: To proceed with this exercise, you need QuickBooks Pro or Premier and 
Microsoft Excel 97, 2000, or 2002. If you don’t have Excel, proceed to  
“Creating QuickInsight graphs” on page 189.

Sending a report to Microsoft Excel

When exporting a report to Microsoft Excel, you indicate whether or not you want to 
preserve the formatting from your QuickBooks report. You also have the option of 
turning on or off several Excel features from within QuickBooks.

By default, QuickBooks preserves the look of your report when exporting to Microsoft 
Excel, and turns on the following Excel features:

■ AutoFit sets column widths in Excel wide enough to display your data without 
cutting off words or numbers.

■ Freeze panes allows you to scroll through data while keeping the row and column 
headers in view.
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■ Show Gridlines turns on gridlines in Excel.

In this exercise, you learn how to select which QuickBooks report formatting options 
you want to preserve in Excel, and how to turn on and off certain Excel features from 
within QuickBooks.

To send a report to Microsoft Excel:
1 From the Reports menu, choose Company & Financial, then choose  

Balance Sheet Standard.

2 On the Report buttonbar, click Modify Report.

QuickBooks displays the Modify report window.

3 In the “Add subcolumns for” area, click the Previous Period checkbox, then click 
the $ Change and % Change checkboxes.

Your screen should resemble the following.
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4 Click OK.

Your balance sheet should now look like this.

5 On the Report buttonbar, click Export.

QuickBooks displays the Export Report - Basic options tab window.

6 Make sure that the Export QuickBooks report selection is set to “A new Excel 
workbook”.

7 Click the Advanced tab.

QuickBooks displays the Export Report to Excel - Advanced options window.
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8 Under Formatting options, click the Colours checkbox to clear it.

The title font will remain blue in QuickBooks, but display in black in Excel.

9 Under Excel features, select the Auto Filtering checkbox.

Your screen should now resemble the following.

10 Click Export.

QuickBooks starts Excel (if it’s not running already) and sends the report to a new 
spreadsheet.

11 Leave the report open in Excel; you’ll use it in the next exercise.

If you wanted to save the report, you would choose Save from the Excel File menu.
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Filtering a report in Microsoft Excel

Within Microsoft Excel, you can filter on any column of data using a drop-down list 
at the top of the column. Using the drop-down list, you can apply a number of preset 
filters or create your own custom filter.

To find out if any of Rock Castle Construction’s account balances have decreased since 
the previous period, you’ll filter the balance sheet report you just created.

To filter a report in Microsoft Excel:
1 In the Excel window, click the down arrow in the $ Change column of the balance 

sheet report, and choose (Custom...) from the drop-down list. Excel displays the 
following window.

2 In the $ Change field, choose “is less than” from the drop-down list.

3 In the field to the right, type 0. Your screen should resemble the following.

4 Click OK. Excel filters the $ Change column for negative amounts and displays the 
results.

5 Close Excel without saving the report.

6 Close the balance sheet report in QuickBooks.

7 Choose No if you’re prompted to memorize the report.
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Creating QuickInsight graphs

A report gives you numbers that are essential if you want to stay on top of your 
business finances. But when you want a visual picture to plan current or future 
business decisions, a graph is another invaluable tool.

A QuickInsight graph shows your data pictured as either a bar graph or a pie chart. The 
bar graphs and pie charts are simply different views of the same company financial 
information.

Refer to Handout 27, “QuickInsight graph types.”

QuickBooks has six types of graphs, providing up to 15 different views of your data:

■ Income and Expenses graphs show your income and expenses for the period you 
specify.

■ Sales graphs show your company’s sales income for the period you specify.

■ Accounts Receivable graphs show how much your customers owe.

■ Accounts Payable graphs show how much you currently owe your vendors.

■ Net Worth graphs show changes in your company’s net worth.

■ Budget vs. Actual graphs let you see the variance between your budgeted 
amounts and the actual amount you earned or spent.

To create a QuickInsight graph, select the type of graph you want from a report 
submenu.

Creating an Income and Expense graph

If you want your business to be profitable, you need to keep an eye on your expenses. 
The income and expense graph shows you exactly what you’re spending and where.

You should be especially concerned with the proportion you’re spending relative to 
the income you receive. As a simplistic example, if you’re earning only $20,000 in 
income, you don’t want to spend $30,000 in expenses.
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To create an income and expense graph:
1 From the Reports menu, choose Company & Financial, then choose  

Income & Expense Graph.

QuickBooks displays a graph depicting your income and expenses.

In the top portion of the graph window, QuickBooks displays a bar graph and 
legend showing total income and expenses. In the lower portion of the window, 
QuickBooks displays a pie chart and legend showing expense percentages by 
account.

2 QuickBooks can display only 10 accounts at a time. To display more accounts, 
click the Next Group button at the top of the graph window.

Features of QuickInsight graphs

These features are common to all QuickInsight graphs:

■ Every graph window, except for the Net Worth and the Budget vs Actual graphs, 
shows a bar graph in the top part of the window and a pie chart in the bottom half.

The bar graph usually shows totals. For example, the Income and Expense graph 
shows the total for income and the total for expenses in each month of the period.

The pie chart shows a breakdown of the information shown in the bar graph; each 
pie slice in the Income and Expense graph represents a type of income or expense. 
The legend to the right of the pie chart shows you which income or expense 
account corresponds to the colour shown in the pie chart; it also shows you what 
percentage of the pie each slice represents.
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■ Every graph window has a buttonbar with buttons you can click to customize the 
graph. For example, you can change the time period shown in the graph by 
clicking the Dates button. If you want the pie chart to show a breakdown by 
customer or class rather than a breakdown by account, just click By Customer or 
By Class.

■ Just as you can use QuickZoom in a report to get more detail on the numbers, you 
can use QuickZoom in a graph to see the numbers behind the picture. When you 
position the mouse pointer over a bar or pie slice and double-click, QuickBooks 
shows you the numbers represented by that graphic image. For example, the pie 
chart legend tells which income/expense accounts are represented by each pie 
slice, and tells you what percentage of the whole is represented by each slice. 
When you zoom in on a pie slice, you can find out exactly how much you received 
or spent (in dollars) for each account.

Customizing graph data

To display income accounts instead of expense accounts:
1 Click Income at the bottom of the graph window.

2 Click By Customer.

QuickBooks changes the pie chart to display income by customers.
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Using QuickZoom with graphs

To help you better understand the information shown in the graphs, QuickBooks lets 
you trace graphical data using QuickZoom graphs.

To display the sales for Anton Teschner:
1 Position the mouse pointer over the Teschner, Anton slice of the pie chart.

(Use the Key on the right side of the window.)

The pointer changes to a magnifying glass with the letter Z inside.

2 Double-click the Teschner, Anton slice.

Note:  If a slice is too small to click, click on its legend representation instead.

QuickBooks displays a QuickZoom graph depicting sales for Anton Teschner by 
month.

To display a report describing the transactions for a given month:
1 Position the mouse pointer over the bar representing November 2007.

The pointer turns into the QuickZoom symbol.

2 Double-click the bar.

QuickBooks displays the custom transaction detail report for the month of 
November 2007.

You may need to scroll to the right to see the entire report.
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To display the first transaction in the report:
1 Double-click any of the lines in the report for Invoice #60.

QuickBooks displays the invoice.

2 From the Window menu, choose Close All.

Customizing how graphs display

You can customize graphs to control what data they include and how the data is 
displayed. In this exercise, you’ll change the display from three-dimensional (3D) to 
two-dimensional (2D) graphs.

To change from 3D to 2D:
1 From the Edit menu, choose Preferences.

QuickBooks displays the Preferences window.

2 In the left scroll box, click Reports & Graphs.
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QuickBooks displays the Preferences window for Reports and Graphs.

3 Click “Draw graphs in 2D (faster).”

A checkmark appears in the checkbox to indicate that Draw graphs in 2D (faster) 
is selected.

4 Click OK.

5 From the Reports menu, choose Sales. Then choose Sales Graph.

QuickBooks displays the sales graph in 2D.

Displaying graphs in 2D often allows your computer to draw them on your screen 
faster than displaying them in 3D.

6 Close the graph.
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Student test and review
1 Create a QuickReport on an item in one of Rock Castle Construction’s lists.

2 Rock Castle Construction wants to create a report that shows how much they have 
spent on lumber for projects during the month of November, 2003. Create an item 
summary purchase report, covering the date range from 11/01/2003 to 
11/30/2003. Filter the report to show only Rock Castle Construction’s purchases 
for Lumber.

3 Batch process the balance sheet, profit and loss statement, and statement of cash 
flows using the Process Multiple Reports window.
195



A n a l y z i n g  f i n a n c i a l  d a t a
196



• • • • • • • • • •

LESSON 10 Setting up 
inventory
5

Lesson objectives, 198

Handout materials, 198

To start this lesson, 198

Turning on the inventory feature, 199

Entering products into inventory, 199
Tracking Units of Measure (Pro & Premier only), 200

Ordering products, 204
Creating purchase orders, 204

Getting a report of purchase orders, 205

Receiving inventory, 207

Entering a bill for inventory, 209

Manually adjusting inventory, 211

Student test and review, 213
197



S e t t i n g  u p  i n v e n t o r y
Lesson objectives
■ To get an overview of inventory in QuickBooks

■ To practice filling out a purchase order for inventory items

■ To track the receipt of the inventory items in QuickBooks 

■ To adjust inventory manually, to enter a stock loss or increase

■ To create and build inventory assemblies (finished goods)

Handout materials
■ Handout 28:  Inventory in QuickBooks

■ Handout 29:  Paying for inventory items

To start this lesson

Before you perform the following steps, make sure you have installed the exercise file 
(qbcanlesson.qbb) on your hard disk. 

The steps that follow will restore the exercise file to its original state so that the data 
in the file matches what you see on the screen as you proceed through each lesson.

To restore the exercise file (qbcanlesson.qbb):
1 From the File menu in QuickBooks, choose Restore.

QuickBooks displays the Restore Company Backup window.

2 In the “Get Company Backup From” section of the window, click Browse and 
select your c:\QBtrain directory.

3 Select the qbcanlesson.qbb file, then click Open.

4 In the “Restore Company Backup To” section of the window, click Browse and 
select your c:\QBtrain directory.

5 In the File name field of the Restore To window, type lesson 10, then click Save.

6 Click Restore.
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Turning on the inventory feature

The QuickBooks inventory feature is turned on in your exercise file, but you’ll review 
how to turn on this feature so you become familiar with QuickBooks preferences. If 
you need to track inventory for your company, you can turn the feature on while 
completing the EasyStep Interview. If you want to turn on the inventory feature after 
you’ve completed the EasyStep Interview, follow this procedure.

To turn on the inventory feature:
1 From the Edit menu, choose Preferences.

2 Select Purchases & Vendors from the scroll box.

3 Click the Company Preferences tab.

Note: Only the QuickBooks Administrator can change company preferences.

4 Click the “Inventory and purchase orders are active” checkbox to select it.

A checkmark shows that the inventory feature is turned on.

5 Click the “Units of Measure are active” checkbox to select it.

Note that if Units of Measure is already selected, QuickBooks does not allow it to 
be unselected.

6 Click OK.

Entering products into inventory

Many small businesses that stock inventory don’t know the number of units they have 
on hand or on order at any given time, and have no way of getting that information 
quickly. Using QuickBooks to manage your inventory, you’ll be able to track the 
number of items in stock and the value of your inventory after every purchase and 
sale. As you order inventory items, receive the items, and later sell the items from 
inventory, QuickBooks tracks each inventory-related transaction. You will know the 
status of your inventory and will have a more accurate picture of your business’s 
assets.

To track inventory, you must enter each product into the Item list as an inventory 
part. Once you enter a product, QuickBooks tracks it as you sell or reorder the product.
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Tracking Units of Measure (Pro & Premier only)

With this version of QuickBooks, you can set up a different unit of measure than the 
one you purchased it in. For example, you can buy soda pop in case with 12 cans to a 
case, and sell them by the can. Then, when you sell one can, QuickBooks understands 
this transaction to mean 1/12 of a case.

The association between an item’s units of measure cannot be changed once a 
transaction involving the item is recorded. Once units of measure are set up for an 
item, the item’s appropriate unit of measure is then displayed on business forms. Sales 
forms show the selling units, and purchasing forms show purchasing units. On forms, 
you cannot switch to a different unit of measure. You can, however, change the 
reports to display in the units you want through the Modify Report window.

What happens when Units of Measure is turned on?

When the units of measure preference is turned on, you’ll see the following changes 
in QuickBooks.

■ A Units of Measure button is added to the Inventory Part and Inventory Assembly 
type items window. This button opens the Define Units of Measure window where 
you can set up different units of measure for these items.

■ A field is added to the Service and Non-Inventory Part items window where you 
can assign a descriptive label that represents the unit of measure used when 
dealing with the item.

■ A Unit column is added to all forms. This new column displays the item’s unit of 
measure associated with the type of transaction. For example, the selling unit is 
used on sales forms such as invoices and sales orders, and the purchasing unit on 
purchase forms such as bills and purchase orders.

■ A Unit column is also displayed on some windows such as “Adjust Quantity/Value 
on Hand” and “Change Item Prices”.

■ A Unit column is added to display an item’s units of measure on reports to do with 
the item list; and purchases, sales and inventory transactions.

You will practice using Units of Measure in this exercise.

To enter a product into inventory:
1 From the Vendors menu, choose Item List.

QuickBooks displays the Item list.

2 Click the Item menu button, then choose New.

QuickBooks displays the New Item window.
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You’ll enter one new item into your inventory.

3 In the Type field, choose Inventory Part from the drop-down list.

QuickBooks changes the New Item window to accept information for an 
inventory part.

4 In the Item Name/Number field, type Door Hinge 120 (120 is the style number).

5 Select the “Subitem of” checkbox, then choose Cabinets from the drop-down list.

6 In the Description on Purchase Transactions field, type Cabinet Door Hinge 120 
Degree, then press TAB to move to the Cost field.

Notice that QuickBooks fills in the Description on Sales Transactions field with the 
same description you entered for the purchase side. You can leave the sales 
description the same or change it later.
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7 In the Cost field, type 3, then press TAB.

8 Choose “Yes” when the pop-up Window for the Setup of Units of Measure 
appears.

9 When the Define Units of Measure for Door Hinge 120 appears, type case in the I 
stock this item in field of the Inventory Unit section.

10 In the Sales Unit section, clear the box titled “Same as Inventory” and type hinge 
in the I sell this item by field.

11 Type 10 in the first field of the Association to Inventory section.

12 Click the down arrow and select “hinge per case” from the drop down list. Leave 
the Purchasing Unit section as is.

Your screen should look like this.

13 Click OK to close this window.

14 In the Preferred Vendor field, choose Thomas Kitchen and Bath from the  
drop-down list.

Or, type the first few letters of your selection and QuickBooks fills in the rest.

15 In the Sales Price field, type 4.

Notice that the cost per case is listed on the Purchase Information section and the 
Sales Price per hinge is seen on the Sales Information side.

16 Leave the Tax Code setting as is. 

If you wanted to assign a different tax code, you could select a different code from 
the drop-down list when setting up the item.

17 In the Income Account field, choose Construction:Materials.

18 Press TAB to move to the Asset Account field.

Inventory Asset was filled in when you selected Inventory Part as the type of item. 
Leave this default setting.

19 In the Reorder Point field, type 5.
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20 In the Qty-on-Hand field, type 10, then press TAB to move to the Total Value field.

Notice that QuickBooks has calculated the value of your item by multiplying the 
number in the On Hand field by the number in the Cost field.

Your New Item window should resemble the following figure.

21 Click OK to close the New Item window.

QuickBooks adds the new item to the Item list.

22 Close the Item list.
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Ordering products

Once you enter your current products and vendors into the Item and Vendor lists, 
you’ll need to order products to keep your inventory stocked.

Creating purchase orders

In Lesson 6, you created a sales order for door frames. Now, create the purchase order 
to order the items from the vendor.

To order a product using a purchase order:
1 From the Vendors menu, choose Create Purchase Orders.

QuickBooks displays the Create Purchase Orders window.

You use the Create Purchase Orders window to enter the products you want to 
order, the quantities, and the vendor. As you fill in this information, QuickBooks 
automatically calculates purchase order number, item cost, and total cost.

Notice that QuickBooks has already entered today’s date and a sequential purchase 
order number.

2 In the Vendor field, choose Thomas Kitchen & Bath from the drop-down list.

Notice that QuickBooks displays all of the information about Thomas Kitchen & 
Bath in the appropriate places on the purchase order form.

3 In the Item column, select Cabinet: CAB 2015 from the drop-down list.

4 In the QTY field, type 10.

Notice that the Units column is filled automatically.
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5 In the Vendor Message field of the purchase order, type Please rush ship this order.

Your Purchase Order should resemble the following figure.

6 Click Save & Close to record the purchase order.

After you have created a purchase order, QuickBooks adds an account to the chart of 
accounts called Purchase Orders. This is a non-posting account and does not affect 
your balance sheet or income statement. The Purchase Orders account is used to 
produce a QuickReport showing current purchase orders so you always know what is 
on order.

Getting a report of purchase orders

To get a chronologically ordered report of all the purchase orders 
you have written:
1 From the Lists menu, choose Chart of Accounts.

2 In the chart of accounts, click Purchase Orders once to select it.

3 Click the Reports menu button at the bottom of the frame and choose Quick-
Report: Purchase Orders.
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QuickBooks displays a report of all purchase orders.

Notice the purchase order you have just created is at the bottom of the report.

4 Close the QuickReport.

5 Close the chart of accounts.
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Receiving inventory

When you receive the items you have ordered with your purchase order, you have to 
enter the items into inventory. You can receive items with a bill or without a bill. 

This exercise shows you how to enter into QuickBooks inventory items you’ve 
received when the bill for those items will follow later.

To receive inventory without a bill attached:
1 From the Vendors menu, choose Receive Items.

QuickBooks displays the Create Item Receipts window.

The Create Item Receipts window lets you enter information for inventory parts 
you’ve received.

2 In the Vendor field, choose Thomas Kitchen & Bath from the drop-down list and 
press TAB.

QuickBooks tells you that there are open purchase orders for this vendor and asks 
if you want to receive against one of these orders.

3 Click Yes.

QuickBooks displays the Open Purchase Orders for Thomas Kitchen & Bath.
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4 Click the fourth purchase order (#89, dated 12/15/2007) to select it.

QuickBooks places a checkmark in the left-most column for the item selected.

5 Click OK to move the information to the item receipt.

The Create Item Receipts window should resemble the following figure.

6 Click Save & Close to process the receipt.

QuickBooks processes the items and adds them to your inventory. If you display 
the Item list, you’ll see that you now have 10 additional cases of kitchen cabinets 
on hand.
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Entering a bill for inventory

If you've entered an item receipt for inventory, but the bill hasn't arrived yet, you can 
still record the bill amount in QuickBooks. Entering the bill as shown in this exercise 
records the amount in your accounts payable account so you can track how much you 
owe.

When the bill comes, you pay the bill just like you would pay any other bill in 
QuickBooks (from the Pay Bills window).

To enter the bill:
1 From the Vendors menu, choose Enter Bill for Received Items.

QuickBooks displays the Select Item Receipt window, where you can select the 
vendor and the item for which you have a bill.

2 In the Vendor field, select Thomas Kitchen & Bath in the drop-down list and press 
TAB.

QuickBooks fills in the Date and Memo fields with information that corresponds 
to your bill.

3 Select “Received items (bill to follow),” dated 12/15/2007. 

4 Click OK.
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QuickBooks displays the Enter Bills window.

5 Click Save & Close.

QuickBooks changes the item receipt to a bill in the Accounts Payable account and 
lists the bill in the Pay Bills window. If you look at the Accounts Payable, you’ll see 
that the balance increased by $1,690.00, based on the bill entered for Thomas 
Kitchen & Bath.

Because you must have inventory on hand before you can enter a sale for 
inventory parts, we recommend that you enter your item receipts before entering 
sales.
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Manually adjusting inventory

When you have spoilage or send out samples of your products, you can adjust your 
inventory manually.

To adjust the inventory manually:
1 From the Vendors menu, choose Inventory Activities, then choose  

Adjust Quantity/Value on Hand.

QuickBooks displays the Adjust Quantity/Value on Hand window.

The Adjust Quantity/Value on Hand window lets you enter the adjustment 
account, and either the New Qty or the Qty Difference. Since two wood interior 
doors were damaged, you’ll adjust the inventory account to remove two doors.

2 In the Adjustment Account field, type Inventory Adjustment and press TAB.

3 In the Qty Difference column for Wood Door:Interior wood door, type –2 (the 
number of damaged doors), then press TAB.
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QuickBooks calculates the value adjustment and decreases the inventory by two 
items.

4 Click Save & Close.
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Student test and review
1 Enter a new inventory item using the following information.

- Item Name/Number: Kitchen counter

- Purchase Description: Kitchen counter

- Cost: 280.00

- COGS Account: Cost of Goods Sold

- Preferred Vendor: Patton Hardware Supplies

- Sales Description: Same as Purchase Description

- Sales Price: 340.00

- Income Account: Construction:materials

- Asset Account: Inventory Asset

- Reorder Point: 5

- Qty on Hand: 6

2 Create a purchase order for 20 Standard doorknobs.

3 Receive the 20 Standard doorknobs into inventory and record the bill for the  
doorknobs.

4 Process the bill and pay for the 20 Standard doorknobs.
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Lesson objectives
■ To get an overview of sales tax in QuickBooks (the steps involved in tracking, 

collecting, and paying it)

■ To see how to set up QuickBooks to track sales tax

■ To see how to apply sales tax to a sale

■ To learn how to determine a business’s sales tax liability

■ To write a QuickBooks cheque to the appropriate tax agency for sales tax liability

To start this lesson

Before you perform the following steps, make sure you have installed the exercise file 
(qbcanlesson.qbb) on your hard disk. 

The steps that follow will restore the exercise file to its original state so that the data 
in the file matches what you see on the screen as you proceed through each lesson.

To restore the exercise file (qbcanlesson.qbb):
1 From the File menu in QuickBooks, choose Restore.

QuickBooks displays the Restore Company Backup window.

2 In the “Get Company Backup From” section of the window, click Browse and 
select your c:\QBtrain directory.

3 Select the qbcanlesson.qbb file, then click Open.

4 In the “Restore Company Backup To” section of the window, click Browse and 
select your c:\QBtrain directory.

5 In the File name field of the Restore To window, type lesson 11, then click Save.

6 Click Restore.
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Overview of sales tax in QuickBooks

Although very small businesses are exempt, the Canada Revenue Agency (CRA) 
recommends that all businesses register to collect the Goods and Services Tax (GST) 
or, in provinces where the provincial sales tax has been combined with the GST, the 
Harmonized Sales Tax (HST). Registered businesses track the GST or HST collected 
from customers on sales and paid on purchases for the business. Usually, you collect 
more sales tax than you pay out and must remit the difference to the CRA. 
(Occasionally, you pay out more than you collect – for example, when your business 
is starting up – and claim a refund.)

When your company’s sales reach a certain level, you are required to register to collect 
the GST or HST. You should check with the CRA or your accountant for detailed 
information about how your business should handle the GST or HST.

Many provincial governments also require you to register to collect a provincial sales 
tax (PST or, in Québec, QST). In most provinces, you track only the PST you collect 
from customers (instead of both the amount you collect and the amount you pay) and 
remit that amount to the government.

However, in Québec, the QST works much the same way as the GST: businesses may 
be able to deduct the amount of QST paid on business-related purchases — called an 
input tax credit — from the amount of QST collected from customers, then remit the 
difference.

Check with your province’s Ministry of Finance or your accountant about how your 
business should handle federal and provincial sales taxes.

In broad terms, collecting sales taxes in QuickBooks means 

■ confirming that QuickBooks is handling GST and PST the way your business and 
government regulations require;

■ assigning tax codes to items so that QuickBooks knows what taxes (e.g. none, GST 
only, PST only, or both GST and PST) to apply to items (or services) that you sell 
or purchase;

■ in rare cases, assigning tax codes to customers who have special tax needs; and

■ filing sales tax returns to the government and creating cheques for the amount 
you owe.

Once you have confirmed that the default tax codes in QuickBooks meet your needs 
or else set up sales tax codes or your own, then assigned these tax codes to the items 
you sell and buy, QuickBooks automatically applies the correct taxes as you work. The 
dollar amounts of the taxes appear at the bottom of sales and purchase forms. Later, 
when you’re ready to pay your sales tax liabilities, QuickBooks can create a return and 
a cheque for the correct amount for you.
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The assumptions this guide makes about PST

Provincial sales taxes vary significantly. The examples in this lesson work on two 
assumptions which may not be true in your area. Always check with an accountant or 
your province’s Ministry of Finance about how your provincial sales tax works.

The examples assume that there is a provincial sales tax. They also assume that when 
a company buys something to resell, it pays the PST at the time of the purchase and 
is not for it reimbursed later.

However, in some provinces, companies buying goods to resell can present a PST 
Exemption form to avoid paying the PST on the purchase. In this case, you would set 
up the item in QuickBooks to have one tax code when you buy it (GST only) and 
another when you resell it (GST and PST).

In other provinces, businesses can claim the PST they pay on purchases as an input tax 
credit, like the GST. In this case, you would assign the PST you pay on business-related 
items to your PST Liability account (to reduce what you have to remit to the 
government) instead of to a PST Expense account.

How QuickBooks calculates the GST and PST

QuickBooks uses your company address to determine what rates of GST and PST apply 
to you and assigns these rates to the default sales tax codes. You then assign these sales 
tax codes to the items you buy and sell.

On sales and purchase forms, QuickBooks calculates the GST and PST separately for 
each item according to the sales tax code you assigned to it. It displays the GST and 
PST totals in their respective boxes at the bottom of the sales or purchase form, then 
adds these amount to the cost of the goods or services. The HST, if applicable, is 
calculated as one rate in the GST field.

Because QuickBooks rounds the individual tax amounts to the nearest cent, the total 
may be slightly different than the total you would get if you combined the taxes into 
one rate and applied it to the sale. Don’t worry about this discrepancy; QuickBooks 
calculates and reports each individual tax amount correctly.

At regular intervals, you file GST and PST returns to remit the amount you owe to the 
federal and provincial governments. When you do, the sales and purchases covered by 
the return are marked as “filed.” Filed transactions never appear in GST or PST returns. 
If you enter a backdated transaction into a previous GST or PST period after you’ve 
already sent your return, it will automatically be included in the next return you send, 
but no other transaction from that period will be.
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To use QuickBooks to track and pay your sales tax:
1 Set up your tax rates and agencies.

QuickBooks uses your company address to determine what rates of GST and PST 
apply in your province, what tax accounts to set up, and the tax agencies (that is, 
the government departments that administer sales taxes) you’ll need. The tax rates 
are set up in tax codes that combine a GST and a PST rate into a single code. 

You can also set up new tax codes if you have additional tax rates or types of tax 
that are applicable to your business. 

2 Indicate what (and occasionally who) gets taxed.

For each item, indicate the tax code to be used when that item is purchased and 
when it is sold. In your Customer:Job list you can also indicate whether the 
Customer:Job has a specific tax code. The customer tax code will override item tax 
codes in a transaction. 

3 Apply tax to each sale or purchase.

When you fill out an invoice, sales receipt form, or purchase form, QuickBooks 
applies the appropriate sales tax. If the item does not have a tax code assigned you 
can add a tax code. QuickBooks uses the tax code to calculate the appropriate sales 
tax for the transaction. If necessary, you can override the tax amount calculated. 

4 Find out what you owe

As you record taxable sales, QuickBooks keeps track of the tax you’ve collected in 
your GST or PST Payable account. When you’re ready to pay your sales tax, you 
can open the Sales Tax Payable register to see how much you owe, or you can 
create a sales tax liability report.

5 File your sales tax return.

To file your sales tax return to the applicable tax agency, go to the File Sales Tax 
window. QuickBooks will show the amount you owe (or have owing to you) and 
you will be able to create a cheque and print out a return to assist in completing 
your tax return for the tax agency. If you have a refund due to you, QuickBooks 
will create an invoice for the amount that you are claiming as a refund on your 
return.

This lesson walks you through each of these steps.
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Setting up your tax rates

QuickBooks creates sales tax codes, tax accounts, and tax agencies based on the 
province of your company file. Tax codes are assigned to items, then used in 
transactions to calculate the tax. The sales tax is then tracked to the GST Payable and 
PST Payable liability accounts.

Now we need to make sure the default sales tax codes set up by QuickBooks meet your 
needs and assign a tax code to each item the company buys and sells.

Reviewing the default sales tax codes

In rare cases, a business may need to adjust the default sales taxes that QuickBooks sets 
up. For example, if your province charges an increased amount of sales tax on a 
particular item your business sells, you may want to set up a new sales tax code that 
takes the higher rate into account.

To create a new sales tax code:
1 From the Lists menu, choose Tax Codes List.

QuickBooks displays the tax code list. 

2 Click the Tax Code menu button at the bottom of the window, then choose New.

In this example, we will assume that Rock Castle Construction is going to start 
offering insurance policies to customers to cover weather damage to the building 
while it is under constructions, and that the provincial government charges 14% 
PST on insurance policies instead of the usual 8%.

3 In the Tax Code field, enter I (for insurance).

4 In the Description field, type Insurance Policies (to remind use that this is a special 
tax code for use only with insurance items).

5 In the GST Rate (%) field, type 7.
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6 In the PST Rate (%) field, type 14.

Your new tax code should resemble the following figure:

7 Leave the Tax Exempt and Calculate Provincial Tax on GST checkboxes clear.

■ If either the GST or PST does not apply to a new tax code you’re setting up, 
select the Tax Exempt box. Note that selecting this box is not the same as 
leaving the percentage at zero! (See “What the Zero Rated (Z) tax code is for” 
on page 221.)

■ In some provinces, on a sale, you calculate the GST first, add it to the purchase 
price of the item or service, then calculate the PST based on this new total. If 
this is the case in your province, you would select the “Calculate Provincial 
Tax on GST (Piggyback)” checkbox when setting up a new tax code.

8 Click OK.

Your new “I” tax code now appears in the Tax Code List.

9 Close the Tax Code List window

What the Zero Rated (Z) tax code is for

Under the GST, certain goods and services are taxed at a rate of 0% instead of the usual 
7%. These items are called Zero Rated. Zero Rated items are not tax exempt, and 
should not be assigned the Exempt tax code (E).

If you sell a Zero Rated item, you charge your customers 0% GST on it. This means that 
you do not collect any GST to remit to the government. However, because the item is 
taxable, you can claim input tax credits (the GST you paid on the materials you needed 
to produce the item) for it. When you file your GST return, you receive a refund based 
on these credits.
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Zero Rated items usually fall into these categories. (However, you should always check 
with the CCRA for the status of a specific item!)

■ Prescription drugs and medical devices

■ Basic groceries

■ Products destined for export

■ Professional farming and fishing goods

■ International travel and transportation services

■ Financial services

Using QuickBooks to track and pay your sales tax

In this lesson you will learn how to set up your tax rates, tax accounts, and tax 
agencies. Assume Rock Castle Construction uses the Standard (GST + PST) sales tax 
most often, and it wants to set that up as the default sales tax.

To set up a default sales tax:
1 From the Edit menu, choose Preferences.

QuickBooks displays the Preferences window.

2 In the Preferences window, click the GST/PST icon in the left scroll box, then click 
the Company Preferences tab.

3 In both the Goods and Services Preferences and the Provincial Sales Tax Prefer-
ences, be sure that the Yes option buttons are chosen for registration and 
recording taxes.

4 Confirm that your Business Number is entered properly to ensure this is printed 
on your sales invoices, and that the reporting periods match the months in which 
you file GST and PST returns.
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5 In the Default Tax Code, make sure S (for Standard) is selected.

QuickBooks will assign this tax code to all new items you create (although you can 
change it if you want).

6 In the Default Customer Tax Code fields, make sure the “Allow customer tax 
codes” option is selected, then select <Not Used> from the drop-down menu.

If you have a customer with special tax status, you can check this box. You will 
then be able to assign a tax code to him or her. On sales forms, the tax code you 
assign to a customer overrides all the tax codes you assign to items. For example, 
suppose you supply goods to a government agency that does not pay the GST. You 
could assign the government agency an E customer tax code (for tax exempt). 
Then, on invoices to this customer, QuickBooks will not calculate sales tax even if 
the items you are selling have tax codes showing they should be taxed.

The “<Not Used>” code means that new customers you create will not have a tax 
code assigned to them by default. You will have to assign each customer tax code 
manually by editing the customer’s profile in the Customer:Job list. 

To have QuickBooks assign a default tax code to all new customers you create, you 
can choose tax code from the “Default customer tax code” list. However, because 
customer tax codes override all item codes on all sales forms, it’s usually best to do 
this only on the advice of your accountant. Instead, assign customer tax codes 
only as you need them.

7 Click OK.

You can use the codes that come preset with QuickBooks, or define your own. You can 
manage sales tax codes using the Sales Tax Code list, which is available on the Lists 
menu when the sales tax feature is turned on in a company data file.

Indicating the tax rates on Items

The next step in setting up sales tax is to indicate what the tax rates apply to each item. 
For each item that you set up in the Item list, you should indicate the tax code to be 
used when that item is purchased and when it is sold. The tax code determines the rate 
of GST and PST that QuickBooks applies. 

In the next exercise, you’ll take a look at an item on Rock Castle’s Item list to see how 
to indicate the tax code that is being used.

To assign or change a tax code to an item:
1 From the Lists menu, choose Item List to display the list of items.

2 Select Doorknobs Std (under Hardware).

3 Click the Item menu button, then choose Edit.

QuickBooks displays the Edit Item window.
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The tax code in the purchase tax code field tells you how QuickBooks will calculate 
sales taxes on this item when you purchase it from a vendor. When you include 
this item on a purchase form (bill), QuickBooks knows the rate of tax to apply to 
the item and automatically calculates the tax amount for it. 

The code in the sales tax code field tells you the rate of GST and PST to calculate 
on a sales transaction. When you choose the item to be included on a sales form 
(invoice or sales receipt), QuickBooks knows the rate of tax to apply to the item 
and automatically calculates the tax on that item.

4 Click OK to close the Edit Item window.

5 Close the Item list.

In the same way that you can specify the tax rate on an Item by attaching a tax 
code to the item, you can indicate the tax rate in a particular customer's record by 
attaching a tax code. On a sales form, the tax code of the customer will override 
the tax code of the item.

To see an existing customer record:
1 From the Lists menu, choose Customer:Job List.

QuickBooks displays the Customer:Job list.

2 Select Jimenez, Cristina.
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3 Click the Customer:Job menu button, then choose Edit.

QuickBooks displays the Edit Customer window.

4 Click the Additional Info tab.

5 Note that the Use customer tax code box is checked. That means it is possible for 
you to assign a tax code to this customer.
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6 Note that S (for Standard tax code) from the drop-down list is selected.

This code means that this customer will always pay both GST and PST on items 
she buys from you regardless of whether the items are tax exempt (such as 
groceries) or should have only GST or PST (but not both) charged on them. In the 
real business world, this situation would not likely arise.

More likely, in the unlikely event that you need to assign a tax code to a customer, 
it will be because he or she is tax exempt, and you would select E from the drop 
down list.

7 Click OK.

8 Close the Customer:Job list.

Applying tax to each sale

When you fill out a sales invoice, or receipt, each item will normally have a tax code 
assigned. If an item does not have a tax code assigned, you can enter it directly on the 
form. QuickBooks uses the tax code to calculate the amount of tax for the transaction. 

To apply tax to a sale:
1 From the Customers menu, choose Create Invoices.

QuickBooks displays the Create Invoices window.

2 In the Customer:Job field, choose Jimenez, Cristina:Utility Shed from the drop-
down list. (Select both the customer and the job.)

3 Click in the Item column and select Doorknobs Std from the drop-down list.

The Create Invoices window should resemble the figure below.
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When you enter an item, QuickBooks displays the tax code associated with that 
item (in this case, the S tax code) in the Tax column, which appears to the right of 
the Amount column. QuickBooks then calculates the sales tax and shows the 
amounts in the GST and PST boxes below the items area.

[Note that even if you had assigned a different tax code to this item, in this case, 
QuickBooks would have displayed the S tax code anyway because this is the sales 
tax you assigned to the customer, Cristina Jimenez.]

Tip: You can select a different tax code from the list to change the tax that is 
calculated for each item.

4 In the Quantity column, type 4, then press TAB.

The Create Invoices window should resemble the following figure.

5 Click Save & Close.
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Determining what you owe

If you are registered for GST, you are required to file periodic returns to the Receiver 
General to report the tax that you have charged on your sales and paid on your 
purchases. If you are registered for PST, you are required to file periodic returns to your 
provincial treasurer to report the tax that you have charged on your sales. Registrants 
in Quebec, need to report the tax charged on your sales and paid on your purchases 
to the Quebec treasurer.

QuickBooks can help you determine what you owe, or have owing from, these tax 
agencies and assist you in preparing the returns that need to be filed. QuickBooks gives 
you three ways to determine the amount of your sales tax liability: the GST or PST 
liability report, the GST or PST Payable register, and the Pay Sales Tax window.

Creating a sales tax liability report

The sales tax liability report provides complete information about the sales tax your 
company owes for a particular period of time. The report is designed to display the 
amounts you need to complete your sales tax return for the tax agencies involved and 
to provide details to support the numbers on your sales tax return.

To create the GST liability report:
1 From the Reports menu, choose Vendors & Payables, then choose GST Liability.

Your report should resemble the following figure.

The GST liability report shows all transactions up to the report date that are not 
marked as filed. The report will calculate the amount of GST recorded as tax on 
sales and tax on purchases that have not been previously filed. 
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2 To view the GST Detail report, double-click on any of the dollar amounts listed in 
the far right column.

3 Close the GST Detail report. If QuickBooks asks if you want to memorize the 
report, click No.

4 Close the GST Liability report.

Tip: To view a PST liability report, choose PST Liability from the drop down list under 
Reports > Vendors & Payables.

Using the sales tax payable register

Each time you write an invoice or sales receipt that includes sales tax, QuickBooks 
enters the information in the sales tax payable register. The tax liability register 
displays all the transactions that are recorded to the sales tax account and provides a 
running balance of the account. The register also allows you to see what transactions 
have been filed in the File Sales Tax process. If necessary, the user can edit the filing 
status of these transactions in the register.

To see the sales tax payable register:
1 From the Company menu, choose Chart of Accounts.

QuickBooks displays the chart of accounts.

2 Click GST Payable once to select it.

3 Click the Activities menu button and select Use Register.

QuickBooks displays the GST Payable register.
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Each entry in the register is a single tax transaction. Taxes you record on invoices 
and sales receipts appear as increases, and payments you make to tax agencies 
appear as decreases. The ending balance of the register is your current tax liability.

The “checkmark” column between the Increase and Decrease columns is used to 
show two things. The white area shows whether you have reconciled the trans-
action yet. It shows nothing for not reconciled, an asterisk (*) for pending (when 
you pause a reconciliation), and a checkmark for reconciled.

The light brown area shows whether the transaction has been reported on a GST 
return. If it has, it is marked with an “F”. 

4 Close the register.

5 Close the chart of accounts.

Filing a sales tax return

When it's time to file a sales tax return, you use the File Sales Tax window to calculate 
the amount of tax owing or refundable. You will also use this window to prepare your 
sales tax return to send to the tax agency and to create a cheque if necessary.

To make a sales tax payment:
1 From the Vendors menu, choose Sales Tax, then choose File Sales Tax from the 

submenu.

QuickBooks displays the File Sales Tax window.

2 Confirm that the “To be printed” checkbox is selected.
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3 In the “Show sales tax due through” field, type 06/30/07, then press TAB.

QuickBooks displays your tax agencies and the amounts you owe to them. To 
mark the Receiver General for payment (i.e. to pay your GST liability), click in the 
Pay column on the line for the Receiver General.

The File Sales Tax window should resemble the figure below.

Note: If you have an amount refundable to you, QuickBooks will create an 
invoice for the amount refundable. 

4 Click Next.

QuickBooks opens the sales tax return for the tax selected. Review the return.
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5 Click Next.

6 Read the Important Information window, then click OK.

7 Click Print when the Return for Registrants reappears.

If you have an amount due, QuickBooks records a cheque to the tax liability 
account (GST Payable or PST Payable). If you have an amount owing to you from 
the tax agency, QuickBooks records an invoice. 

From the printed return, you must complete your final return for the tax agency 
and mail it to the agency.

After completing the File Sales Tax window, QuickBooks automatically marks all 
the transactions that were a part of the return as filed. If you receive a refund 
cheque back from the tax agency, record it as a Receive Payment and apply it to 
the outstanding invoice from the tax agency.

Tip: In some situations, you may have to change the amount on the cheque 
payable to the tax agency. If you need to edit the amount of the cheque 
after you have completed the File Sales Tax window, use the Find function 
to search for the cheque and make an adjustment directly on the cheque.

8 Click Done.
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Student test and review
1 Create an invoice for Pretell Real Estate’s 155 Wilks Blvd. job, for 10 interior wood 

doors and 2 exterior wood doors.

2 After you record the invoice, open the GST payable register to see how QuickBooks 
has recorded the tax due from the invoice.
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Lesson objectives
■ To gain an overview of payroll in QuickBooks

■ To learn more about payroll setup

■ To set up employee payroll information

■ To practice writing and printing a payroll cheque

■ To learn how QuickBooks tracks your payroll tax liabilities

■ To practice payroll tax liabilities

Handout materials
■ Handout 30:  Overview of payroll tracking

■ Handout 31:  Items on the Payroll Item list

■ Handout 32:  Tracking payroll expenses and payroll liabilities

To start this lesson

Before you perform the following steps, make sure you have installed the exercise file 
(qbcanlesson.qbb) on your hard disk. 

The steps that follow will restore the exercise file to its original state so that the data 
in the file matches what you see on the screen as you proceed through each lesson.

To restore the exercise file (qbcanlesson.qbb):
1 From the File menu in QuickBooks, choose Restore.

QuickBooks displays the Restore Company Backup window.

2 In the “Get Company Backup From” section of the window, click Browse and 
select your c:\QBtrain directory.

3 Select the qbcanlesson.qbb file, then click Open.

4 In the “Restore Company Backup To” section of the window, click Browse and 
select your c:\QBtrain directory.

5 In the File name field of the Restore To window, type lesson 12, then click Save.

6 Click Restore.
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Overview of payroll tracking

This lesson is designed to demonstrate some of the QuickBooks payroll features. The 
way you process payroll for your company may differ from this lesson depending on 
which (if any) payroll features you use. 

Because payroll information is already set up in the exercise file, you will not go 
through the payroll setup process in this lesson. For information about setting up 
payroll for your company in QuickBooks, see “Setting up payroll” in the QuickBooks 
User Guide.

To calculate payroll, QuickBooks uses tax tables. The exercise file includes the tax  
table needed to complete this lesson. To get the tax tables to use with your own 
QuickBooks company data file, you need to become a member of the QuickBooks 
Payroll Service. To learn about the payroll service, from the Employees menu,  
choose Set Up QuickBooks Payroll Service, then choose About Payroll Services from 
the submenu.

QuickBooks calculates each employee’s gross pay, then calculates taxes and 
deductions to arrive at the net pay. With QuickBooks, you can write the pay cheque, 
record the transaction in your QuickBooks chequing account, keep track of your 
payroll tax liabilities, and pay them.

You, as the employer, must subtract taxes and other deductions before issuing an 
employee’s pay cheque. Some typical pay cheque deductions are Income Taxes, 
Canada Pension Plan/Quebec Pension Plan (CPP/QPP), and Employment Insurance 
(EI). You may also deduct for benefits such as Registered Retirement plans (RRSP) or 
contributions to your company’s medical/dental plan.

Then you must submit regular deposits of the withheld tax money (biweekly or 
monthly, depending on the size of your payroll), and file annual forms that list the 
total amounts you withheld from each employee’s pay cheque.
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Calculating payroll with QuickBooks

To do its payroll calculations, QuickBooks needs four kinds of information:

■ Information about your company

Besides the company name and address, this includes your Business Number from 
the CRA. You enter this information in the payroll preferences when you set up 
your payroll system. (Note that your Business Number should appear in all of 
these places: the Company Information window, the GST/PST preferences, and 
the payroll preferences.)

■ Information about your employees

The Employee list stores general information about each of your employees as well 
as specific information related to payroll (such as the employee’s Social Insurance 
Number, date of birth, salary or hourly pay rate, Federal and Provincial TD1 
amounts, and miscellaneous additions, deductions, and company contributions). 
You can store payroll information that most employees have in common in the 
employee defaults. Whenever you have a new employee to add, simply enter 
information that’s specific to that employee (name, address, and so on).

■ Information about your payroll items

When you create any kind of payroll transaction in QuickBooks—whether it’s a 
pay cheque or a payroll tax payment—you use payroll items to do it (in the same 
way that sales forms use service and inventory items). When you specify you want 
to use payroll, QuickBooks creates a number of payroll items for you. You add 
others as you need them.

■ Tax tables for federal and provincial withholdings

To calculate payroll, QuickBooks uses a table of all federal and provincial payroll 
taxes. This tax table is accurate when Intuit manufactures your software, but the 
government changes tax regulations often, so it becomes outdated. You then need 
a new tax table so that QuickBooks can continue to withhold the correct amount 
of tax from each employee’s pay cheque. To receive updated tax tables whenever 
they are needed, you must become a member of the QuickBooks Payroll Service. 

Once you’ve set up your company, employee data, and payroll items, all you do 
to run payroll is enter the number of hours worked during the pay period for each 
employee. QuickBooks calculates the gross wages for the employee, then refers to 
its tax tables and the company and employee information you entered to calculate 
all withholdings and deductions and arrive at the net pay amount. QuickBooks 
also calculates your company payroll expenses (for example, your contributions to 
CPP and EI) and, if you want, prints the pay cheques.
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Setting up for payroll

By default, the QuickBooks payroll feature is turned off. This exercise will show you 
how to turn it on.

To turn payroll on in a company data file:
1 From the Edit menu, choose Preferences.

2 Click Payroll & Employees from the scroll box on the left, then click the Company 
Preferences tab.

3 Notice that Full payroll features is selected in the QuickBooks Payroll Features 
section.

In this sample data, the payroll features are already active. In your own company 
file, you would select that option. (The “Payroll reports only” option is intended 
for people who use an outside payroll service or who prefer to perform payroll 
manually, without the automatic payroll features.)

4 Take a moment to examine the other settings in this window. You can

■ change how employee names are displayed.

■ set what information appears on pay cheque vouchers and pay stubs.

■ set up employee defaults (see “Using the employee defaults to store common 
information” on page 243).

■ set advanced options.

5 In the first field of the Business Number area, enter 123456789, then 0001 in the 
second field.

6 Click OK.

Understanding payroll items

QuickBooks maintains a list for everything that affects the amount on a payroll 
cheque and for every company expense related to payroll. This list is called the Payroll 
Item list. There are payroll items for compensation, taxes, other additions and 
deductions, and employer-paid expenses. QuickBooks uses payroll items to track 
individual amounts on a pay cheque and accumulated year-to-date wage and tax 
amounts for each employee.

QuickBooks adds some items to the list for you, and you can add others as you need 
them. For common payroll items, such as compensation and benefits, QuickBooks 
provides extra assistance so you can set them up quickly and accurately.

You work directly with payroll items as you do payroll tasks. Behind the scenes, 
QuickBooks tracks your payroll liabilities in the Payroll Liabilities account (an Other 
Current Liability account) and your payroll expenses in the Payroll Expenses account.
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To view the Payroll Item list:
1 From the Employees menu, choose Payroll Item List. (You must have payroll 

turned on to see this choice.)

QuickBooks displays the Payroll Item list.

You’ve already used the QuickBooks Item list, so this list should look familiar. Just 
like the regular Item list, each payroll item has a Name and a Type.

The names of the payroll items are what you’ll see on pay cheques and in payroll 
reports.

2 Close the Payroll Item list.

You won’t add a new payroll item in this lesson, but if you need to add an item after 
you’ve set up payroll in QuickBooks, you can use the following procedure.

To add a payroll item:
1 From the Employees menu, choose Payroll Item list.

2 Click the Payroll Item menu button, then choose New.

3 QuickBooks displays the Add new payroll item window, which steps you through 
the payroll item setup process.

4 Press Cancel to terminate payroll item setup process.
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Setting up employee payroll information

Before you can create a pay cheque for an employee, QuickBooks needs certain basic 
information: his or her address, social insurance number, and date of birth; the rate of 
pay; completed federal and provincial TD1 forms; what taxes and deductions apply to 
the employee; and how his or her vacation pay and sick time should be calculated. 
This information is stored in the Employee list. General information about the 
employee is stored here, too.

(Of course, to create a pay cheque, QuickBooks also needs how many hours he or she 
worked, but that information is entered elsewhere.)

What information does QuickBooks store?

You’re going to add a new employee to Rock Castle Construction payroll in a moment. 
First, look at the information QuickBooks stores in the Employee list.

To view information stored in the Employee list:
1 From the Employees menu, choose Employee List.

2 Select Roy O. Uchman in the list, then choose Edit from the Employee menu 
button.

QuickBooks displays the Edit Employee window for Roy O. Uchman.
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The Address Info tab contains some payroll information about Roy Uchman, such 
as his name, social insurance number, and date of birth. This is also where Quick-
Books stores employees’ addresses, telephone numbers, and other contact infor-
mation.

3 Click the Additional info tab.

The Additional Info tab lets you add custom fields to the Employee list.

4 Click the Payroll info tab.

QuickBooks displays the Payroll Info tab of the Edit Employee window. This is 
where QuickBooks stores most payroll information.

The Payroll Info tab contains an employee’s specific salary or hourly rate, and any 
additions, deductions, or company contributions that apply to him or her. You 
can see tax information for this employee (the type of information required for a 
T4) by clicking the Payroll Taxes button.

5 Click Payroll Taxes.

QuickBooks displays the Taxes for Roy O. Uchman window.
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The checkboxes show the types of taxes the employee should have deducted from 
each pay cheque. For example, a checkmark in the Employment Insurance 
checkbox indicates that this employee should have Employment Insurance 
premiums deducted from his earnings. The EI Factor shows that the employer’s 
portion of EI tax will be 1.4 times the amount the employee pays (which is the 
usual amount).

You also enter the employee’s federal and provincial TD1 amounts in this window.

6 Click OK to return to the Edit Employee window. 

7 Click OK again to return to the Employee list.

Using the employee defaults to store common information

QuickBooks stores a wealth of information about each employee, but it doesn’t require 
you to enter the same information over and over. When you have information that 
applies to most of your employees, you can enter it into your employee defaults. Then, 
when you add an employee, QuickBooks automatically fills in the information stored 
with the defaults. You just need to add or change any information that is different for 
a particular employee.

To view employee defaults:
1 With the Employee list displayed, choose Employee Defaults from the Employee 

menu button.

QuickBooks displays the Employee Defaults window.

Use this window to set up the payroll information that most new employees will 
have in common. QuickBooks saves the information so you won’t have to re-enter 
it when you set up the payroll record for an individual employee. For example, all 
Rock Castle Construction employees have the same biweekly pay period, so it is 
entered in the employee defaults.

In addition, most new employees we hire will be eligible for a company perfor-
mance bonus of $50 per pay period. You can add it now.
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2 In the Additions, Deductions and Company Contributions area, click in the Item 
Name column below the Union Dues item, then choose Bonus from the drop-
down list.

3 In the Amount column, type 50 and press TAB.

4 Confirm that the “Use time data to create pay cheques” checkbox is selected. This 
option lets you pay for time entered using the time tracking feature (available in 
QuickBooks Pro and Premier products only).

Your screen should look like the following.

5 Click Payroll Taxes.

QuickBooks displays the Taxes Defaults window.

The withholding taxes that should be deducted from each employee pay cheque 
are entered in this window.

6 Click Cancel to close the Taxes Defaults window.

7 Click Vacation Pay.

QuickBooks displays the Vacation Defaults window.
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Information regarding vacation pay is entered in this window. QuickBooks can 
keep track of vacation pay accrued for each pay period. 

8 Click Cancel to close the Vacation Defaults window.

9 Click OK to close the Employee Defaults window.

10 When QuickBooks asks whether you would like to apply changes to all matching 
employees, click Yes.

The new default you created will now appear in all employee records if the 
employee record has not been changed from the defaults.

Adding a new employee

Suppose you have a new employee on the payroll, and want to add him to your 
records.

To add a new employee:
1 With the Employee list displayed, choose New from the Employee menu button.

QuickBooks displays the New Employee window.

2 On the Address tab, enter the employee data as shown below.
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3 Click the Payroll Info tab. Notice that the Regular Pay item is displayed already.

4 In the Hour/Annual Rate column for the Regular Pay payroll item, type 15. Then 
press TAB.

The Payroll Info tab should look like the following.

5 Click Payroll Taxes.

QuickBooks displays the Taxes for Michael M. White window.

QuickBooks automatically calculates the correct amount of income tax to 
withhold based on the information an employee has entered on their TD1 form. 
You need to copy the total claim amounts from the federal and provincial TD1 
forms into QuickBooks using this tax window for each employee.

6 Click OK.

QuickBooks returns to the New Employee window.

7 Click OK. When QuickBooks asks whether you want to set up additional payroll 
information, click Leave As Is.

QuickBooks returns to the Employee list, where the new employee’s name is now 
displayed.

8 Close the Employee list.
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Writing a pay cheque

QuickBooks lets you print payroll cheques in a batch or one at a time. You may want 
to process the pay cheques of salaried employees in a batch, and do payroll for the 
hourly employees one at a time.

To run a pay cheque:
1 From the Employees menu, choose Pay Employees.

QuickBooks displays the Select Employees To Pay window.

2 In the Period Ends field, type 12/15/2007.

3 Click in the column to the left of Michael M. White’s name.

QuickBooks places a checkmark next to the name.

4 Make sure that “Enter hours and preview cheque before creating” is selected.

5 Click Create.

When QuickBooks warns you that it is using a sample tax table and payroll calcu-
lations will be inaccurate, click OK to continue.
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QuickBooks displays the Preview Pay Cheque window. Now you can enter the 
time Michael worked.

6 In the Item Name field, select “Hourly” from the drop-down list. QuickBooks auto-
matically fills in the employee’s Rate field.

7 In the Hours column, type 80 and press TAB.

QuickBooks fills in the Employee Summary area of the Preview Pay Cheque 
window, showing the gross regular pay and all of the deductions from Michael’s 
pay cheque. The net amount of the cheque appears at the bottom.
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Because payroll tax rates change regularly, your numbers may vary from this 
illustration.

The Company Summary area of the window shows company-paid taxes and 
contributions that don’t affect the amount of the pay cheque (company-paid 
benefits). 

8 Click Create.

QuickBooks writes a payroll cheque for the correct net amount, showing the  
deductions in the voucher area.

QuickBooks displays the Select Employees To Pay window.

9 Click Leave.

Viewing the pay cheque

QuickBooks records payroll cheques in your QuickBooks chequing account register. 
You can see the cheques by going to the register.

To view the pay cheque from the register:
1 From the Lists menu, choose Chart of Accounts.

2 Double-click “Chequing.”

QuickBooks displays the Chequing account register.

3 Select the pay cheque transaction for Michael M. White, and click Edit Trans-
action.

QuickBooks displays the Pay Cheque – Chequing window for Michael. Notice that 
the Pay Cheque Summary shows a summary of the cheque’s deductions. If you 
want to see the deductions that make up this total, you can click the Pay Cheque 
Detail button.
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4 Click Save & Close to close the Pay Cheque – Chequing window.

5 Close the chequing account register, but leave the chart of accounts open.

Printing pay cheque stubs

You can print pay cheques as you would any QuickBooks cheque. If you use voucher 
cheques, QuickBooks prints the payroll item detail in the voucher area. If you don’t 
use voucher cheques, you can print a paystub to give to your employees.

To print a pay cheque:
1 From the File menu, choose Print Forms, then choose Pay Cheques.

QuickBooks displays the Select Pay Cheques to Print window.

2 In the First Cheque Number field, type 296.

3 Make sure all pay cheques you want to print have checkmarks beside them, then 
click OK. (In this case, all the names should be checked.)

4 From the Print Cheques window, click Print.

When QuickBooks warns you that you have created two pay cheques with the 
same number (296), click Keep Number (for this example).

5 When QuickBooks asks if the cheques printed properly, click OK.
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Tracking your payroll liabilities

As an employer, you need to track both payroll expenses and payroll liabilities.

Expenses include items like:

■ Employees’ gross pay

■ Company-paid payroll taxes, such as the employer portions of EI and CPP/QPP.

■ Company-paid benefits for employees, such as company-provided dental plans.

QuickBooks uses an expense account called Payroll Expenses to track these costs to 
your company. (The funds you deduct from employee pay cheques aren’t considered 
an actual cost because they’re monies you’re holding for the government; they don’t 
come from your company assets but from the employees’ money.) Whenever you run 
your payroll, QuickBooks keeps track of your company’s expenses for each employee. 
You can then see totals for these expenses on the payroll summary by employee report 
and on the profit and loss statement.

Liabilities are amounts you owe but have not yet paid to an agency. Payroll liabilities 
include items like:

■ Federal or Quebec income tax withheld from employees’ pay cheques

■ Employee-paid payroll taxes, such as the employee portions of CPP/QPP and EI.

■ Benefits for which the company collects premiums from employees (like some 
group insurance plans).

QuickBooks uses the Payroll Liabilities account (an Other Current Liability account) 
to track what you owe to the government. When you do your payroll, QuickBooks 
calculates how much you owe for each tax, deduction, or company contribution 
payroll item and records that information as a transaction in the liability account. This 
produces a record of how much tax you owe at any time, so you can plan to have the 
cash available for payment. When you pay your payroll taxes or other payroll 
liabilities, QuickBooks decreases the balance of the liability account.

Look at the payroll expense and liability accounts, so you can see how QuickBooks 
recorded expenses and liabilities related to Michael White’s pay cheque.

To display the payroll expenses QuickReport:
1 In the Chart of Accounts window, select the Payroll Expenses account.

2 From the Reports menu button, choose QuickReport: Payroll Expenses.

QuickBooks displays the QuickReport. You can see the expense items paid by the 
company for Michael White’s pay cheque.
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3 Close the QuickReport.

4 In the chart of accounts, double-click the Payroll Liabilities account.

QuickBooks displays the register for the account. The register shows a separate 
transaction for each item from Michael’s pay cheque. The running balance shows 
an increase for every liability.

5 Close the register.

6 Close the chart of accounts.
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Paying payroll taxes

As long as you are a member of the QuickBooks Payroll Service, QuickBooks uses 
current tax tables to keep track of your tax liabilities as they accrue, so you know how 
much you owe at any time.

Figuring out what you owe

If you’re about to pay your payroll taxes, the Payroll Liabilities report shows you how 
much to pay and to whom. Suppose you are ready to make a payroll tax payment and 
you want to see how much you owe.

To create a payroll liabilities report:
1 From the Reports menu, choose Employees & Payroll, then choose Payroll 

Liability Balances.

2 Click Modify Report, select “Display columns by Year across the top,” be sure that 
the end date is 12/31/2007, then click OK.

QuickBooks displays a report that shows what you owe for each payroll item.

3 Close the report.

If QuickBooks asks if you’d like to memorize the report, click No.

Writing a cheque for payroll taxes

When it’s time to pay payroll taxes, use the Pay Payroll Liabilities window to fill out a 
QuickBooks cheque.

Note: Don’t just open the Write Cheques window and write a cheque from there. 
QuickBooks can’t properly adjust your Payroll Liabilities account unless you 
use the Pay Liabilities feature.
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To pay payroll liabilities:
1 From the Employees menu, choose Process Payroll Liabilities, then select Pay 

Payroll Liabilities item from the submenu.

QuickBooks displays the Select Date Range For Liabilities window.

2 In the “Through” field, type 12/31/2007.

3 Click OK.

QuickBooks displays the Pay Liabilities window.

4 Click in the column to the left of the CPP - Company payroll item.

QuickBooks places checkmarks in the column for both Company and Employee 
to show that the items will be paid. It also places checkmarks next to EI and 
Federal Income Tax items.

Now your Pay Liabilities window should look like the following.
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5 Make sure “Review liability cheque to enter expenses/penalties” is selected, then 
click Create. 

If QuickBooks reminds you that you can order cheques for this account, click 
Close to continue.

QuickBooks displays the Liability Cheque window, with your cheque displayed.

You should use a separate cheque for each vendor that you are paying.

6 In the Memo field, type BN 123456789 as a reference number for the CRA.

7 Click Save & Close to record the cheque.

8 Click Yes if QuickBooks asks if you want to save changes made to this transaction. 

Whenever you make a payment and record your cheque this way, QuickBooks 
decreases the balance of the Payroll Liabilities account.
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Preparing PD7A, T4, T4 Summary, and Relevé 1 forms

Along with your liability cheque, you’ll need to submit a PD7A (Current Source 
Deductions Remittance) form to the CRA. On this form, you report the federal income 
tax amounts, EI premiums, and CPP contributions you withheld from your 
employees’ pay cheques over the past month. To help you prepare this form, 
QuickBooks provides a PD7A Summary Report.

Creating a PD7A Summary Report
1 From the Reports menu, choose Employees & Payroll, then PD7A Report.

2 In the “To” field, type 12/31/2007, then press TAB.

QuickBooks displays a summary of the income tax, pension plan contributions, 
and Employment Insurance premiums that you’ve withheld from employee pay 
cheques.

Your screen should look like this:
 

You would use the figures in the report to fill in your PD7A form.

3 Close the report.
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Preparing T4 slips

At the end of the year, you’ll need to provide T4 slips for your employees and the CRA. 
QuickBooks can help you create these.

To create a T4 slip
1 Click the Employees menu, then Process T4s. QuickBooks shows the Process T4s 

window.

2 Check that the Year drop-down menu is showing the correct year (for this 
example, 2007 -- though usually, you would want the year that just finished).

3 Click in the checkmark column to the left of Michael M. White.

4 Click the Review T4 button to see Michael’s T4.
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5 Notice that the information on the T4 matches the information from the pay 
cheque you created for Michael.

If you’re not sure what a box on this form is for or how amounts should be 
entered, click the Help button, then you can find out more about individual 
boxes. The online help contains a good deal of information about how T4 slips 
should be completed.

6 Double-click the EI Premiums box (Box 18).

In the Adjustments window, you can adjust amounts on the T4 slip, if necessary, 
and enter a memo to remind you why you made the adjustment (the Description 
field). The amount you enter is added to the one already showing on the T4 (the 
Amount field). To decrease the amount on the T4, you would enter a negative 
number.

7 Click Cancel.

8 In the Employee T4 window, click OK.

You are returned to the Process T4s window.

9 Click Print T4.

10 In the Print T4s window, choose the printer you want to use and whether it is a 
single-sheet printer (like an inkjet or laser printer) or a continuous-feed printer 
(like most dot-matrix printers).

Then you can choose whether to print on blank paper (the default if you have an 
inkjet or laser printer) or pre-printed, multipart forms from the CRA. Finally, you 
select who you are printing the forms for: the CRA, your own records, or to give 
to the employee.

For this example, print CRA forms on blank paper. (Note that the Printer Name 
area will be different from this illustration as it will show your printer’s name.)
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11 Click Print, then read the information message and click OK to continue.

12 In the Process T4s window, click Done.

Preparing a T4 Summary report

When you file the T4s you created for your employees, you need to include a T4 
Summary that totals the amounts on all the T4 slips. You can use a report to fill in your 
T4 Summary form quickly.

To create a T4 Summary report:
1 From the Reports menu, choose Employees & Payroll, then T4 Summary.

QuickBooks displays a summary of your T4s.

2 For this example, make sure that the Dates field reads, “This calendar year.”

When you work with your own company file, you will likely want to select “Last 
Calendar Year” when you use this report.

You can now use the information in the report to fill in the T4 Summary form.

3 If you want to print the report, click Print in the report button bar.

4 Close the report.
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Student test and review
1 Add a salaried employee to the employee list. Use SIN 111 111 118 and a date of 

birth of 10/12/76, and assume that he or she is using the default TD1 amounts. 
Enter the employee’s personal information, tax information, and at least one addi-
tional pay cheque deduction (for which you will have to create a payroll item).

2 Process a pay cheque for the new employee. Then, view the cheque in QuickBooks. 
Open the payroll liability account register to see how the pay cheque changed the 
account’s balance.

3 Select the payroll expense account from the chart of accounts. Create a Quick-
Report for it.
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Lesson objectives
■ To learn how to create job estimates

■ To find an estimate in a data file

■ To learn to duplicate an existing estimate

■ To create an invoice from an estimate

■ To display project reports for estimates

■ To update a job’s status

■ To make an estimate inactive

Handout materials
■ Handout 33:  Creating an estimate

■ Handout 34:  Creating invoices from an estimate

To start this lesson

Before you perform the following steps, make sure you have installed the exercise file 
(qbcanlesson.qbb) on your hard disk. 

The steps that follow will restore the exercise file to its original state so that the data 
in the file matches what you see on the screen as you proceed through each lesson.

Note: To proceed through this lesson, you must be using QuickBooks Pro or 
Premier. Estimates are not available in QuickBooks Basic.

To restore the exercise file (qbcanlesson.qbb):
1 From the File menu in QuickBooks, choose Restore.

QuickBooks displays the Restore Company Backup window.

2 In the “Get Company Backup From” section of the window, click Browse and 
select your c:\QBtrain directory.

3 Select the qbcanlesson.qbb file, then click Open.

4 In the “Restore Company Backup To” section of the window, click Browse and 
select your c:\QBtrain directory.

5 In the File name field of the Restore To window, type lesson 13, then click Save.

6 Click Restore.
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Creating jobs and estimates

An estimate is a description of work or products you propose to sell to a current or 
prospective customer. You can create multiple estimates for each name (customer or 
customer:job combination). If the customer accepts an estimate, you can turn the 
estimate into an invoice, modifying it as necessary. When you have actual costs and 
revenues, you can compare them to your estimated costs and revenues to see if you 
were over or under the estimate.

Estimates are “non-posting” transactions—they do not affect any financial reports or 
income and expense balances. QuickBooks allows you to create invoices from 
estimates either by transferring the entire estimate to an invoice or by allowing you to 
choose a percentage or selected items to invoice from the estimate. The ability to bill 
for only a percentage of the estimate or selected items on an estimate is called progress 
invoicing.

When you create a new QuickBooks company using the EasyStep Interview, 
QuickBooks asks you if you use estimates and/or progress invoicing. If you respond 
yes, QuickBooks turns on these features for you. If you respond no, you need to turn 
on these features in order to use them. Rock Castle Construction already has estimates 
and progress invoicing turned on, but you’ll review how to do this so you become 
familiar with QuickBooks preferences.

Turning on estimates and progress invoicing

To turn on estimates and progress invoicing:
1 From the Edit menu, choose Preferences.

2 Click Jobs & Estimates in the left scroll box.

3 Click the Company Preferences tab to display the job and estimate preferences.

4 Click Yes for “Do You Create Estimates?”

5 Click Yes for “Do You Do Progress Invoicing?”
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The Jobs & Estimates preferences window should look as follows

6 Click OK to record your selections and close the Preferences window.

Creating a new job

Now that you’ve turned on the estimates feature, you can add a new job for a 
bathroom remodel project for your customer, Ernesto Natiello. Then you’ll create an 
estimate for the job.

To create a new job:
1 From the Customers menu, choose Customer:Job List.

2 In the Customer:Job list, select Natiello, Ernesto.

3 Click the Customer:Job menu button, then choose Add Job.

QuickBooks displays the New Job window.
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4 In the Job Name field, type Bathroom Remodel #2.

5 Click the Job Info tab.

QuickBooks displays the Job Info portion of the New Job window.

The New Job window is unique to QuickBooks Pro and Premier. Dates appear in 
the date fields from a previous job done for this customer.

6 In the Job Status field, select Pending from the drop-down list.

7 In the Start Date field, type 1/4/08.

8 In the Projected End field, type 2/28/08.
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9 Press TAB to move to the End Date field, then press DELETE (on the keyboard) to 
clear this field.

10 In the Job Description field, type Remodel bathroom #2.

11 In the Job Type field, choose Remodel from the drop-down list.

Job types give you a way to classify your jobs so you can group and subtotal similar 
jobs on your reports. By using them, you’ll be able to determine which kinds of 
jobs are the most profitable for your business.

Your screen should look like the figure below.

12 Click OK.

QuickBooks returns you to the Customer:Job List.

Notice that the new Bathroom job is listed as a pending job for Natiello, Ernesto. 
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Writing an estimate

Now that you’ve created a new job for the bathroom remodel, you can create an 
estimate for it.

To create an estimate:
1 In the Customer:Job list, select Natiello, Ernesto:Bathroom remodel #2.

2 Click the Activities menu button, then choose Create Estimates.

QuickBooks displays the Create Estimates window for this customer and job. You 
learned in Lesson 6 how to fill out an invoice form, so this form should look 
familiar.

3 Press TAB to accept Natiello, Ernesto:Bathoom remodel in the Customer:Job field.

Notice that QuickBooks enters the customer’s name and address in the  
appropriate area of the form.

4 Make sure that Custom Estimate is selected in the Template field.

5 Click in the Item column in the middle of the form. A Down Arrow appears, indi-
cating that a drop-down list of choices is available.

The Item list, which contains all the services and goods your business provides, is 
the same list that is available to you on invoice forms and throughout Quick-
Books.

6 Type Installation.

Before you can finish typing, QuickBooks has filled it in for you, and QuickBooks 
fills in the default description for this item.

7 Press TAB twice to move to the QTY column.

8 Type 10 in the QTY column, then press TAB.

The total amount is calculated by QuickBooks when you move out of this field.

9 Click the line under “Installation” in the Item column.

10 Type Framing.

11 Press TAB twice to move to the QTY column, then type 40.

12 In the line under Framing in the Item column, type Rough.

QuickBooks completes the field with the item Lumber:Rough.

13 Press TAB three times to move to the Cost column, then type 2500.

14 Press TAB to move to the Markup column.

15 Type 15%, then press TAB twice.

Your estimate should look like the following figure.
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Notice that QuickBooks has filled in most of the information for the estimate 
based on the items selected.

16 Click Save & Close to save the estimate.

QuickBooks returns you to the Customer:Job list. Notice the Estimate Total 
column for the Pending Bathroom remodel job for Ernesto Natiello now has a 
balance of 6,238.75.

Creating multiple estimates

Just as you’ve completed the estimate for this customer, he calls and asks you to 
prepare a second estimate for the same job. He’d like you to price a couple of different 
options. 

Finding estimates

Because you just created the estimate, you can open the Create Estimates window and 
press Prev and that will take you to the correct estimate. However, when you don’t 
know where an estimate is, there are a couple of methods you can use to locate the 
estimate you want quickly. You’ll use one of them here.

1 From the Customers menu, choose Create Estimates.

2 From the Edit menu, choose Find Estimates.

QuickBooks displays the Find Estimates window.
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3 In the Customer:Job drop-down list, select Natiello, Ernesto:Bathroom remodel 
#2.

4 Click Find.

5 Click No to “You have not recorded the new transaction. Do you want to record 
it now?”.

QuickBooks displays the estimate that you’ve already created for this job (Estimate 
# 22).

6 Keep the estimate open, you’ll use it in the next exercise.

Duplicating estimates

Your customer wants you to prepare a second estimate for the bathroom remodel job 
because he is considering buying the cabinets from you in addition to having you do 
the installation work.

First, you’ll create a duplicate of the original estimate, then make the modifications 
necessary for the second bid.
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To create a duplicate of an existing estimate:
1 Right-click to the right of Name/Address and choose the Duplicate Estimate menu 

item from the displayed menu.

QuickBooks duplicates the estimate and displays the new version on your screen. 
Notice that QuickBooks assigns the next available estimate number to the new 
form.

2 Highlight the number in the QTY column on the line for Installation.

3 Type 18.

4 Click in the Item column in the line below Lumber:Rough, and select 
Cabinets:Light Pine from the drop-down list. 

5 Press TAB twice and type 6 in the QTY column.

6 Click in the Item column in the line below Cabinets:Light Pine and select 
Cabinets:Cabinet Pulls from the drop-down list.

7 Press TAB twice and type 12 in the QTY column.

8 Press TAB and type 10 in the Cost field.

9 Press TAB.
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Your estimate should look like the following figure.

10 Click Save & Close.

Creating an invoice from an estimate

Once you have created an estimate and the customer has approved it, you can use the 
estimate to invoice the customer. In this exercise, you’ll be using the QuickBooks 
progress invoicing feature.

Progress invoicing (also known as progress billing), lets you invoice for jobs that you 
work on and complete in phases. When using progress invoicing, you start by creating 
an estimate for the job (you don't have to give this estimate to the customer). Then, 
as you complete each phase, you can easily transfer items from the original estimate 
to an invoice. You can specify which items to include on each invoice and change 
estimated amounts or percentages. When you use estimates to create progress 
invoices, you can run reports to help you track your estimated versus actual costs.
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To create an invoice from an estimate:
1 In the Customer:Job list, select Natiello, Ernesto:Bathroom #2 remodel.

2 Click the Activities menu button, then choose Create Invoices.

QuickBooks displays the Create Invoices window.

3 Press TAB to leave the Customer:Job field.

QuickBooks displays a list of estimates created for this job.

4 The customer accepted the second estimate you created, so select the line 
containing Estimate #23, and click OK.

QuickBooks displays the Create Progress Invoice Based On Estimate window.

Rock Castle Construction typically bills for one-third of the job before starting 
work, one-third when the project is one-third complete, and the final one-third 
when the job is completed.

5 Select “Create invoice for a percentage of the entire estimate.”

6 Type 33.333 in the “% of estimate” field.

If you need to invoice for only selected items on an estimate or for varying 
percentages or amounts for different items, select the option “Create invoice for 
selected items or for different percentages of each item.” QuickBooks then displays 
a table of all items on the estimate and allows you to select which items you want 
to include and the amounts for each item.

7 Click OK.

8 In the Template drop-down list in the upper right corner of the Create Invoice 
screen, be sure that the Progress Invoice is selected.
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QuickBooks completes the invoice for one-third of each item on the estimate. 
Your invoice should resemble the following figure.

Notice that QuickBooks changed the invoice template to Progress Invoice and 
added fields for Estimate Amount and Total %. QuickBooks also tracks that one-
third of the Natiello bathroom remodel job has been invoiced and that two-thirds 
has not yet been invoiced.

Note: If you don’t want your customers to see this level of detail on the invoice 
you send them, you can customize the invoice to remove some of these 
columns from the printed form. See Lesson 15, “Customizing forms and 
writing QuickBooks Letters,” for more information.

9 Click Save & Close to record the invoice.

10 Close the Customer:Job list.
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Displaying reports for estimates

QuickBooks provides five reports on estimates, as described in the following table. You 
can create these reports from the Jobs & Time submenu of the Reports menu.

Displaying the job progress invoices vs. estimates report

Because you’ve just completed a progress invoice, you can see how QuickBooks 
records this on the job progress invoices vs. estimates report. This report shows job 
status, estimate total, total invoiced from the estimate on progress invoices, and the 
percentage of the estimate already invoiced on progress invoices.

To display the job progress invoices vs. estimates report:
1 From the Reports menu, choose Jobs, Time & Mileage.

QuickBooks displays a submenu of project reports that deal with customer jobs 
and estimates.

2 Choose Job Progress Invoices vs. Estimates.

Report Description

Job Estimates vs. Actuals Summary Compares estimated cost to actual cost and esti-
mated revenue to actual revenue for all custom-
ers and jobs.

Job Estimates vs. Actuals Detail (for 
one job)

For a particular customer or job, compares esti-
mated costs to actual costs and estimated reve-
nues to actual revenues.

Job Progress Invoices vs. Estimates Compares each estimate with progress invoices 
based on the estimate.

Item Estimates vs. Actuals For each item, compares estimated cost to 
actual cost and estimated revenue to actual rev-
enue.

Estimates by Job Lists all estimates by job.
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QuickBooks displays the job progress invoices vs. estimates report.

Notice that the progress invoice you completed for Ernesto Natiello is listed in the 
Prog. Invoice column. The % Progress column shows how much of the total 
estimate you’ve invoiced for so far.

3 Close the report window.

Updating job status

Every time you change the status of a job, you should update its job status in the 
Customer:Job list. For example, the estimate for the bathroom remodel is no longer 
pending: Ernesto Natiello awarded you the job and you have started work.

To update the status of a job:
1 From the Customers menu, choose Customer:Job List.

QuickBooks displays the Customer:Job list.

2 In the list, select Natiello, Ernesto:Bathroom remodel #2.

3 Click the Customer:Job menu button, then choose Edit.

QuickBooks displays the Edit Job window.

4 Click the Job Info tab.

QuickBooks displays the Job Info portion of the Edit Job window.

5 In the Job Status field, select “In progress.” 

Your screen should look like this.
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6 Click OK.

QuickBooks returns you to the Customer:Job list. The Customer:Job list now 
shows this project as being in progress.

7 Close the Customer:Job list.

Making estimates inactive

Now that the customer has accepted one of the estimates for the bathroom remodel 
job and you have started work, you might want to make the unaccepted estimate 
inactive. When you make an estimate inactive QuickBooks keeps a record of it, but 
does not use the numbers in reports.

To mark an estimate inactive:
1 From the Reports menu, choose Jobs, Time & Mileage.

2 Choose Estimates by Job from the submenu to display the estimates by job report.

3 Scroll to the section of the report that displays the estimates for Ernesto Natiello.
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4 Double-click anywhere on the line for Estimate #22.

QuickBooks displays the Create Estimate screen.

5 Click to clear the checkmark in the Estimate Active checkbox.

6 Click Save & Close.

7 If QuickBooks asks if you want to save the changes you made to the transaction, 
click Yes.

8 Close the report.
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Student test and review
1 Create an estimate for the 75 Sunset Rd. job for Pretell Real Estate. The estimate is 

for 6 hours of installation labour, 18.5 hours of plumbing work, and 4 hours of 
drywall work.

2 Create a progress invoice for 50% of the estimate just created for the 75 Sunset Rd. 
job for Pretell Real Estate.
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Lesson objectives
■ To learn how to track time worked on a project

■ To learn how to invoice a customer for time worked on a project

■ To create project reports for time tracking and learn about other project reports

■ To learn how to set up items used to track time worked by owners or partners

■ To learn how to pay nonemployees for time worked

Handout materials
■ Handout 35:  Invoicing customers for time worked

To start this lesson

Before you perform the following steps, make sure you have installed the exercise file 
(qbcanlesson.qbb) on your hard disk. 

The steps that follow will restore the exercise file to its original state so that the data 
in the file matches what you see on the screen as you proceed through each lesson.

Note: To proceed through this lesson, you must be using QuickBooks Pro or 
Premier. Time tracking is not available in QuickBooks Basic.

To restore the exercise file (qbcanlesson.qbb):
1 From the File menu in QuickBooks, choose Restore.

QuickBooks displays the Restore Company Backup window.

2 In the “Get Company Backup From” section of the window, click Browse and 
select your c:\QBtrain directory.

3 Select the qbcanlesson.qbb file, then click Open.

4 In the “Restore Company Backup To” section of the window, click Browse and 
select your c:\QBtrain directory.

5 In the File name field of the Restore To window, type lesson 14, then click Save.

6 Click Restore.
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Tracking time

QuickBooks provides time tracking for any job. Time tracking lets you keep track of 
the time a person spends on each job (including sick and vacation time and time spent 
for general overhead). The person whose time you track can be an employee, an owner 
or partner, or a subcontractor.

You can use time data to do the following:

■ Invoice the customer for the time spent doing a job.

■ Provide hours worked on an employee's paycheque, or a cheque to a nonemployee 
(vendor, owner, or partner).

■ Track the cost of employees’ gross pay by job.

■ Report on the number of hours worked—by person, by job, or by item.

Turning on time tracking

To turn on time tracking:
1 From the Edit menu, choose Preferences.

2 Click Time Tracking in the left scroll box. Then click the Company Preferences tab.

QuickBooks displays the Time Tracking Preferences window.

3 Make sure Yes is selected as the answer to the question “Do You Track Time?”

4 Click OK to save the preference setting.
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Entering time data

There are three ways to get time data into a company file:

■ Enter time directly onto a weekly timesheet or single activity form in QuickBooks.

■ Use the Stopwatch to time an activity while you are performing it.

■ Use the QuickBooks Timer program to track time, then import the time directly 
into QuickBooks. (The Timer is available in QuickBooks Pro and Premier only.)

When you track time with QuickBooks, you have a choice of two forms to enter time: 
Weekly Timesheet or Time/Enter Single Activity window. If you want to enter time for 
multiple jobs or multiple days, then the Weekly Timesheet is the best choice.

If you tend to enter a lot of detailed notes about your activities, or you prefer to enter 
time data as you complete an activity, use the Time/Enter Single Activity window 
instead.

Information you enter in the Time/Enter Single Activity window displays in the 
Weekly Timesheet, and vice versa. They’re different views of the same information.
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The Timer program is useful when you have employees or subcontractors who need 
to track their time but don’t need or want to run QuickBooks. When time is imported 
into QuickBooks from the Timer application, you view the imported time data on the 
same timesheets you would use if you did the data entry directly into QuickBooks.

If you have employees who don’t have access to a computer, you can print blank 
copies of the weekly timesheet for your employees to fill out by hand.

To print a blank timesheet:
1 From the Employees menu, choose Time Tracking, then choose Use Weekly 

Timesheet.

QuickBooks displays the Weekly Timesheet window.

2 From the Print drop-down menu, choose Print Blank timesheet.

3 In the Print Timesheets window, click Print.

Recording employee time on a weekly timesheet

In this exercise, you’ll complete a weekly timesheet for Gregg Schneider. In a later 
exercise, you’ll learn how to invoice a customer for the time Gregg spent working on 
a job for that customer.

To enter information on a weekly timesheet:
1 In the Name field of the time sheet, select Gregg Schneider from the drop-down 

list.

2 When QuickBooks displays the message asking if you would like to set this 
employee to use time data during pay cheque creation, click Yes.

QuickBooks will track the time you enter for this employee and display it when 
you are ready to pay employees.
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3 Click in the Customer:Job column, then choose Melton, Johnny:Dental office 
from the drop-down list.

QuickBooks will associate the time that you enter in this window with the office 
repairs being completed for Johnny Melton.

4 In the Service Item column, type Installation.

After you type a few characters, QuickBooks fills in the rest of the item for you. 
The Item list, which contains all the services and goods your business provides, is 
the same list that is available to you on invoice forms and throughout Quick-
Books.

5 Press TAB. Notice that QuickBooks fills in the information in the Payroll Item 
column for you.

Gregg Schneider is paid by the hour. QuickBooks has his hourly rate stored in the 
Employee list, on the Payroll Info tab.

Tip: If you try to select a payroll item that is not associated with this employee, 
QuickBooks displays a warning message. For example, if you try to select 
Salary as the payroll item for Gregg Schneider, QuickBooks tells you that you do 
not have that type of payroll item set up for the employee. (It still lets you make 
the selection, but it warns you that the Salary is set up with a $0.00 rate.)

6 Click in the M 10 column.

M stands for Monday and 10 for the date, Monday, the 10th of December, 2007. 
Note that you can change the first day of your workweek in the QuickBooks time 
tracking preferences. (From the Edit menu, choose Preferences, then click Time 
Tracking.)

7 Type 8 to enter the number of hours worked on Monday.

8 In the Tu field, type 8.

9 In the W field, type 8. As you enter hours for each day, the Total column displays 
the total hours for the week.

10 In the Th field, type 8.

11 In the F field, type 8, then press TAB. Your screen should resemble the figure below.
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The invoice icon to the right of the Total column tells QuickBooks if the time will 
be transferred onto an invoice. In its current setting, you’re telling QuickBooks 
that you do want to invoice the customer for time worked.

If you do not plan on invoicing the customer for time worked, you can click the 
invoice icon and QuickBooks displays a red “X” over it. 

12 Click Save & Close to record the Weekly Timesheet. QuickBooks records the time 
for Gregg Schneider and for Johnny Melton’s dental office job.

This time can now be transferred onto an invoice for Johnny Melton’s dental office 
job or used to create a paycheque for Gregg Schneider.

Invoicing a customer based on time

Refer to Handout 35, “Invoicing customers for time worked.”

Now you can invoice Johnny Melton for the time Rock Castle Construction’s 
employee, Gregg Schneider, spent on the dental office job.

1 From the Customers menu, choose Create Invoices.

2 Select Melton, Johnny:Dental office as the customer:job.

3 If you’re using QuickBooks Pro or Premier, QuickBooks displays the Available  
Estimates window. Click Cancel.

4 If QuickBooks reminds you that this customer has billable time/costs, click OK to 
continue.

5 In the Date field, type 12/17/2007.

6 Click Time/Costs on the taskbar at the top of your screen, then click the Time tab.

QuickBooks displays the Choose Billable Time and Costs window.

QuickBooks displays the Time information entered on the timesheet for Gregg 
Schneider for the Johnny Melton dental office job.
285



T r a c k i n g  t i m e
Note: By default, QuickBooks combines time for activities that have the same 
service item, and lists them as one line item on the invoice. If you prefer to 
have each individual line from the timesheet displayed as a line item on the 
invoice, click the Options button and select “Do not combine activities.”

7 Click in the Use column to select each of the lines that represents time worked by 
Gregg Schneider.

QuickBooks places a checkmark in the Use column to the left of each entry to 
indicate it is selected.

8 Click OK.

The invoice should resemble the figure below.

9 Click Save & Close to record the invoice.
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Displaying project reports for time tracking

QuickBooks provides four reports on time, as described in the following table. You can 
create these reports by choosing Jobs, Time & Mileage from the Reports menu.

Displaying the time by job report

The time by job summary report summarizes the total hours for each job, and the time 
by job detail report breaks down those summary figures into hours for each service 
item and hours for each customer:job.

To create a time by job report:
1 From the Reports menu, choose Jobs, Time & Mileage.

2 From the submenu, choose Time by Job Summary. QuickBooks displays the time 
by job summary report.

3 Scroll the report until you see the time worked for the Melton, Johnny:Dental 
office job.

Project report Description

Time by Job  
Summary

Shows hours worked subtotaled first by customer or job, 
then by service item.

Time by Job Detail Lists each time activity (that is, work done by one person for 
a particular customer or job on a specific date), and shows 
whether the work is billed, unbilled, or not billable. The 
report groups and subtotals the activities first by customer 
and job, then by service item.

Time by Name Shows hours worked (or tracked as sick or vacation time), 
subtotaled first by the name of the person who performed 
the work, then by the customer or job the person performed 
the work for.

Time by Item Shows the hours worked, subtotaled first by service item, 
then by customer or job.
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Viewing time data in more detail

Like all QuickBooks reports, you can QuickZoom any of the numbers in a report to see 
more detail. Suppose you want to see who worked the eight hours on installation for 
Johnny Melton. You can point to that number in the report and double-click to get 
more information.

1 Position your mouse pointer over the 80 hours for Installation on the  
Melton, Johnny:Dental office job, then double-click.

When you position your mouse pointer over the number, the pointer changes into 
a magnifying glass with a Z in it. After you double-click, QuickBooks displays a 
time by job detail report for the time data you selected. (This functionality is called 
QuickZoom.)

You can see that Gregg Schneider and Roy Uchman did the work and the time has 
already been billed to the customer.

Because the report ending date is December 15, it displays all the hours that you 
entered on Gregg’s timesheet. If you want to reduce the number of hours 
displayed on this report, you can change the date range it covers. In the To field 
(on the Report buttonbar), type 12/12/07 and press Tab. QuickBooks redisplays the 
report to cover the new date range.

2 Close the time by job detail and the time by job summary reports.

If QuickBooks asks if you want to memorize the report, click No.
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Displaying other project reports

In addition to the estimate and time reports, QuickBooks provides several project 
reports to track job profitability, as described in the following table.

Paying non-employees for time worked

You can easily pay owners, partners, subcontractors, and other non-employees for 
time spent on projects and jobs. When you track time for a non-employee, you assign 
a service item to each time activity so that you can pay the non-employee for time 
worked. Then QuickBooks can transfer time data for a specified date range to a cheque. 
QuickBooks prefills the Items tab of the cheque with information from the time data, 
including hours worked and rate.

To pay a subcontractor, owner, or partner for time worked, the person must be on one 
of the following lists:

■ Vendor (appropriate for subcontractors, especially if you must report payments to 
them to the CRA)

■ Other Names (appropriate for owners and partners)

If the company is a sole proprietorship or an unincorporated partnership, owners 
and partners are not treated like regular employees. They should not be on the 
business' payroll. Instead, owners and partners take money out of the business by 
drawing on their equity. In accounting terms, these owner's draws are not business 
expenses -- they are a transfer of some of the value in the business to the owner.

An owner's draw is a "regular" cheque drawn from an equity account. If you track 
time for an owner or partner, you can base the owner's draw on the number of 
hours worked.

Note: To pay an ordinary employee for time worked, use the payroll feature to 
write a paycheque.

Project report Description

Job Profitability  
Summary

Compares the actual cost to the actual revenue for all  
customers and jobs. The report subtotals the data first  
by customer, then by job.

Job Profitability Detail  
(for one customer:job)

For a particular customer or job, compares actual costs to 
actual revenues and shows the difference between the two 
amounts. The report subtotals the data first by item type, 
then by item.

Item Profitability For each item, compares the actual cost to actual revenue 
and shows the difference between the two amounts. The 
report subtotals the data first by item type, then by item.
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Creating service items for subcontractors, owners, or 
partners

When you use service items for subcontractors, QuickBooks records expenses and 
income for the work in separate accounts. You can use such items on both purchase 
forms and sales forms.

In this section, you learn how to do the following:

■ Set up a service item to use to track work performed by an owner or partner

■ Enter time worked for an owner or partner

■ Prepare a cheque to pay an owner or partner for time worked

To set up a service item for owners or partners:
1 From the Lists menu, choose Item List.

2 Click the Item menu button, and choose New.

3 In the Type field of the New Item window, choose Service from the drop-down list.

4 In the Item Name/Number field, type Plan.

5 Select the “This service is performed by a subcontractor, owner, or partner” 
checkbox.

QuickBooks changes the window to display fields for sales and purchase  
information.

6 In the Description on Purchase Transactions field, type Job Planning and press TAB.

QuickBooks copies the text into the Description on Sales Transactions field.

7 In the cost field, type 50 and press TAB.
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8 From the drop-down list in the Expense Account field, choose the equity subac-
count called Owner’s Draw.

If you pay owners (or partners) for time worked, you need a service item that 
records the cost of the work as a draw against equity, rather than an expense.

9 In the Sales Price field, type 90.

10 In the Sales Tax Code drop-down list, select E for Exempt.

11 In the Income Account field, type Plan and press TAB. Note that QuickBooks 
expands this to Planning.

Your screen should now look like this.

12 Click OK to close the New Item window.

13 Press Esc to close the Item list.

In the next section, you learn how to use the Planning item you’ve just created to track 
time performed by the owner of Rock Castle Construction.

Recording nonemployee time worked

You record data for time worked by nonemployees the same way you enter it for 
employees. 

To enter time for nonemployee time worked:
1 From the Employees menu, choose Time Tracking. Then choose Time/Enter Single 

Activity.

QuickBooks displays the Time/Enter Single Activities window.
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2 In the Name field, choose Tom Ferguson from the drop-down list.

Note: When you selected the owner’s name, QuickBooks removed the Payroll 
Item field from the window. (When class tracking is on, this field is 
replaced with the class field.) Owners and partners should be set up on the 
Other Names list, or on the Employee List with the Type set to “Owner” 
because they are not paid with payroll cheques.

3 In the Customer:Job field, choose Abercrombie, Kristy:Family Room.

4 In the Service Item field, select Planning from the drop-down list and press TAB.

5 Type 8 in the Duration field and press TAB.

6 From the Class drop down list, choose Remodel.

Your screen should resemble the following.

7 Click Save & Close.
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Preparing a cheque to pay for nonemployee time worked

In this section, you’ll learn how to create a cheque to reimburse an owner for time 
worked on a specific job.

1 From the Banking menu, choose Write Cheques.

QuickBooks displays the Write Cheques window.

2 Make sure that Chequing is selected in the Bank Account field.

3 Click to put a checkmark in the To be printed checkbox.

If QuickBooks reminds you that you can use computer cheques with this account, 
click Close to continue.

4 In the Pay to the Order of field, choose Tom Ferguson from the drop-down list.

5 Click Yes at the message QuickBooks displays asking if you want this cheque to 
pay for time worked.

QuickBooks displays the Select time period window.

6 Type 12/15/07 in the Start Date field and press TAB.

7 Type 12/19/07 in the End Date field and click OK.
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QuickBooks prefills the Items tab of the cheque with information from the time 
data, including hours worked and rate.

8 Click Save & Close in the Write Cheques window.

Notice that time activity is marked unbillable so that it is not billed twice—as a 
time activity and an item.
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Student test and review
1 Create a single activity timesheet for Gregg Schneider, for eight hours worked on 

the Anton Teschner Sun Room job.

2 Transfer the time you just entered for Gregg Schneider onto an invoice for the 
Teschner Sun Room job.

3 Display a time by name job report to see how many hours Gregg Schneider has 
worked for each job.
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C u s t o m i z i n g  f o r m s  a n d  w r i t i n g  Q u i c k B o o k s  L e t t e r s
Lesson objectives
■ To learn how to modify a preset invoice form

■ To design a custom invoice form

■ To see how to print invoices

■ To learn how to prepare a collection letter for overdue customers

■ To learn how to edit a prewritten letter in QuickBooks

Handout materials
■ Handout 36:  Types of QuickBooks forms you can customize

■ Handout 37:  QuickBooks Layout Designer

To start this lesson

Before you perform the following steps, make sure you have installed the exercise file 
(qbcanlesson.qbb) on your hard disk.

The steps that follow will restore the exercise file to its original state so that the data 
in the file matches what you see on the screen as you proceed through each lesson.

To restore the exercise file (qbcanlesson.qbb):
1 From the File menu in QuickBooks, choose Restore.

QuickBooks displays the Restore Company Backup window.

2 In the “Get Company Backup From” section of the window, click Browse and 
select your c:\QBtrain directory.

3 Select the qbcanlesson.qbb file, then click Open.

4 In the “Restore Company Backup To” section of the window, click Browse and 
select your c:\QBtrain directory.

5 In the File name field of the Restore To window, type lesson 15, then click Save.

6 Click Restore.
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About QuickBooks forms

Each form you use in QuickBooks has its own layout—that is, its own arrangement of 
fields and columns for entering information. If the layout of a particular form doesn’t 
meet your needs, you can create your own custom layout and use your version instead 
of the QuickBooks version.

In Lesson 6, you learned about the three preset formats for invoices: professional, 
service, and product. If these formats don’t precisely meet your needs, you can create 
your own invoice templates. You can also create templates for other sales and 
purchase forms.

For each form, you can decide which fields and columns to include, what they are 
called, and where to place them. Once you have created your forms, you can save the 
new layouts as templates—to use whenever you want, and to modify whenever you 
want. The forms you can customize in QuickBooks are the invoice, sales receipt, credit 
memo, statement, purchase order, estimate (QuickBooks Pro and Premier only), and 
sales order (QuickBooks Premier editions only).

Note: You can create custom forms in all QuickBooks products, but some of the 
customization and layout options described in this lesson are available 
only in QuickBooks Pro and Premier products. For example, adding 
coloured backgrounds, using rounded borders on fields, and using fields on 
forms multiple times are available only in QuickBooks Pro and Premier 
products.

Customizing invoices

QuickBooks lets you customize an invoice form to suit the needs of your business, but 
there may be times when you want to design a completely different invoice form. 
QuickBooks lets you do that, too. You can use the Layout Designer to create a new 
form design for your business. In the Layout Designer, you can move, resize, or change 
the width of columns, turn on or off borders around fields, and control font type and 
size for each field.

In the following exercises, you’ll use both the customize forms and Layout Designer 
features in QuickBooks to create a custom invoice.

Note that these features affect only the printed forms; you cannot customize the 
onscreen version of QuickBooks forms.
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Creating new templates

To create a new invoice template:
1 From the Lists menu, choose Templates.

QuickBooks displays the Templates list.

2 Click the Templates menu button, then choose New.

QuickBooks displays the Select Template Type window.

3 Click OK to select the invoice form.

QuickBooks displays the Customize Invoice window, which uses multiple tabs to 
display several sets of formatting options. Each area of the form is represented by 
a tab. To display the available formatting options, click the tab for the area of the 
form you want to change.

4 In the Template Name field, type My New Invoice.
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This is the name you’ll use for the new template. Your window should look like 
this.

Notice that the Header tab is currently selected. The Header tab displays the 
formatting options you have for the top part of the invoice form. For each field, 
you can specify the title you want and whether you want the field displayed 
onscreen, on paper, both, or neither. You can enter a new title by highlighting the 
current title text and typing your new one.

If you want to track information about a particular invoice, but don’t want your 
customer to see this information, select the Screen checkbox and clear the Print 
checkbox.

5 Click the Fields tab. The Customer Invoice Fields tab screen is displayed: 
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The Fields tab is where you select which fields you want to appear on screen and 
on paper. You can specify your own title (label) for each field.

Suppose you want to remind customers of payment due dates at the time you send 
the invoice. You can customize the invoice form to display the Due Date field.

6 To have the Due Date field display both on screen and on the printed form, click 
the Screen and Print columns for Due Date to select both checkboxes.

Checkmarks appear in both checkboxes.

7 Clear the Screen and Print checkboxes for the P.O. field to remove the field from 
the form.

Changing field order on forms

The lower half of the standard QuickBooks invoice form is where you enter details 
about the items or services purchased by the customer. You can change the order of 
these fields as they appear on your invoices.

The Order column on the Columns tab shows you how fields display from left to right 
on the invoice form. Currently, Item is the first column and Amount is the last 
column. Suppose you want the Qty field to appear after the Item field, and before the 
Description field.

To change the order of fields on a form:
1 Click the Columns tab.

The Custome Invoice Columns tab screen is displayed::

2 Double-click the Order column in the Quantity row to select the number.

3 Type 2.

4 Double-click the Order column in the Description row to select it.
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5 Type 3. Your screen should look like the following figure.

If you use progress invoices or sales orders, use the Prog Cols tab to customize the 
columns on those forms.

6 Click the Footer tab.

The Footer tab contains information that you usually find at the bottom of the 
form. It also provides a place for you to enter free-form text, such as a disclaimer, 
on your form. In the next exercise, you’ll learn how to move fields on forms.

7 Click the Company tab.

Use the Company tab to specify which pieces of company information to include 
on your sales and purchase forms.

8 Select the Print Phone Number checkbox. Your window should look like the 
following graphic.
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If you wanted to add your company logo to the form, you would select the Use 
Logo checkbox and tell QuickBooks which file to use. QuickBooks supports BMP, 
JPEG, TIFF, and GIF graphic formats.

9 Click the Format tab.

Use the Format tab to change the fonts for various textual elements on the form. 
If your forms print on multiple pages, use the checkbox on this tab to indicate 
whether or not you want to print page numbers.

If you don’t want QuickBooks to print the status stamp (paid, pending, etc.) on 
forms, clear the Print Status Stamp checkbox on this tab.

10 Click the Printer tab.

The Customize Invoice Printer tab screen is displayed:

Use the Printer tab to associate print settings with individual form templates. For 
example, if you print most forms in Portrait mode, but have one form that you 
print in Landscape, you can associate the Landscape print setting with that form’s 
template. When you send the form to the printer, QuickBooks knows to print it in 
Landscape.

11 Click OK to record the changes. Click Cancel if the error message box appears.

12 Close the Templates window.
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Displaying your customized form

Now display the customized form to see the changes you made in the previous 
exercise.

To display the custom form:
1 From the Customers menu, choose Create Invoices.

QuickBooks displays the Create Invoices window with the Custom Invoice 
template displayed.

2 In the Form Template field, choose My New Invoice from the drop-down list.

Notice how this form reflects the changes you made in the Customize Invoice 
window. 

The phone number field that you added to the form only shows on the printed 
form, so you do not see it onscreen.

3 Leave the Create Invoices window open; you’ll use it in the next exercise.
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Designing custom layouts for forms

With the QuickBooks Layout Designer, you can change the design or layout of a form. 
In the Layout Designer, you can move, resize, change the width of columns, turn on 
or off borders around fields, add coloured backgrounds, and control the font type and 
size for each field.

Here are a few examples of what you can do with a custom layout:

■ Give your company name, address, and logo special treatment on the form. For 
example, you could center your logo at the top of the form and put your company 
name and address in a special font immediately below the logo.

■ Enlarge a custom field so that it can display more information.

■ Position the customer’s billing address so that it coincides with the address 
window in the envelopes you use.

■ Change the borders on fields, add background colours, and add extra text fields.

■ Add multiple graphics to a form.

Changing the position of fields on forms

Next, you’ll use the Layout Designer to move the Phone # and Bill To fields, and to 
decrease the width of the Quantity column.

To move fields on forms:
1 In the Create Invoices window, click Customize.

QuickBooks displays the Customize Template window.

2 Make sure that My New Invoice is selected and click Edit.
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QuickBooks displays the Customize Invoice window that you used to customize 
the form.

Now, you’ll use the Layout Designer to change the design of the form.

3 Click Layout Designer.

QuickBooks displays the Layout Designer window.

By clicking the Zoom buttons, you can zoom out to see an overall view of the form 
or zoom in for a closer look at a small section of the form.
307



C u s t o m i z i n g  f o r m s  a n d  w r i t i n g  Q u i c k B o o k s  L e t t e r s
4 Click the Bill To field.

5 Press and hold the Shift key.

Holding down the Shift key when clicking on an object allows you to select 
multiple fields at the same time. Having multiple fields selected lets you move the 
fields together.

6 Click the field directly below the Bill To field (the field containing the words “This 
is sample text”).

Notice the four-directional arrow that appears when you move the cursor over the 
selected fields. The selected fields on your screen should look like this.

7 Release the Shift key.

8 With the cursor over the selected fields, press and hold the left mouse button.

9 Drag the selected fields down about one inch.

10 Release the mouse button.

Your screen should now look like this.

11 Select the field containing Rock Castle’s address.
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12 Move the mouse over one of the dark squares on the bottom of the field, then hold 
the mouse button while you drag the bottom of the field up to a point just below 
the address.

13 Scroll to the bottom of the screen and select the Phone # field.

14 Click Remove.

15 Select the field containing the numbers 555-555-5555.

16 Holding down the mouse button, drag the field so that it sits just below Rock 
Castle’s address.

Changing field widths

In the next exercise, you’ll change the font size for Rock Castle’s phone number to 
make it match the address, but first you want to make the field wider so that the phone 
number isn’t cut off.

To change the width of a field:
1 Select the field containing the telephone number and drag the right border further 

to the right while holding down the mouse button.

The fields should resemble the figure below.

Rock Castle Construction rarely enters a quantity greater than two characters, so 
you want to make the QTY column smaller. Decreasing the width of the QTY 
column also increases the width of the Description column.

2 In the Layout Designer window, scroll until the Qty column is visible.

3 Click the Qty column to select it.

Your screen should resemble the figure below.

Notice that when the cursor is positioned between the QTY and DESCRIPTION 
columns, it turns into a two-directional arrow.
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4 Click and hold the left mouse button on the line separating the Qty and 
Description columns.

5 While holding down the mouse button, drag the column line to the left (to the 
one-inch mark on the ruler).

6 Release the mouse button.

The forms area on your screen should resemble the figure below.

Changing fonts, borders, and colours

Using the Properties window in the Layout Designer, you can change font size and 
style, text justification. You can also add, remove, or change the borders around fields.

1 With the phone number field selected, click Properties.

QuickBooks displays the Properties window.

2 On the Text tab, select Left for horizontal justification.
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3 Click the Font button.

4 In the Size area, enter 12, then click OK.

5 Click the Border tab.

6 Click to remove the Top, Bottom, Right, and Left checkboxes.

7 Click OK to save your changes in the Properties window.

8 Click OK to save the changes in the Layout Designer.

9 Click OK to close the Customize Invoice window.

This exercise covers only a portion of the changes you can make with the 
customization and layout tools. For example, if you wanted to add a background 
colour to the field, you could do so using the Background tab. You could use the Add 
button to add empty fields into which you can enter your own text—or to add data 
fields that you forgot to select in the Customize window. If you want a field to appear 
on a form more than once, select the field and click Copy.

We encourage you to experiment with the tools available to create your own custom 
forms. For examples of what you can achieve, visit the forms library at 
http://templategallery.quickbooks.com/forms/.

If you are using QuickBooks Pro or QuickBooks Premier, you can download templates 
from the forms library to use in your own business.

Previewing new forms

Notice that the invoice form displayed by QuickBooks doesn’t show the changes you 
just made in the Layout Designer. This is because changes made in the Layout 
Designer only affect the printed invoice and not the invoice QuickBooks displays 
onscreen for data entry.

To preview the invoice:
1 To see how the printed invoice form will look, click the Print drop-down list on 

the Create Invoices window toolbar, then choose Preview.

QuickBooks displays the Print Preview window.
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The invoice displayed in the Print Preview window shows exactly how the printed 
invoice will look. Notice that the changes you made in the Layout Designer are 
reflected in this preview.

2 When you are finished looking at the preview, click Close.

3 Press Esc to close the Create Invoices window without saving.
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Using QuickBooks Letters

From time to time, you may need to send a letter to a customer or vendor (or someone 
on your employee list or other names list), or to another list of people. With 
QuickBooks Pro and Premier, you can easily add the pertinent QuickBooks data (such 
as name, address, and balance information) to a letter without having to re-type it.

QuickBooks provides a number of business letters focusing on collections, news, and 
announcements. You can edit these letters as needed to suit your business and style of 
communication.

Note: To proceed with this lesson, you must be using QuickBooks Pro or Premier 
and Microsoft Word 97 or higher. The QuickBooks Letters feature is not 
available in QuickBooks Basic.

Preparing collection letters

In this exercise, you’ll learn how to prepare a collection letter to send to customers 
with overdue payments.

To prepare a collection letter:
1 From the Company menu, choose Write Letters.

2 If QuickBooks prompts you to find letters, click Copy. QuickBooks will copy the 
QuickBooks letters from your installation directory to your QBtrain folder.

QuickBooks opens the Write Letters wizard.

3 Make sure that “Prepare a Collection Letter” is selected and click Next.
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4 When QuickBooks prompts you to choose who you want to write to, make the 
following selections:

■ For number 1, choose Active.

■ For number 2, choose Customer.

■ For number 3, choose 31 days or more.

Your screen should look like this.

5 Click Next.

6 If QuickBooks reminds you that some customers have unapplied payments or 
credits, click OK to continue for this example.

(In general, you would not send a customer a notice of overdue payments if you 
had not applied all of the credits he or she has on file or payments he or she has 
already made.)

QuickBooks displays a list of all active customers with payments 31 days or more 
past due.
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7 Leave all names selected and click Next.

8 When QuickBooks prompts you to choose the letter you want to use, click 
“Friendly collection” and click Next.

9 In the Name field of the next screen, type Tom Ferguson. In the Title field, type  
President.

Your screen should look like the following.

10 Click Create Letters.

11 If QuickBooks displays a message about missing information, click OK.

QuickBooks starts Microsoft Word (if it’s not running already) and displays 
collection letters for the customers that you selected
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.

You can scroll through the Microsoft Word document to see the letters. Notice 
that QuickBooks entered Tom Ferguson’s name and title at the end of each letter.

12 Close the Microsoft Word file without saving the letters.

When you do save letters you’ve created using QuickBooks Letters, don’t save 
them to the QuickBooks Letters folder. The QuickBooks Letters folder should only 
be used to store the original QuickBooks Letters installed with the QuickBooks 
software program.

To print the letters, you would choose Print from the Microsoft Word File menu.

Editing QuickBooks Letters

You can make changes to individual letters using Microsoft Word, or you can make 
global changes by editing the QuickBooks Letter used to generate a specific letter.

In this exercise, you’ll edit the collection letter you prepared in the last exercise 
(Friendly collection). However, instead of working with completed letters with 
customer information already filled in, you’ll work with the underlying QuickBooks 
Letter used to create the letters.
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To edit a QuickBooks Letter:
1 From the Company menu, choose Write Letters.

2 Click Design QuickBooks Letters, then click Next.

3 In the screen that appears, make sure “View or edit existing letters” is selected and 
click Next.

4 When QuickBooks prompts you to choose the QuickBooks Letter you want to view 
or edit, click Overdue customers (collection letters), then select “Friendly 
collection” from the list of available letters.

Your screen should look like this.

5 Click Edit Letter.
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QuickBooks opens Microsoft Word (if it’s not running already) and displays the 
QuickBooks Letter (Friendly collection) and a toolbar (QuickBooks Collection 
Letter Fields) that you’ll use to add information from QuickBooks to the letter in 
Word. If the QuickBooks Collection Letter Fields toolbar is not visible, select the 
Toolbars menu item from the View menu and select QuickBooks Collection Letter 
Field toolbar.

Note that you can move the toolbar by clicking it with your mouse pointer and 
dragging it to a new location. Now, you’ll enter more text and use the toolbar to 
insert data from QuickBooks into the “Friendly collection” letter.

6 Click your mouse pointer after the period at the end of the first sentence and the 
press the Space bar once. (You’ll insert a sentence into the paragraph.)

7 Type Our records show that your balance is past due.

8 Click your mouse pointer after the word “is” in the sentence you just typed, and 
press the Space bar again.
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9 From the Insert Collection Info. Fields drop-down list on the QuickBooks 
Collection Letter Fields toolbar, select Range(days) of Overdue Invoices.

QuickBooks adds the <<OverdueRange>> field to the sentence you just typed.

When you create letters using this modified QuickBooks letter, QuickBooks will 
replace the <<OverdueRange>> field with the number of days each customer you 
create a letter for is past due.
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10 From the Word File menu, choose Save As.

11 Navigate to the Qbtrain\QuickBooks Letters\Collection Letters folder and click 
Save.

If you save the file to your QuickBooks directory (instead of the Qbtrain folder you 
created to use with this guide) without changing the filename, you will overwrite 
the original QuickBooks Letter.

12 To see how this change affects the final letter output, close the letter file in 
Microsoft Word and go through the “Preparing collection letters”exercise again.

When you’re done, your letters should resemble the following.

13 Close Microsoft Word.

Unless your instructor tells you otherwise, do not save your work.
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Student test and review
1 Customize the Sales Receipt form to change the default title on the header from 

“Sales Receipt” to “Cash Sale.”

2 Using the Layout Designer, make the columns for QTY and Rate narrower so the 
Description field is wider.

3 Customize the P.O. form to include the Terms field.
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APPENDIX A Course Handouts 0
Using the course handouts

In this section, you’ll find copies of all the handouts referenced in this guide.
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Course Syllabus

Introduction

LESSON 1: Getting started

Course introduction
Introducing QuickBooks
Getting around in QuickBooks
All the accounting you need to know
Exiting QuickBooks
Moving between company files

LESSON 2: Setting up QuickBooks

Creating a QuickBooks company
Entering company info
Setting up QuickBooks preferences
Choosing a start date
Setting up income and expense accounts
Providing details about your income
Entering opening balances
Finishing the Interview
Getting help while using QuickBooks

LESSON 3: Working with lists

Using QuickBooks lists
Editing the chart of accounts
Working with the Customer:Job list
Working with the Employee list
Working with the Vendor list
Adding custom fields
Managing lists

LESSON 4: Working with bank accounts

Writing a QuickBooks cheque
Using bank account registers
Entering a handwritten cheque
Transferring money between accounts
Reconciling chequing accounts

LESSON 5: Using other accounts in QuickBooks

Using other account types in QuickBooks
Tracking credit card transactions
Working with asset accounts
Working with liability accounts
Understanding equity accounts
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Course Syllabus (continued)

LESSON 6: Entering sales and invoices

Using sales forms in QuickBooks
Filling in a sales form
Memorizing a sale
Entering a new service item
Using multiple price levels
Using statements to bill customers

LESSON 7: Receiving payments and making deposits

Recording customer payments
Making deposits

LESSON 8: Entering and paying bills

Handling bills in QuickBooks
Using QuickBooks for accounts payable
Entering bills
Paying bills

LESSON 9: Analyzing financial data

Reports and graphs help you understand your business
Creating QuickReports
Creating and customizing preset reports
Saving report settings
Printing reports
Exporting reports to Microsoft Excel
Creating QuickInsight graphs

LESSON 10: Setting up inventory

Turning on the inventory feature
Entering products into inventory
Ordering products
Receiving inventory
Entering a bill for inventory
Manually adjusting inventory

LESSON 11: Tracking and paying sales tax

Overview of sales tax in QuickBooks
Setting up your tax rates
Applying tax to each sale
Determining what you owe
Filing a sales tax return
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Course Syllabus (continued)

LESSON 12: Doing payroll with QuickBooks

Overview of payroll tracking
Setting up for payroll
Setting up employee payroll information
Writing a pay cheque
Tracking your payroll liabilities
Paying payroll taxes

LESSON 13: Estimating and progress invoicing

Creating jobs and estimates
Writing an estimate
Creating multiple estimates
Creating an invoice from an estimate
Displaying reports for estimates
Updating job status

LESSON 14: Tracking time

Tracking time
Invoicing a customer based on time
Displaying project reports for time tracking
Paying non-employees for time worked

LESSON 15: Customizing forms and writing QuickBooks Letters

About QuickBooks forms
Customizing invoices
Designing custom layouts for forms
Using QuickBooks Letters

APPENDIX A: Course Handouts
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Record your daily transactions on QuickBooks 
forms

Some examples of forms you use in QuickBooks include the following:

■ Invoices

■ Purchase orders

■ Cheques

The Write Cheques window looks just like a cheque.

You fill out most forms by choosing from lists.
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Information stored in the Customer list

Here’s an example of the information stored in customer records in the Customer:Job 
list.
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Register for an accounts receivable account

Registers show all the activity in one account.
330



                                                                                                
H A N D O U T  5
5

The QuickBooks chart of accounts

Balance 
sheet 
accounts

Income 
and 
expense 
accounts
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About assets, liabilities, and equity

Assets

■ Include both what you have and what other people owe you. 

■ The money people owe you is called your accounts receivable, or A/R for short.

■ QuickBooks uses a single account—the accounts receivable account—to track all 
the money that different people owe you.

The rest of your company’s assets may include chequing accounts, savings accounts, 
petty cash, fixed assets (such as equipment or trucks), inventory, and undeposited 
funds (money you’ve received from customers but haven’t yet deposited in the bank).

Liabilities

■ What your company owes to other people.

■ The money you owe for unpaid bills is your accounts payable, or A/P for short.

■ QuickBooks uses a single account—the accounts payable account—to track all the 
money you owe different people for bills.

A liability can be a formal loan, an unpaid bill, or sales and payroll taxes you owe to 
the government.

Equity

■ The net worth of your company: the value you have left over after you have 
collected everything that is owed to you and paid off all your debts.

■ Equity equals the company’s total assets minus the total liabilities.

Equity = Assets - Liabilities
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Sample balance sheet
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Sample profit & loss statement
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Setting up QuickBooks

After installing the QuickBooks program, follow these steps to set up QuickBooks for 
your company:

1 Choose a QuickBooks start date, and set up your company with the EasyStep 
Interview.

2 Fine-tune your chart of accounts and enter historical transactions.

3 Finish entering payroll information (add new payroll items, finish entering 
employee payroll information, and so on).

4 Complete customer and vendor information.

5 Complete the Item list.
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How to choose a start date

If today is close to the end of your fiscal year, the last day of your fiscal year is an 
excellent start date. You’ll probably have an accurate balance sheet to enter in 
QuickBooks.

If today is midway in your fiscal year, ask yourself whether you really want to enter all 
transactions from the beginning of the year.

■ If the answer is no, choose a more manageable start date, such as the end of the 
last quarter or the end of last month.

■ If the answer is yes, choose the end of your last fiscal year as your start date. 
You will then have complete records in QuickBooks for the current fiscal year.
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QuickBooks balance sheet accounts

This account type… Tracks…

Bank account Chequing, savings, and money market accounts. Add one 
bank account for every account your company has at a 
bank or other financial institution. (You should also use 
this type for petty cash.)

Accounts receivable (A/R) Transactions related to the customers who owe you 
money, including invoices, payments, deposits of pay-
ments, refunds, and credit memos. Most companies have 
only one A/R account.

Other current asset Assets likely to be converted to cash or used up within one 
year, such as notes receivable due within a year, prepaid 
expenses, and security deposits.

Fixed asset Long-term notes receivable and depreciable assets your 
company owns that aren't likely to be converted into cash 
within a year, such as equipment or furniture.

Accounts payable (A/P) Transactions related to the vendors to whom you owe 
money, including your company's outstanding bills, bill 
payments, and any credit you have with vendors.

Credit card Credit card purchases, bills, payments, and credits.

Current liability Liabilities scheduled to be paid within one year, such as 
sales tax, payroll taxes, accrued or deferred salaries, and 
short-term loans.

Long-term liability Liabilities such as loans or mortgages scheduled to be 
paid over periods longer than one year.

Equity Owner's equity, including capital investment, drawings, 
and retained earnings.
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Registers associated with QuickBooks 
windows

You can display the register associated with a window by choosing Use Register from 
the Edit menu.

While you have this window 
displayed:

You can display the register for this 
account:

Create Invoices Accounts Receivable

Enter Bills Accounts Payable

Write Cheques The account you have displayed in the Bank 
Account field on the cheque form

Receive Payments Accounts Receivable

Make Deposits The account you have displayed in the Deposit To 
field, or Undeposited Funds if that option is 
selected

Enter Sales Receipts The account you have displayed in the Deposit To 
field

Create Credit Memos/Refunds Accounts Receivable

Enter Credit Card Charges The account you have displayed in the Credit Card 
field
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Using the keyboard to move around a register

To do this: Press these keys:

Move up or down one transaction at a time ↑, ↓

Move up or down one full screen at a time PgUp, PgDn

Move to beginning of previous or next month Ctrl+PgUp, Ctrl+PgDn

Move to beginning of register Ctrl+Home

Move to end of register Ctrl+End
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Determining the value of a fixed asset

Fixed asset: Equipment or property your business owns that is not for sale (for 
example, a computer system or a company vehicle).

Because fixed assets wear out or become obsolete, their value declines constantly from 
the day you purchase them. The amount of this decline in value is depreciation.

The value of a fixed asset equals

the Original Cost

minus

the Accumulated Depreciation 

(the total amount of depreciation

 since the asset’s purchase)
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Tracking asset cost and depreciation

1 Create a fixed asset account for each asset (or group of assets) you want to depre-
ciate.

2 Add two subaccounts to each asset account you created. One subaccount tracks 
the cost of the asset, the other tracks accumulated depreciation. If you acquired 
the asset after your QuickBooks start date, you enter 0.00 as the opening balance 
for both accounts.

3 Create an expense account to track depreciation expense. Give the account a name 
like “Depreciation Expense.”

4 When it’s time to enter an asset’s depreciation, enter the depreciation amount as 
a decrease in the asset’s Accumulated Depreciation account.

5 When you take out a loan to pay for the asset, create a long-term liability account 
to track the loan (with an opening balance of 0.00).

6 Enter the amount of the loan as an increase in the asset’s Cost account. Assign the 
transaction to your loan liability account.
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Understanding QuickBooks equity accounts

Equity = Assets – Liabilities

If you sold all of your assets today, and you paid off your liabilities using the money 
received from the sale of your assets, the money you’d have left would be your equity.

QuickBooks equity accounts

QuickBooks adds these accounts for you:

Opening Bal Equity

When you set up your QuickBooks company file as of a particular start date, you may 
already have company assets and liabilities as of that date. As you tell QuickBooks the 
opening balances of your assets and liabilities, QuickBooks automatically tracks the 
amount of equity in the Opening Bal Equity account.

Retained Earnings

This account tracks your company’s net income from previous fiscal years. 
QuickBooks automatically transfers your profit (or loss) to Retained Earnings at the 
end of each fiscal year.
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Create Invoices window

In QuickBooks, an invoice is a form on which you record details about a sale to a 
customer who owes you money.

An invoice lists the services you are providing or the products you are selling. It also 
shows the quantity and price or rate of each item (unless you choose an invoice design 
that does not show them).
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Enter Sales Receipts window

To record what you sold and received full payment for at the time of sale, use the Enter 
Sales Receipts window.

You can print the form to use as a customer receipt if you want.
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Choosing a format for sales forms

Use this format . . . If you . . .

Service Primarily sell services but occasionally sell goods.

Professional Sell services and need a lot of room for descrip-
tions of your services.

Product Sell parts or products and need fields relevant to 
shipping.

Custom Want to tailor a form to your type of business.
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Types of QuickBooks items

Whether you’re recording a sale or a purchase, you use items from your Item list to fill 
out the form quickly. When you choose an item in the Item field on the form, 
QuickBooks fills in the description, rate or price, then calculates the amount.

Items for things you sell or purchase

Type Use when recording sales for

Service Services you charge for or services you purchase.
EXAMPLES: Professional fees, labour

Inventory Part Items you purchase, track as inventory, then resell.
EXAMPLES: Electrical outlets, T-shirts

Inventory Assembly Items you buy or produce, track as inventory, and resell.
EXAMPLES: Pre-assembled door kits, bicycles

Non-inventory Part Items you sell but do not purchase; items you purchase but do 
not resell; items you purchase and resell but do not track as 
inventory.
EXAMPLES: Custom-made slipcovers, pizza, office supplies

Other Charge Other charges on a sale or a purchase, such as freight or 
finance charges.
EXAMPLES: shipping charge, delivery charge

Group Fast entry of a group of individual items already on the list.
EXAMPLES: Group of services and lab fees for office visits, 
group of services and food items provided by a caterer

Items that calculate

Type Use for

Subtotal Calculating a subtotal before calculating a discount or charge 
that covers several items.

Discount Calculating an amount to be subtracted from the total.
(To discount several items, use a Subtotal item first).

Payment Payment received at the time of invoicing so that amount owed 
on invoice is reduced.
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Receive Payments window

Use the Receive Payments window to record payments from customers. If you billed a 
specific job for a customer, be sure to apply the payment to the job (not just the 
customer name).

To open the Receive Payments window, choose Receive Payments from the Customers 
menu.
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Make Deposits window
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Handling expenses in QuickBooks

Do this: When:

Write a cheque manually or 
pay with a credit card

You need to purchase an item and pay for it on 
the spot.

Write and print a Quick-

Books cheque

You receive a bill from a vendor that you want 
to pay immediately.

Use accounts payable in 

QuickBooks

You receive a bill from a vendor that you want 
to pay later, and you want to track the total 
amount you owe to vendors.
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Creating a QuickReport from a list, register, or 
form

When you’re in… The QuickReport shows you…

A register (with a transaction 

selected)

All transactions in that register for the same 
name

A form (invoice, bill, or 

cheque)

All transactions for that particular customer,  
vendor, or payee

A list (with an item or person 

selected)

All transactions for that item or all open transac-
tions for that person
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Preset report types in QuickBooks

■ Company & Financial reports include the following:

- Profit and loss reports give you a global view of your company's income, 
expenses, and net profit or loss over a specific period of time.

- Balance sheet reports show the financial position of your business by 
listing assets, liabilities, and equity.

- Cash flow reports show the net change in your cash during a period.

■ Customers & Receivables (accounts receivable) reports give you infor-
mation about the “receivables” side of your business: which invoices are due (or 
overdue), how much each customer owes your company, and so on.

■ Sales reports give you information about what you have sold and to whom.

■ Jobs, Time & Mileage reports (QuickBooks Pro and Premier only) give 
you information on job profitability, item profitability, how your estimates 
compare to actual costs, how much time you and your employees are spending on 
various projects, and travel expenses.

■ Vendors & Payables (accounts payable) reports give you information about 
the “payables” side of your business, including which bills are due, your sales tax 
(GST and PST) liabilities, and your current balance with each vendor. 

■ Purchases reports give you information about your purchases.

■ Inventory reports give you information about the status (such as the quantities 
you have on hand or on order) and the value of your inventory.

■ Employees & Payroll reports give you information about your payroll 
expenses and liabilities.

■ Banking reports include cheque detail, deposit detail, and missing cheque 
reports.

■ Accountant & Taxes reports include income tax summary, income tax detail, 
general ledger, trial balance, journal, transaction journal, and audit trail reports.

■ Budget reports show how your income and expenses compare to the budgets 
you have set up.

■ List reports give you a way to display information from your QuickBooks lists.
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Seeing more of an onscreen report

Click… To do this…

Hide Header Hide everything in the report header (company 
name, report title, date range, today's date, etc.). 
This button does not affect the printed report.

Show Header Display the report header you previously hid.

Collapse Hide subaccounts, jobs, and subclasses; by sum-
marizing their amounts under the main heading. 
This button affects both the onscreen and printed 
report.

Expand Display the subaccounts you previously hid.
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QuickInsight graph types

■ An income and expense graph shows your income and expenses for the period you 
specify.

■ A sales graph shows your company’s sales income for the period you specify.

■ An accounts receivable graph shows how much your customers owe.

■ An accounts payable graph shows how much you currently owe your vendors.

■ A net worth graph shows changes in your company’s net worth.

■ A budget vs. actual graph lets you see the variance between your budgeted 
amounts and the actual amount you earned or spent.
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Inventory in QuickBooks
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Paying for inventory items

If… You pay by…

You’re making an  
over-the-counter purchase

Entering a cheque or credit card receipt.

You've entered an item receipt 

for inventory, but the bill 

hasn't arrived yet

Entering the bill when the item receipt arrives. 
(Choose Enter Bill for Received Items from the 
Vendors menu.) You then pay the bill just like 
you would any other QuickBooks bill.

You've entered a bill for inven-

tory you've received

Paying the bill just like you would pay any 
other QuickBooks bill. (Choose Pay Bills from 
the Vendors menu.)
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Overview of payroll tracking

Employer responsibilities:
1 Calculate gross pay for the employee based on salary or hourly wages time hours 

worked.

2 Calculate federal withholdings (i.e. income tax) for the gross pay based on the 
employee’s federal TD1 form and the current tax rates.

3 Calculate provincial withholdings for the gross pay based on the employee’s 
provincial TD1 form and the current tax rates.

4 Calculate the Employment Insurance premium for the gross pay.

5 Calculate the CPP/QPP contribution amount for the gross pay.

6 Calculate any other deductions, such as provincial health care premiums or 
company benefit packages.

7 Withhold the above amounts from the employee’s pay cheque.

8 Write a cheque for the net pay to the employee.

9 Submit reports and pay the withheld tax amounts to the government.

10 Pay any other withheld deductions.
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Items on the Payroll Item list

A payroll item is anything that affects the amount on a pay cheque. The QuickBooks 
sample company has the following items for wages and federal taxes:

As you need them, other items can be added to the list.
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Tracking payroll expenses and payroll liabilities

Payroll Expenses
■ Employees’ gross pay

■ Employer payroll taxes:

- The company’s portion of CPP/QPP contributions

- The company’s portion of Employment Ensurance (EI) premiums

- In some cases, health care premiums

Payroll Liabilities

Taxes you’ve withheld from pay cheques for:

■ Federal income tax

■ Provincial income tax

■ The employee’s portion of CPP/QPP contributions

■ The employee’s portion of Employment Insurance (EI) premiums

■ In some cases, health care premiums
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Creating an estimate

An estimate is a description of work, or products, you propose to sell to a current or 
prospective customer. After you create an estimate, you can use it to create one or 
more invoices.

Estimates are not available in QuickBooks Basic.
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Creating invoices from an estimate

After you create an estimate, you can use it to invoice the customer.

QuickBooks Pro and Premier let you do the following:

■ Create an invoice for the entire estimate (100%).

■ Create an invoice for a percentage of the entire estimate (for example, 33.33% if 
you want to invoice for one-third of the estimate).

■ Create an invoice for selected items or for different percentages of each item.
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Invoicing customers for time worked

To invoice a customer for time worked, click Time/Costs in the Create Invoices 
window. Then, click in the Use column to select the time entries you want to want to 
include on the invoice to that customer.

In this example, all of the time worked in November on Bryan Ruff’s sun room will be 
added to his invoice.

Notice that QuickBooks created two line items for time worked: one for all billable 
time for Removal (8 hours), and one for Framing (23 hours).
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Types of QuickBooks forms you can customize

■ Invoice

■ Sales receipt

■ Credit memo

■ Statement

■ Purchase order

■ Estimate (QuickBooks Pro and Premier only)

■ Sales orders (QuickBooks Pro and Premier only)

For each form, you can decide which fields and columns to include, what they are 
called, and where to place them.

Once you have created your forms, you can save the new layouts as “templates”—to 
use again and again.
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QuickBooks Layout Designer

The Layout Designer lets you move, change the size, change the fonts, and turn on/off 
the borders for all fields. You can also import your logo, place it anywhere you want, 
and resize it in the Layout Designer.
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